Using Open Workbench

Version 1.1

Second Edition
Title and Publication Number
Title: Using Open Workbench
Edition: Second Edition
Printed: May 4, 2005

Copyright
Copyright © 1998-2005 Niku Corporation and third parties. All rights reserved.

Trademarks
Niku and the Niku logo are registered trademarks and Open Workbench is a trademark of the Niku Corporation in the United States and certain other countries. All other products, company names, and/or trademarks are the property of their respective owners.

This manual, and the information contained in this manual, is distributed and made available as is, without warranties of any kind. The information contained in this manual is subject to change at any time, without notice.

Mailing Address
Niku Corporation
305 Main Street
Redwood City, CA 94063
# Contents

## 1 Getting Started

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>2</td>
</tr>
<tr>
<td>Installing Open Workbench</td>
<td>3</td>
</tr>
<tr>
<td>Starting and Exiting Open Workbench</td>
<td>4</td>
</tr>
<tr>
<td>Windows in Open Workbench</td>
<td>6</td>
</tr>
<tr>
<td>Shortcut Bar</td>
<td>9</td>
</tr>
<tr>
<td>Toolbar Basics</td>
<td>11</td>
</tr>
<tr>
<td>Keyboard Navigation</td>
<td>17</td>
</tr>
<tr>
<td>Managing Columns and Rows</td>
<td>19</td>
</tr>
<tr>
<td>Printing</td>
<td>21</td>
</tr>
<tr>
<td>Using Online Help</td>
<td>25</td>
</tr>
</tbody>
</table>

## 2 Quick Start

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>28</td>
</tr>
<tr>
<td>Starting Open Workbench</td>
<td>29</td>
</tr>
<tr>
<td>Specifying Project Properties</td>
<td>31</td>
</tr>
<tr>
<td>Tasks and Durations</td>
<td>32</td>
</tr>
<tr>
<td>Resources</td>
<td>34</td>
</tr>
<tr>
<td>Scheduling Projects</td>
<td>36</td>
</tr>
<tr>
<td>Customizing Views</td>
<td>37</td>
</tr>
<tr>
<td>Printing Views</td>
<td>38</td>
</tr>
<tr>
<td>Saving Projects</td>
<td>39</td>
</tr>
<tr>
<td>Exiting Open Workbench</td>
<td>40</td>
</tr>
<tr>
<td>Using Standard Views</td>
<td>41</td>
</tr>
<tr>
<td>Summary</td>
<td>54</td>
</tr>
</tbody>
</table>

## 3 Program Preferences

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>56</td>
</tr>
<tr>
<td>Defining Program Defaults</td>
<td>57</td>
</tr>
</tbody>
</table>
4 Views, Filters, Sorts, and Highlights

Overview ................................................................. 68
Using the Library ....................................................... 69
Working with Field Names ............................................. 75
Working with Views .................................................... 77
Working with Filters ................................................... 87
Working with Sorts ..................................................... 92
Changing View Display Colors ................................. 97
Highlighting Project Information ............................ 100
Customizing the Look of Gantt Charts ................. 109
Setting Time Scales .................................................. 111

5 Working with Projects

Overview ................................................................. 116
Opening Projects ....................................................... 117
Creating and Editing Projects .............................. 120
Using Calendars ......................................................... 130
Sharing Project Data Using Email ..................... 135
Finding Information in Projects ......................... 136
Cutting, Copying, and Pasting Project Data .......... 138

6 Creating and Managing Project Tasks

Overview ................................................................. 146
Adding Tasks .......................................................... 147
Defining and Editing Task Properties ..................... 149
Managing Tasks From Views ..................................... 169
Editing Multiple Task Selections ......................... 171
Shifting Tasks ........................................................ 175
Deleting Tasks ........................................................ 177

7 Working with Multiple Projects

Overview ................................................................. 180
Establishing Master and Sub-project Relationships .... 181
Working with Dependencies ................................ 188
1 Getting Started

In this chapter:

- "Overview" on page 2
- "Installing Open Workbench" on page 3
- "Starting and Exiting Open Workbench" on page 4
- "Windows in Open Workbench" on page 6
- "Shortcut Bar" on page 9
- "Toolbar Basics" on page 11
- "Keyboard Navigation" on page 17
- "Managing Columns and Rows" on page 19
- "Printing" on page 21
- "Using Online Help" on page 25
Overview

Open Workbench is an application for project scheduling and management. It conforms to and supports the underlying ideas of project management while presenting information in an intuitive and easy to learn format.

Using Open Workbench, you can create projects, populate them with tasks, create dependencies on tasks that are internal and external to the project, and assign resources. You can also import data, such as tasks, from other projects. You can display Project data in a variety of ways, including spreadsheet views, Gantt charts, and CPM networks. Open Workbench provides standard views that you can use as-is or modify to meet your needs.

Additionally, Open Workbench allows users to save and share projects in a central database repository when Open Workbench is connected to a portfolio management system. To learn more about these and other features in the Clarity portfolio management system from Niku, visit www.niku.com/go/owb."
Installing Open Workbench

To install Open Workbench on your workstation:

1. Double-click the Open Workbench Setup executable file wbsetup.exe. This file guides you through the program setup process using the Install Shield Wizard. The Choose Setup Language dialog appears.

2. Choose the language in which you want to install Open Workbench. For example, to install using the English language, choose English (United States).

3. Click OK. The Install Shield Wizard dialog appears.

4. Follow the on-screen installation instructions. Click Next to move forward in the wizard.

5. Once the installer has successfully installed Open Workbench, click Finish.
Starting and Exiting Open Workbench

Starting Open Workbench

To start Open Workbench from your workstation in Windows:

☞ Do one of the following:

• Choose Start — All Programs — Open Workbench.

• Choose Start — Run and enter the full pathname of the program executable file, enclosed in double quotation marks (optionally followed by the name of the file to open):

  "C:\Program Files\Open Workbench\bin\npWbench.exe"

  Click OK.

Note: The Tip of the Day dialog appears at startup. To have this dialog not appear each time you start Open Workbench, on the Tip of the Day dialog, de-select Show Tips at StartUp and click OK. If the Tip of the Day does not appear and you would like it to appear when you run Open Workbench, from the Tools menu, choose Options and select the Show Tips at Startup check box on the General tab and click OK.
Exiting Open Workbench

To exit Open Workbench:

1. From the File menu, choose Exit.

   If you have modified or created projects, views, sorts, or filters during an Open Workbench session, you are asked if you want to save them. A confirmation dialog box displays for each item.

2. To save the project, view, sort, or filter before exiting Open Workbench, click Yes.

   If the project had previously been saved, then it is saved automatically. Otherwise, the Save As dialog box appears.

   Use this dialog box to enter a file name and directory location.
Windows in Open Workbench

In this section:
- "Main Window" on page 6
- "Window Elements" on page 7
- "Docking Windows" on page 8

Main Window

Open Workbench views are displayed in windows that contain many familiar features and some features you may not have seen before. This section describes some of the features you may see in the Open Workbench user interface.
# Window Elements

The following are descriptions of the various window elements displayed in Open Workbench:

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Shortcut bar</td>
<td>Gives you easy access to groups and their views. For more information see “Shortcut Bar” on page 9.</td>
</tr>
<tr>
<td>Tab Views</td>
<td>Gives you fast access to multiple view windows.</td>
</tr>
<tr>
<td>Task detail</td>
<td>Displays the project plan.</td>
</tr>
<tr>
<td>Resource detail</td>
<td>Displays information about resources available for use in a project.</td>
</tr>
<tr>
<td>Gantt chart</td>
<td>Displays the status of tasks, their start and finish dates, and their duration.</td>
</tr>
<tr>
<td>Split bar</td>
<td>Separates a window into panes. To move a split bar, click and drag it to a new position in the window.</td>
</tr>
<tr>
<td>Panes</td>
<td>Display separate areas in a split or single window. To resize a pane, move a split bar to a new position. Use the scroll bar to view all of the data in a pane.</td>
</tr>
<tr>
<td>Toolbar buttons</td>
<td>Provide fast access to commonly-used commands and tasks. For more information on toolbars, see “Toolbar Basics” on page 11.</td>
</tr>
<tr>
<td>Header buttons</td>
<td>Select a row. Double-click to open the Project Properties, Task Properties or Resource Properties dialog box depending on which header button you click.</td>
</tr>
</tbody>
</table>
Docking Windows

In order to display the data you want to see when multiple views are displayed as windows, you can determine the positions of the windows so that data are displayed simultaneously.

To dock view windows:

1. Reduce the view from a tabbed view to a window(s), by clicking the minimize view button.

2. Right-click the view window title bar. Following is an example of a minimized window with the shortcut menu displayed.

3. Choose any of the following options from the shortcut menu:

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Docked</td>
</tr>
<tr>
<td>Drags a view window to another location inside or outside of Open Workbench. To move a view to your desktop, select it and then drag the view window to a new location.</td>
</tr>
<tr>
<td>Floating</td>
</tr>
<tr>
<td>Aligns a view window to the top, left, bottom, or right side of the window.</td>
</tr>
<tr>
<td>MDI Child</td>
</tr>
<tr>
<td>(Multiple Document Interface) Child disables docking and keep a separate view window inside the main Open Workbench window.</td>
</tr>
<tr>
<td>Docketed to</td>
</tr>
<tr>
<td>Specifies a docking position.</td>
</tr>
<tr>
<td>MDI Child as</td>
</tr>
<tr>
<td>Minimizes, maximizes, or restores the size of a view window.</td>
</tr>
</tbody>
</table>
Shortcut Bar

The shortcut bar displays views that you can apply to projects. When you click a view in the shortcut bar, this view replaces the displayed view of the project with a different view. You can also simultaneously display different views of the same project.

For more information on using the shortcut bar to apply views, see “Working with Views” on page 77.

In this section:
- “Shortcut Bar Display” on page 9
- “Right-Click Menu Options” on page 10

Shortcut Bar Display

The shortcut bar displays up to 32 groups each containing views, sorts, and filters by category from the library. When you choose a group, the shortcut bar displays icons representing views, sorts, and filters, which you can then click and apply to a project.

<table>
<thead>
<tr>
<th>Display Type</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Examples of group display</td>
<td></td>
</tr>
<tr>
<td>Favorites</td>
<td></td>
</tr>
<tr>
<td>Planning</td>
<td></td>
</tr>
<tr>
<td>Executing</td>
<td></td>
</tr>
<tr>
<td>Controlling</td>
<td></td>
</tr>
<tr>
<td>Filters &amp; Sorts</td>
<td></td>
</tr>
</tbody>
</table>

Examples of view, sort, and filter icons

By default, Open Workbench displays the shortcut bar on the left side of the window. However, you can change this location or turn the shortcut bar display on or off.

To hide the shortcut bar:

- From the Tools menu, choose Options, and then clear the View Shortcut Bar check box.

To restore the shortcut bar:

- From the Tools menu, choose Options and then select the View Shortcut Bar check box.

To reposition the shortcut bar:

1. Click the top of the bar.
2. Drag the bar to another location in the window.
### Right-Click Menu Options

When you right-click a view on the shortcut bar, the following options display:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Large Icon</td>
<td>Enlarges the size of the view buttons.</td>
</tr>
<tr>
<td>Small Icon</td>
<td>Reduces the size of the view buttons.</td>
</tr>
<tr>
<td>New Window</td>
<td>Opens a new project window with the chosen view applied.</td>
</tr>
<tr>
<td>Library</td>
<td>Opens the Libraries dialog box. For more information on using this dialog box, see &quot;Working with the Libraries Dialog Box&quot; on page 71.</td>
</tr>
<tr>
<td>Edit</td>
<td>Available only when you choose a view in the shortcut bar; opens the View Definition dialog box for that view. For more information on using this dialog box, see &quot;Working with Views&quot; on page 77.</td>
</tr>
</tbody>
</table>
Toolbar Basics

Open Workbench has a modifiable toolbar that displays buttons that duplicate many menu commands. You can use the default toolbar, create toolbars to meet specific needs, add toolbar buttons to the menu bar, and define which toolbars to display.

In this section:
- "Displaying Toolbars" on page 11
- "Customizing Toolbars" on page 13
- "Creating New Toolbars" on page 14
- "Editing Toolbars" on page 15
- "Removing or Deleting Toolbars" on page 16

Displaying Toolbars

You can decide what toolbars appear in Open Workbench, where they are placed, and what buttons they display.

To specify which toolbars appear:

1. Open the Customize dialog box.
2. On the Toolbars list of the Toolbars tab, select a toolbar check box. The toolbar appears in the Open Workbench window.
The following toolbar buttons are available in Open Workbench:

- Create a new project
- Insert Clipboard contents
- Open an existing project
- Undo the last action
- Save the active document
- Add a row or column to the active view
- Print the active view
- Delete selected information from the active view
- Close the active project
- Find specified search criteria
- Preview the active view before printing
- Select all objects
- Send the active file through E-mail
- List available views, sorts, and filters
- Set the project properties
- Open the definition of the active view
- Cut the selection and put it on the Clipboard
- List dependencies in external projects
- Save the active view
- Display, create, and delete sub-projects
- Display the calendar used for all projects
- Display program information, version number, and copyright.
- Schedule tasks automatically in order of priority
- Zoom in
- Set or clear a baseline for selected tasks
- Zoom out
- Copy the selection and put it on the Clipboard

To place a toolbar:

- Click the toolbar from the Open Workbench window and drag it to a new location.
Customizing Toolbars

Use the Customize dialog box to create and edit toolbars and to define their contents.

To open the Customize dialog box:

△ From the Tools menu, choose Customize. The Customize dialog box appears. Use this dialog box to define toolbar display options.
Creating New Toolbars

To create a new toolbar:

1. Open the Customize dialog box.
2. On the Toolbars tab, click New.
3. In the Toolbar name text box, enter a name for the toolbar.
4. Click OK. The toolbar name appears on the Toolbars list.
5. Select the toolbar’s check box to display the toolbar in Open Workbench.
6. Click Commands to view the Commands tab.
7. Drag buttons from the Buttons group to the toolbar.
Editing Toolbars

You can add and remove buttons appearing on a toolbar or on the menu bar, and you can rename toolbars that you have created. You can also define how toolbars are displayed. Toolbar display options are available on the Toolbars tab of the Customize dialog box. Selected options apply to all toolbars and include:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Tooltips</td>
<td>Select to display the name of the toolbar button.</td>
</tr>
<tr>
<td>Cool Look</td>
<td>Select to add a 3-D look to the toolbar.</td>
</tr>
<tr>
<td>Large Buttons</td>
<td>Select to enlarge toolbar buttons.</td>
</tr>
</tbody>
</table>

Adding Buttons

To add a button to a toolbar or the menu bar:

1. Open the Customize dialog box and click Commands. The Commands tab appears.
2. From the Categories list, select a category to display their associated buttons. The buttons appear in the Buttons group.
3. From the Buttons group, drag a button to the desired toolbar or to the menu bar.

Renaming and Resetting Toolbars and the Menu Bar

You can rename the toolbars you create but you cannot rename the Menu bar and Default toolbar selections. If you change the Menu bar or the Default toolbar selections, you can reset them to their original states. Use the Toolbars tab of the Customize dialog box to rename or reset toolbars.

To rename a toolbar:

1. Make a selection from the Toolbar list.
2. In the Toolbar Name text box, enter a new name.

To reset a menu bar or toolbar:

- Select the toolbar from the Toolbars list, then click Reset.
Removing or Deleting Toolbars

Removing Toolbars
To remove a toolbar from display in Open Workbench:

1. Open the Customize dialog box.
2. In the Toolbars list, de-select the desired check box.

Deleting Toolbars
The Delete button is available only when the toolbar you are deleting is user-defined. You cannot delete the Menu bar or Default toolbar selections.

To delete a toolbar:

1. Open the Toolbars tab of the Customize dialog box.
2. Make a selection on the Toolbars list, then click Delete.
## Keyboard Navigation

<table>
<thead>
<tr>
<th>Keys</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrow keys</td>
<td>Traverse cells in a view and on a grid.</td>
</tr>
<tr>
<td>Home</td>
<td>Move to the first cell on a row in a view.</td>
</tr>
<tr>
<td>Ctrl + Home</td>
<td>Move to the first cell displayed in a view.</td>
</tr>
<tr>
<td>End</td>
<td>Move to the last cell on a row in a view.</td>
</tr>
<tr>
<td>Ctrl + End</td>
<td>Move to the last cell displayed in a view.</td>
</tr>
<tr>
<td>Left mouse-click</td>
<td>Rearrange tasks by selecting them then dragging them to a new location or assign a resource to a task by selecting it and dragging it onto the task.</td>
</tr>
<tr>
<td>Right mouse-click</td>
<td>In many cases, displays a shortcut menu of commands specific to the open window or dialog box group.</td>
</tr>
<tr>
<td>Insert</td>
<td>Insert a column or a row.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete a column or a row.</td>
</tr>
<tr>
<td>Tab</td>
<td>Move forward through cells in a view or grid and through text boxes in a dialog box.</td>
</tr>
<tr>
<td>Shift + Tab</td>
<td>Move backward through cells in a view or grid and through text boxes in a dialog box.</td>
</tr>
<tr>
<td>Ctrl + A</td>
<td>Select all objects in a spreadsheet view.</td>
</tr>
<tr>
<td>Ctrl + C</td>
<td>Copy a highlighted selection and put it on the Clipboard.</td>
</tr>
<tr>
<td>Ctrl + F</td>
<td>Invoke the Find dialog.</td>
</tr>
<tr>
<td>Ctrl + N</td>
<td>Display a new, empty project with the default view applied.</td>
</tr>
<tr>
<td>Ctrl + O</td>
<td>Invoke the Open dialog box.</td>
</tr>
<tr>
<td>Ctrl + P</td>
<td>Invoke the Print dialog box.</td>
</tr>
<tr>
<td>Ctrl + S</td>
<td>Save a project or invoke the Save As dialog box.</td>
</tr>
<tr>
<td>Ctrl + V</td>
<td>Insert Clipboard contents.</td>
</tr>
<tr>
<td>Ctrl + X</td>
<td>Cut a selection and put it on the Clipboard.</td>
</tr>
</tbody>
</table>
### Getting Started

**Keyboard Navigation**

<table>
<thead>
<tr>
<th>Keys</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + Z</td>
<td>Undo the previous action.</td>
</tr>
<tr>
<td>Alt + F4</td>
<td>Exit Open Workbench.</td>
</tr>
<tr>
<td>Ctrl + F6</td>
<td>Display the next view window.</td>
</tr>
<tr>
<td>Ctrl + F4</td>
<td>Close the current view.</td>
</tr>
<tr>
<td>Ctrl + Shift + C</td>
<td>Object Copy Content.</td>
</tr>
<tr>
<td>Ctrl + Shift + V</td>
<td>Object Paste Special.</td>
</tr>
<tr>
<td>F1</td>
<td>Display online Help for a dialog box, a menu command, or subcommand.</td>
</tr>
<tr>
<td>F2</td>
<td>Edit the contents of a cell in a view.</td>
</tr>
<tr>
<td>F3</td>
<td>Edit the current view.</td>
</tr>
<tr>
<td>F4</td>
<td>Find next.</td>
</tr>
<tr>
<td>F5</td>
<td>Refresh.</td>
</tr>
<tr>
<td>F8</td>
<td>Modify project, task, or resource properties.</td>
</tr>
</tbody>
</table>
Managing Columns and Rows

You can change the width of columns in views, on some grids that appear in dialog boxes and, in some cases, you can insert and delete columns. These features let you determine the amount of data displayed in a column, the order of its display and, sometimes, the sort order of rows.

In this section:
- "Resizing Columns" on page 19
- "Inserting and Deleting Columns" on page 19
- "Inserting and Deleting Rows" on page 19

Resizing Columns

In some dialog boxes and most views, you can resize columns to see more or less data.

To resize column width:
1. Place your cursor over the column line at the top of the grid. The cursor changes to a double-headed arrow.
2. Click and hold the left mouse button, and then drag the column line to the left or right.

Inserting and Deleting Columns

When you are in the View Definition dialog box, you can insert and delete columns, even when they contain cells populated with field names.

To insert a column:
- Click the top of a column, and then press the Insert key. A new column is added to the left of the selected column.

To delete a column:
- Select a column, and then press the Delete key.

Inserting and Deleting Rows

You can insert and delete rows that appear in most views and in many dialog boxes that display a grid.

Inserting and Deleting Rows in Grids

To insert rows:
- Select a row's header button, and then press the Insert key.

To delete rows:
- Select a row's header button, and then press the Delete key. Not all Grids support these actions.
Inserting and Deleting Rows in Views

Inserting a row in a view provides you with an easy way to add data to a specific place in a project. However, when you delete rows from a view, be careful that they do not contain data you will need later in the project.

To insert a row:

➤ Select a row header button, and then press the Insert key.

To delete a row:

➤ Select a row header button, and then press the Delete key.

**Warning:** If you accidently delete a row, you can only recover it immediately by pressing the Ctrl + Z keys or by choosing Undo from the Edit menu.
Printing

Some dialog boxes provide you with direct access to printing project information. When you click Print in a dialog box, the Print dialog box appears. Use this dialog box to specify printing options and to print the contents of the dialog box.

In this section:
- "Previewing a Project" on page 22
- "Setting Up a Page" on page 23
- "Setting Up a Printer" on page 24
- "Printing Views" on page 24
- "Technical Support" on page 25

Following are some of the features available for printing spreadsheet views and CPM networks:

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click this icon to open a print preview window where you can see a project before printing it. You can also print directly from this window.</td>
</tr>
<tr>
<td>Page Setup (from the File menu)</td>
</tr>
<tr>
<td>Print Setup (from the File menu)</td>
</tr>
<tr>
<td>Click this icon to automatically print a view.</td>
</tr>
<tr>
<td>Print (from the File menu) or Ctrl + P</td>
</tr>
</tbody>
</table>
Previewing a Project

Use the Print Preview feature to see your project before you print it. This option is unavailable when you are printing from a dialog box.

To preview a print job:

1. From the File menu, choose Print Preview. The print preview window appears, displaying what the view will look like when printed.

2. Optionally, click Close to return to the view, or click Print to open the Print dialog box where you can set your printer options and print the view.
Setting Up a Page

Use the Page Setup dialog box to define page margins, alignment, ordering, and other page attributes prior to printing. The header that appears at the top of every printed page is created automatically, in the form: *File name - View name*. You can view this header by using the File / Print Preview command, but you cannot edit it.

Set print margins to at least 0.75”. When you print views with top and bottom print margins set very small (less than 0.75” in the Page Setup dialog box), view data may overwrite the headers and footers.

To set up pages:

1. From the File menu, choose Page Setup. The Page Setup dialog box appears.

2. Use the selections in this dialog box to define your page settings.

3. To apply these settings to other projects, select the Save Settings as Default check box.

4. Click OK.
Setting Up a Printer

To set up your printer:

1. From the File menu, choose Print Setup. The Print Setup dialog box appears.

2. Use the selections in this dialog box to select a printer and other print options, such as paper size and orientation.

3. Click OK. (Open Workbench does not support plot printers.)

Printing Views

To print a view:

1. From the File menu, choose Print. The Print dialog box appears.

2. Use the Print dialog box to define the print parameters.
Using Online Help

Open Workbench provides you with several ways to access online Help, answering questions about dialog boxes and procedures.

To access online Help, perform one of these steps:

- Press the F1 key when the Open Workbench main window is displayed, then use the resulting dialog box to navigate to the appropriate Help topic.
- From the Help menu, choose Open Workbench Help, then use the Table of Contents in the left pane to navigate to the appropriate Help topic.

To display online Help for a dialog box:

1. Do one of the following:
   - Press the F1 key.
   - Click Help in the resulting dialog box.

2. Use the online Help text and links to navigate to the location where the field name is described.

To get online Help for dialog box elements, do one of the following:

- Click the question mark on the title bar of a dialog box. The mouse pointer changes to a question mark (?). Drag the question mark to an area in the dialog box and click the mouse button.
- Place your cursor on a dialog box element and press the Shift + F1 keys. The resulting window displays online Help for the active tab of the dialog box.

To display online Help on menu and submenu commands:

Choose a menu or submenu command, and then press the F1 key.

Technical Support

For further assistance with Open Workbench, please visit [http://www.openworkbench.org](http://www.openworkbench.org).

The Open Workbench website provides the most current information on supported Open Workbench versions, including Technical Support hotline numbers for contacting Niku’s world-class technical support organization.

You can purchase a Niku maintenance contract to receive technical assistance on Open Workbench. SourceForge.net provides community based support for Open Workbench users who are not under a Niku maintenance contract.
Getting Started
Using Online Help
3 Program Preferences

In this chapter:
- "Overview" on page 56
- "Defining Program Defaults" on page 57
Overview

This chapter describes how you specify default program preferences and project defaults. Program preferences determine how Open Workbench behaves each time you start it (for example, the presence of the Tip of the Day dialog box that displays when you start), while project defaults impact other project settings, such as default directory locations and the default dependency type automatically assigned when you create dependency relationships. Every project you create automatically uses these defaults unless you specify otherwise.

Some dialog boxes allow you to override default settings. Changes you make in dialog boxes are automatically saved with your project and override the program defaults when you open the project.
Defining Program Defaults

You define program defaults and behavior on tabs in the Options dialog box. These customizable defaults determine the overall behavior and can be changed as needed.

To open the Options dialog box:

⇒ From the Tools menu, choose Options. The Options dialog box appears. Use the tabs in this dialog box to define project defaults and program behavior.

In this section:

- "Using the General Tab" on page 57
- "Using the Defaults Tab" on page 59
- "Using the Locations Tab" on page 61
- "Using the WBS Tab" on page 63
- "Using the Display Tab" on page 65

Using the General Tab

Use the General tab of the Options dialog box to define default program behavior such as the display of Open Workbench window components, project file formats, the default location where files are saved, and the default location of methodology guidelines. Many of the selections you make in this dialog box can be overwritten in other dialog boxes.
Program Preferences
Defining Program Defaults

To use the General tab:

1. Select the Show Tips at Startup check box to see daily tips for using Open Workbench each time you run the program. De-select this check box if you do not want to see daily tips. **Note:** You can turn off this feature from the Tip of the Day dialog box.

2. Select the Display Status Bar check box to display a status bar at the bottom of the Open Workbench window. The status bar provides you with information that can include how to get online help, or what a function a specific toolbar button performs.

3. Select the View Shortcut Bar check box to display the shortcut bar in the Open Workbench window. De-select this check box if you do not want the shortcut bar to appear.

4. In the Recent Project File List Contains text box, enter the number of recently-opened files you want displayed at the bottom of the File menu. You can display anywhere from one to nine files.

5. From the Default Project Format drop-down list, choose the default file format to use when opening and saving project files. You can override this default when you save files using the Save As dialog box.

6. Specify the Default Currency for the project.

7. By default, the Warn When Reading or Writing Different Currencies option is selected. To turn off this warning, de-select the checkbox.

8. In the Guideline URL text box, enter a default Uniform Resource Locator (URL) or the directory and path where project guidelines are located.
   - If guidelines are located on your company’s intranet, you can access them by typing the guideline’s URL. For example, enter:
     
     http://www.guidelines.com
   - If guidelines are located on your hard drive, enter file:/// followed by the directory and path (optionally followed by the name of the guideline file and its extension). For example, enter:
     
     file:///c:\guidelines\plan.htm

   For more information on methodology guidelines, and to override the default guidelines location, see “Using the Methodology Tab” on page 163.

9. In the Note Categories group, enter category names that you will later assign to notes. Categories you create are available for selection in every dialog box that has a Notes tab.
Using the Defaults Tab

Use the Defaults tab of the Options dialog box to define preferred project scheduling behavior. In most cases, you can override this information as needed.

![Options dialog box with Defaults tab highlighted]

To use the Defaults tab:

1. Select a default resource loading pattern from the Loading Pattern drop-down list.

   Loading patterns determine how Autoschedule distributes resource usage over the duration of a task. The following resource loading patterns are available:

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Uniform</td>
</tr>
<tr>
<td>Fixed</td>
</tr>
<tr>
<td>Contour</td>
</tr>
<tr>
<td>Front</td>
</tr>
<tr>
<td>Back</td>
</tr>
</tbody>
</table>

2. From the Unit of Measure pull-down, choose how resource value is measured. Resource value can be measured in hours and days.
3 Do one of the following with the Fixed Duration check box:

- Select to constrain tasks by the time needed to complete them, regardless of how many resources are assigned. When you autoschedule a project, the length of fixed-duration tasks is not changed.
- De-select to make the task duration variable. Variable duration constrains tasks by the availability and number of assigned resources.

**Note:** When you run Autoschedule, Open Workbench adjusts the length of variable-duration tasks around the remaining availability, loading patterns, and maximum percent loading of assigned resources. Choose a default dependency link type from the Type drop-down list. The following types are available:

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Finish-Start</td>
</tr>
<tr>
<td>Start-Start</td>
</tr>
<tr>
<td>Finish-Finish</td>
</tr>
<tr>
<td>Start-Finish</td>
</tr>
</tbody>
</table>

- In the Lag text box, enter a number that represents an amount of time, or a percentage, in which a successor task’s constraining date starts before or after its predecessor task’s constraining date. You can enter a positive or negative number.
- From the Lag Type drop-down menu, choose a unit of measure for the value entered in the Lag text box. You can specify Lag in terms of time or percent.
- Lag is calculated as a percentage of the predecessor task’s duration if you choose Percent from the Lag Type drop-down list.
- From the Based On drop-down list, choose whether Percent Complete values for the project are based on user-entered values or calculated based on Percent Expended. If you chose Percent Expended, the Percent Complete field is not automatically populated by the Percent Expended value.

**Note:** If you are working with an .RMP project, you must manually enter percent complete values.

For more information on dependencies, see *Working with Dependencies* on page 188.
Selecting a Percent Complete Value

Use the final area in the Defaults tab to specify how Open Workbench computes the Percent Complete value, which is used in Earned Value calculations such as BCWP, CV, CPI, CVI, SV, SVI, SVP, and the Perform % Complete field. (See “Using Earned Value Variances for Analysis” on page 246.)

<table>
<thead>
<tr>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>User-Entered Value</td>
<td>Use the value that a user enters in the % Complete field on the Task Properties - General dialog box (see “Using the General Tab” on page 150). This is the default setting.</td>
</tr>
<tr>
<td>% Expended</td>
<td>Use the value in the % Expended field of a View (Task Status group). This calculated value is based on Actuals and Total Usage.</td>
</tr>
</tbody>
</table>

**Note:** Because % Expended is calculated and can be more precise than % Complete (which is user-entered and limited to 2 decimal places), Earned Value calculations such as BCWP and the others listed above may produce different results depending on which Percent Complete value you select.

Using the Locations Tab

Use the Locations tab of the Options dialog box to define or change the default directory locations for libraries such as the view library, and other files from which you save or retrieve information.
Default directory locations that you can specify include:

<table>
<thead>
<tr>
<th>Directory</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Corporate View Library</td>
<td>The location of the corporate view library you are using, if any. This library contains all views, filters, and sorts defined at a corporate level.</td>
</tr>
<tr>
<td>User View Library</td>
<td>The location of your personal view library. This library contains all views, filters, and sorts you define and save.</td>
</tr>
<tr>
<td>Highlights File</td>
<td>The location of your highlights file. You can also choose a default highlights file to be applied to all view windows. Use a highlights file to increase the visibility of specific data in a project.</td>
</tr>
<tr>
<td>Default View</td>
<td>The name and location of the default view you want applied to projects. If you do not specify a default view, projects you open in an empty Open Workbench window display a minimum amount of information.</td>
</tr>
<tr>
<td>Project Files</td>
<td>The directory where your project files are stored. You can override this location for individual projects.</td>
</tr>
<tr>
<td>Global Files</td>
<td>The default location of global settings, such as calendars, resource files, and note categories.</td>
</tr>
<tr>
<td>Custom Dictionary</td>
<td>The location of your custom spelling dictionary.</td>
</tr>
</tbody>
</table>

To specify default directory locations for all but Project Files and Global Files directories:

1. Select an item on the list and click Browse. The Open dialog box appears.
2. Use this dialog box to select a default directory location. The location displays in the Locations tab.

To specify default directory locations for Project Files and Global Files:

1. Select an item in the list and click Browse. The Browse for Folder dialog box appears.
2. Use the Browse for Folder dialog box to select a folder for your project files.
Using the WBS Tab

Use the WBS tab of the Options dialog box to add and delete Work Breakdown Structure (WBS) levels, and to define or change WBS level names. You can define any number of WBS levels.

Some edits to the WBS tab are done in the Summary Levels Label list. Editing features include: Undo, Cut, Copy, Paste, Delete, and Select All.

To edit the Summary Levels Label list:

 peny-click the list and select one of the editing features from the shortcut menu.

Customizing WBS level names

To customize names assigned to WBS levels:

1. In the Milestone Label text box, enter a new name for the new level name.
2. In the Task Label text box, enter a new name for the task.
3. In the Summary Levels Label list, select the name of the name of the WBS level you are re-naming (by double-clicking the name in the list) and enter a new name.
Inserting WBS levels

In addition to changing WBS level names, you can add WBS levels. Keep in mind the following rules when inserting WBS levels in the Summary Levels Label list:

- WBS level names must be unique.
- When a WBS level is inserted above an existing level, the levels below the insertion are downgraded.

To insert WBS levels:

1. Click in the Summary Levels Label list where you are inserting the WBS level, then press the Enter key. A blank space appears.
2. Enter a name for the WBS level in the blank space.

To insert a WBS level at the bottom of the list:

1. Select the last level in the Summary Levels Label list and press the down-arrow key. A blank space appears.
2. Enter a name for the WBS level.

Deleting WBS levels

To delete WBS levels:

- Select a WBS level and press the Delete key.

How WBS levels are displayed

Some dialogs boxes in Open Workbench use icons to represent WBS levels. When you change WBS level names, equivalent icons are displayed. Following is a list of WBS icons that you may see in Open Workbench:

<table>
<thead>
<tr>
<th>WBS Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon] Project</td>
</tr>
<tr>
<td>![Icon] Phase and activity (or equivalent)</td>
</tr>
<tr>
<td>![Icon] Task and key task (or equivalent)</td>
</tr>
<tr>
<td>![Icon] Milestone</td>
</tr>
<tr>
<td>![Icon] A proxy task inside an inserted (entire) sub-project, as viewed from the master project.</td>
</tr>
<tr>
<td>![Icon] An individually-inserted proxy task represents an external task. In another project, you inserted an external dependency to a task.</td>
</tr>
<tr>
<td>![Icon] A task inside an inserted (entire) sub-project, as viewed from the master project.</td>
</tr>
<tr>
<td>![Icon] An individually-inserted sub-project task. Instead of inserting an entire project as a sub-project, you inserted only task(s).</td>
</tr>
</tbody>
</table>
Using the Display Tab

Use the Display tab of the Options dialog box to change the display colors of horizontal and vertical separation lines, and the background colors of rows, appearing in spreadsheet views.

A view can display horizontal and vertical lines in color, or not at all, and rows that alternate colors line-by-line or object-by-object. When choosing view display colors, you can use a standard color palette or create a custom color palette.

For complete instructions on how to customize the display colors, see “Changing View Display Colors” on page 97.
Program Preferences
Defining Program Defaults
2 Quick Start

In this chapter:
- "Overview" on page 28
- "Starting Open Workbench" on page 29
- "Specifying Project Properties" on page 31
- "Tasks and Durations" on page 32
- "Task Dependency Links" on page 33
- "Resources" on page 34
- "Scheduling Projects" on page 36
- "Customizing Views" on page 37
- "Printing Views" on page 38
- "Saving Projects" on page 39
- "Exiting Open Workbench" on page 40
- "Using Standard Views" on page 41
- "Summary" on page 54
Overview

This chapter describes basic steps for using the features that let you create and manage projects. Other chapters in this user’s guide provide you with detailed steps, instructions on using advanced features, and other technical information necessary to successfully use Open Workbench for maximum productivity.
Starting Open Workbench

Before continuing:

- Open Workbench must be installed on your computer. For more information on installing Open Workbench, see "Installing Open Workbench" on page 3.

To start Open Workbench:

To start Open Workbench from your workstation in Windows:

Do one of the following:

- Choose Start — All Programs — Open Workbench.
- Choose Start — Run and enter the full pathname of the program executable file, enclosed in double quotation marks (optionally followed by the name of the file to open):
  
  "C:\Program Files\Open Workbench\bin\npWbench.exe"

Click OK.

Note: The Tip of the Day dialog appears at startup. To have this dialog not appear each time you start Open Workbench, on the Tip of the Day dialog, de-select Show Tips at StartUp and click OK. If the Tip of the Day does not appear and you would like it to appear at startup, from the Tools menu, choose Options and select the Show Tips at Startup check box on the General tab and click OK.
The Open Workbench window displays a shortcut bar that contains views which you can apply to projects. The view that is set as the default view is automatically displayed in this window, even if you have not opened a project. If no default view has been set, this window is blank.

In later chapters, you will learn how to define your own views, display projects using different views, and how to move views between libraries according to your preferences.
Specifying Project Properties

Steps in this section describe how to specify properties for a new project. You can define and edit project properties in the Project Properties dialog box. To learn more about project properties, see “Working with Projects” on page 115.

To specify project properties:

1. Open a new or existing project.
2. From the File menu, choose Properties. The Project Properties dialog box appears.
3. Use any of the following tabs to create or edit project properties:

<table>
<thead>
<tr>
<th>Use</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter or edit administrative details for a project.</td>
</tr>
<tr>
<td>Scheduling</td>
<td>Create or edit scheduling properties for a project.</td>
</tr>
<tr>
<td>Resources</td>
<td>Select a team of resources from a list of global resources.</td>
</tr>
<tr>
<td>Key Tasks</td>
<td>View tasks marked as key tasks in a project. You can edit the Start Date and Finish Date for a key task provided no resource is assigned to the key task or if the task is of a fixed duration. When a resource is assigned to a key task, the Start Date and Finish Date are determined by the ETC and the scheduler.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Enter advanced information on how you want to manage the project.</td>
</tr>
<tr>
<td>Notes</td>
<td>Create and edit project-specific notes. You can also use this tab to see historical comments about a project.</td>
</tr>
</tbody>
</table>
Tasks and Durations

In this section:
- "Entering Tasks" on page 32
- "Editing Task Durations" on page 32
- "Task Dependency Links" on page 33

Entering Tasks

Open Workbench provides you with several ways to add project phases, activities, tasks, and milestones. At a minimum, you can add tasks directly in a view.

**Warning:** You cannot add tasks in a CPM network view. Tasks must first be created in a spreadsheet view.

To add a task to a project:

1. Click in a row in the task detail pane of the spreadsheet view and enter a name for the task.
2. As appropriate, click in other cells in the view and enter other task-related information.

Editing Task Durations

When you add a task to a project, the task’s default start date is today’s date or the next working date after today’s date, if today is a holiday or nonwork day. There are several ways to change task duration. To learn more about entering and editing task duration, see “Using the General Tab” on page 150.

To edit task duration:

1. Do one of the following:
   - Use your mouse to drag the left or right side of a Gantt bar to the desired position on the timescale.
   - Double-click the header button for the task to open the Task Properties dialog box.
2 On the General tab of the Task Properties dialog box, use the Duration text box to edit the task duration.

3 Click OK to save your changes.

**Task Dependency Links**

Task dependency links help establish the timing and relationship between tasks in a project. There are many ways to create and edit dependency relationships between tasks. To create predecessor relationships in a spreadsheet view, you must set the view to display tasks.

To create a dependency relationship in a spreadsheet view:

1 Click the header button of the task for which you want to create the dependency relationship.

2 Right-click the header button of another task and choose one of the following options from the shortcut menu:
   - Choose Make Successor if you want the task in Step 2 to be the successor of the task in Step 1.
   - Choose Make Predecessor if you want the task in Step 2 to be the predecessor of the task in Step 1.

The task you select in Step 2 becomes the successor or predecessor of the task you selected in Step 1.

For more information on task dependency links, see “Using the Dependencies Tab” on page 155.
Resources

Resources are the people required to complete a project. Resources can be defined by categories for reporting and analysis, as groups of more than one, or as roles, such as “Business Analyst.” Resources are defined as people and can use different units of measure. You define resource properties using the Resource Properties dialog box. This dialog box is available when you use a view with resource-specific fields or with a resource detail pane.

To define a resource’s general properties:

1. In the resource detail pane, click a row and enter a resource name.
2. Right-click the header button for the resource and choose Modify. The General tab of the Resource Properties dialog box appears. The Resource Properties dialog box contains several tabs where you create or edit properties specific to a resource.
3 Use the following tabs of the Resource Properties dialog box to enter resource information.

<table>
<thead>
<tr>
<th>Use</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Specify resource tracking, availability, and billing information.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Enter advanced resource management details.</td>
</tr>
<tr>
<td>Calendar</td>
<td>Assign vacations, holidays or other periods of nonavailability to a resource.</td>
</tr>
<tr>
<td>Notes</td>
<td>Create and edit resource-specific notes. You can also use this tab to see historical comments about a resource.</td>
</tr>
</tbody>
</table>

4 Click OK to save resource information and to close the Resource Properties dialog box.

For more information on:

- Making resources available to your project from a list of global resources, see “Using the Resources Tab” on page 124.
- Assigning available resources to your project staff, see “Using the Resources Tab” on page 152.
- Defining resource properties, see “Working with Resource Properties” on page 205.
Scheduling Projects

There are several scheduling techniques that you can use to schedule projects; you can also use the Autoschedule feature to automate project scheduling. You can autoschedule an entire project or only the tasks that occur between a range of dates. You can also autoschedule backwards based on the project’s finish date.

Autoschedule performs a series of complex calculations to produce a schedule that considers dependency relationships, and task priorities. The consideration of resource data is optional.

To autoschedule a project:

1. From the Tools menu, choose Autoschedule. The Autoschedule dialog box appears.

   ![Autoschedule dialog box]

2. In the dialog box, define the autoschedule criteria.

   For more information on Autoschedule, the Autoschedule dialog box, and other scheduling methods, see “Scheduling Projects” on page 217.
Customizing Views

Views are the means by which you display a project plan and other project data. You can use views to enter project data, add or delete tasks, or otherwise modify a project plan. Open Workbench provides standard views that you can use, or you can create your own custom views, or modify the standard views. To customize views, you use the View Definition dialog box.

To open the View Definition dialog box and customize a view:

1. Perform one of these steps:
   - From the View menu, choose Edit View.
   - From the View menu, choose Library to open the Libraries dialog box, then use the Libraries dialog box to access the View Definition dialog box.

2. Edit data appearing on tabs of the View Definition dialog box.

3. From the View menu, choose Save View to save the edited view before exiting Open Workbench. The Save View Definition dialog box appears.

4. In the Save View Definition dialog box, name the view and select its Library group and the location where you want to save it.
Printing Views

To print a view directly from the Open Workbench window:

- From the File menu, choose Print.
Saving Projects

To save a new, previously unsaved project:

1. From the File menu, choose Save As. The Save As dialog box appears.
2. Make selections and choose the location to save the project.
3. Click OK.
Exiting Open Workbench

When you exit Open Workbench, a confirmation dialog box appears if you have one or more projects open or if you have not saved changes to views, sorts, and filters.

To exit Open Workbench:

☞ From the File menu, choose Exit. If you have any previously-unsaved changes to the project, views, sorts, and filters, you are prompted to save these changes before Open Workbench exits.
Using Standard Views

Following are brief descriptions of views, sorts, and filters that come standard with Open Workbench, and some of the ways you can use and enhance them. In addition to applying these to projects, you can create variations of them and save them with different names in your Personal View Library.

Favorites Group

In this section:
- “Gantt Chart” on page 41
- “CPM Network” on page 42
- “Phase Level Gantt” on page 43

Gantt Chart

A Gantt chart provides a graphical overview of a project by displaying each task’s duration as Gantt bars across a timescale. You can use this view to manually schedule a project by dragging and shrinking or stretching Gantt bars, and to create dependency relationships between tasks.

This standard view has four sections:
- The project section displays column headers. You can also set up this section to display the project ID, name, start and finish dates, if desired.
- The task detail section displays task information.
- The resource detail section shows resource information, including usage throughout the project.
- A Gantt chart that displays task duration and dependency relationships.
Quick Start
Using Standard Views

For larger projects, you may want to change the timescale increments to monthly or quarterly to see the entire project. If the project is baselined, symbols appear on the Gantt chart that indicate where a task was originally scheduled. The Gantt chart display can also be customized with alternate colors and symbols that are useful for reporting purposes.

By default, the Gantt bars display a solid bar from a task’s start date through its finish date even if there are periods of time where work is not being performed on a task. To show periods of nonwork on the Gantt chart, double-click in the Gantt chart and select the Discontinuous check box in the Gantt dialog box. This chart then displays solid bars only where work is actually scheduled to be performed on a task.

CPM Network

The CPM (Critical Path Method) Network view displays dependency relationships between tasks as well as the project’s critical path. This visual representation of tasks provides a way for you to manually add dependencies directly in the view. The colors and shapes of the CPM cells are controlled through highlight settings.

Zoom In, Zoom Out, and a Panning Overview window provide easy navigation through large CPM networks. Other ways to make the CPM network easier to read include changing the shape and color of the CPM cells for milestones so they are easier to see, and by applying different colors to each phase in the project plan so that phase handoffs can be quickly identified.
# Phase Level Gantt

This view is similar to the Gantt Chart view except that it displays only the phases in a project, and not all tasks in the project’s Work Breakdown Structure (WBS). Use this view to see the phase dates and to drill down to identify and correct potential delays. The Phase Level Gantt is often ideal to present as a printed report to managers who do not need to review the fine details of a project plan.

To can change the level of detail in this view, open the View Definition dialog box and make a different selection from the Level of Analysis drop-down list on the Description tab.
Quick Start
Using Standard Views

Planning Group

In this section:

- “WBS Definition” on page 44
- “Dependency Definition” on page 45
- “Resource Assignment” on page 46

WBS Definition

This view is useful for entering data in the Work Breakdown Structure (WBS), the task list for the project. The WBS Definition view contains some commonly used task-level field names, which you can add to as needed. Use the Key Task? column in this view to flag the more important tasks in your project, which aids in the reporting process.

If a task list already exists outside of Open Workbench in a different format, such as a spreadsheet, you can copy and paste the task names directly into this view rather than re-enter the information.
Dependency Definition

The Dependency Definition view offers a different perspective on dependencies when compared to the CPM Network view. Use this view to see all task dependency relationships without accessing the Task Properties dialog box or scrolling through the Gantt Chart view or the CPM Network view. Rather than display a graphical view of tasks and their relationships, this view displays each task and milestone and all of their predecessors and successors.

You can create dependencies quickly in this view, by choosing tasks and selecting Predecessor or Successor from the drop-down list in the Relation column. You can also create a dependency chain by selecting multiple tasks, and right-clicking, and selecting Make Chain from the shortcut menu.

To verify that all dependencies have been created, apply a filter that uses the following equation in its definition:

Task Dependencies? = No
Use the Resource Assignment view to assign resources to tasks. This view is an alternative to using the Assignments tab in the Task Properties dialog box. Resource Assignment view is best suited for use with Autoschedule when work estimates are entered first before running Autoschedule.

You can assign resources to tasks by selecting them in the resource detail pane of the view and dragging them onto tasks in the task detail pane. Once the resources are assigned, you can add work estimates to each assignment.

To schedule work manually, enter hours directly into this view and apply the Schedule view from the Executing group. This combination provides a way to place estimates on the actual day the work is scheduled to be performed.

Use the Quick Filter by Resource drop-down list to display tasks assigned to a specific resource. To further filter the view and see only the selected resource’s assignments, open the Description tab of the View Definition dialog box and select the Resource LOA check box.
Executing Group

In this section:

- “Schedule” on page 47
- “Dependency Status” on page 48

Schedule

Use the Schedule view for detailed scheduling information. This view provides information on the most commonly-used scheduling fields. This is especially helpful when you need to fine-tune settings before running Autoschedule. After running Autoschedule, you need to reassign resources and reevaluate estimates prior to performing additional autoscheduling. Also, you may want to make sure the project is scheduled within its intended finish date.

By adding column totals to Start and Finish fields, you immediately see the current start and finish dates for the project. Also, you can create and apply filters to see information on specific resources, making it easier to reassign resources to certain tasks.
Dependency Status

This view is similar to the Dependency Definition view in the Planning group and gives date information on tasks that helps identify and resolve dependency violations. Dependency violations display with highlighted task names in the Primary Task column.

Once you identify a violation, you can also look in the Related Task column to see which related tasks also have the dependency violation highlight. This view is helpful when you want to change dependency relationships and make dependency chains.

To further aid in identifying scheduling conflicts, apply a filter that uses the following equation in its definition:

Dependency Violation? = Yes
Controlling Group

In this section:

- “Status Update” on page 49
- “Unused Availability” on page 50
- “Variance Analysis” on page 51
- “Revise Schedule” on page 52

Status Update

After you track actuals to a project, use the Status Update view to close out tasks and revise estimates for tasks in process. Follow the flow of the columns to:

- Review actuals for last week.
- Update the finish dates of tasks.
- Mark tasks as Completed.

You can also use this view in conjunction with the Pending ETC filter in the Filters & Sorts group to inspect only those tasks where the resource has suggested a different ETC.
Quick Start
Using Standard Views

Unused Availability

Apply the Unused Availability view after scheduling a project to see any remaining free hours a resource has on the project. This view is helpful when you need to identify which resources are free during a particular time period so that you can reassign them to different tasks.

To calculate unused resource availability, Open Workbench subtracts the resource’s actual usage and ETC from the resource’s availability for the project.
Variance Analysis

The Variance Analysis view displays start, finish, and usage variance for projects and is useful when you want to know if a task is ahead of schedule, behind schedule, or if it is under or over budget. The default highlights help to quickly identify tasks that are falling behind schedule or those ahead of schedule.

You can use a filter to show only tasks where the variance is above or below a defined threshold. You can also change the Level of Analysis to Phase or Activity on the Description tab of the View Definition dialog box, which allows you to see a summary view of the variances.
Revise Schedule

Use the Revise Schedule view to monitor project schedule and cost. This view uses a Totals section to display the project finish date, the total remaining estimates, and the remaining cost of the project. Use this view to reduce the cost of the project by reassigning less expensive resources to noncritical tasks.

By default, this view displays only remaining hours and cost. To see the total hours and cost of the project, open the View Definition dialog box and replace the Assignment Estimate to Complete field name with the Total Usage field name.
Filters and Sorts Group

In this section:
- "Key Tasks" on page 53
- "Sort By Resource" on page 53
- "Clear Filters" on page 53
- "Clear Sorts" on page 53

Key Tasks

Key tasks are tasks or milestones that you designate as important to a project even if they are not on the project’s critical path. Use this filter when you want to see only the key tasks in the project. This filter removes all tasks in a view that are not marked as key tasks.

Sort By Resource

Sort By Resource rearranges the order of resources in a view, based on their IDs. If the task detail section contains data, this view sorts resources within each task alphabetically without changing the order of tasks. If the only data appearing in a view is in the resource detail section, this sort reorders the resources by their IDs.

Clear Filters

Apply this filter to remove all filters from the view currently in focus. This is a faster alternative for clearing filters than modifying the Filter tab in the View Definition dialog box.

Clear Sorts

Apply this sort to remove all sorts from the view currently in focus. This is a faster alternative for clearing sorts than modifying the Sort tab in the View Definition dialog box.
Summary

As demonstrated in this chapter, you can use Open Workbench to quickly and easily create a project, add tasks to it, and assign resources to those tasks. Using a variety of dialog boxes, you can set project properties, define tasks and resources, record descriptive notes, sort and filter a view, and even create an entirely original view.

Also keep in mind that there is an extensive help system available at all times as you explore the many powerful features and functions built into Open Workbench.
4 Views, Filters, Sorts, and Highlights

In this chapter:
- "Overview" on page 68
- "Using the Library" on page 69
- "Working with Field Names" on page 75
- "Working with Views" on page 77
- "Working with Filters" on page 87
- "Working with Sorts" on page 92
- "Changing View Display Colors" on page 97
- "Highlighting Project Information" on page 100
- "Customizing the Look of Gantt Charts" on page 109
- "Setting Time Scales" on page 111
Overview

Open Workbench uses views, sorts, filters, and highlights to provide you with a way to display, enter, and organize project information. Apply views, sorts, filters, and highlights to see different aspects of your project and access specific project information.

Open Workbench comes with a library of commonly-used predefined views, sorts, and filters that are grouped by type. They are available for your immediate use, and can be customized to meet your needs. To learn more about Open Workbench standard views, see “Using Standard Views” on page 41.

In this chapter you will learn how to create and save views, sorts, filters and how to access the library where they are stored. You will also learn how to highlight project information and how to customize the display of Gantt charts, CPM networks, and time scales.

The views, sorts, and filters that you create can be saved as part of a User View Library that you can easily access.

While views, sorts, and filters are important for displaying project information, highlighting that information adds another level of sophistication to working with views and analyzing project status. When you apply highlights to your projects, you make views and printed reports easier to read, analyze, and understand. To Highlight project information you select field names that may be used in views, set criteria for when the highlight should be applied, and assign special fonts, colors, symbols, and patterns so that information displays according to your preferences.
Using the Library

A library of views, sorts, and filters gives you real-time interaction when you display projects. Use the Library feature to apply different views to one or more open projects and to simultaneously display variations of project data.

When you use the Library, you create groups that categorize views, sorts, and filters by type. For example, you can create a group containing views, sorts, and filters used for planning or tracking purposes. When you create a group and populate it with views, sorts, and filters it becomes part of your User View Library. Groups and their contents also appear in the shortcut bar.

All items associated with your User View Library are customizable.

Corporate View Library

Your organization may create a Corporate View Library that is available for company-wide use. Typically, this library contains views, sorts, and filters which staff members can apply to projects, but to which they have read-only access. In most cases, the contents of the library resides at a network location that is controlled by a network administrator.

Creating the Library

To create the Corporate View Library, you must copy some standard files shipped with Open Workbench to another location and assign the location as a User View Library. Later, you can edit, add, and remove files, then reassign the location as a Corporate View Library.

Before creating a Corporate View Library, become familiar with setting program preferences (discussed in “Defining Program Defaults” on page 57). Specifically, you should be familiar with using the Locations tab of the Options dialog box. Also, you should know how to create, edit, and delete view, sort, filter, and highlight files as described throughout this chapter.

To create a Corporate View Library:

1. Using Explorer or MS-DOS, locate and open the Open Workbench default view located in C:\Program Files\Open Workbench\Views.

2. Copy Standard.rwl and all of the .rwl, .rws, and .rwv files located in C:\Program Files\Open workbench\views\en to a location on a network where you want the Corporate View Library to reside. These are the files you will edit, create, or delete that will comprise the Corporate View Library.

   **Warning:** Do not edit the files located in C:\Program Files\Open Workbench\Views or in C:\Program Files\Open Workbench\Views\en.

3. If desired, rename Standard.rwl to indicate that this is a Corporate View Library. However, retain the .rwl file extension.

4. Start Open Workbench.

5. From the Tools menu, choose Options. The Options dialog box appears.

6. Click Locations. The Locations tab of the Options dialog box appears.
7 Assign the Standard.rwl file location specified in Step 1 as your User View Library location. This step provides you with the means to create, edit, and delete files that will comprise the Corporate View Library.

8 Edit, create, or remove view, sort, and filter files that will comprise the Corporate View Library.

9 On the Locations tab of the Options dialog box, remove the location assigned as a User View Library, and reassign it as the Corporate View Library.

10 If desired, set the User View Library back to C:\Program Files\Open workbench\views\Open_en.rwl.

**Accessing the Library**

In most cases, only the network administrator can add, edit, delete, and assign access to views that are part of the Corporate View Library. While you cannot directly edit these files, you can copy and save them to your hard drive, then customize the copies and include them in your User View Library.

In some organizations, it is the responsibility of the network administrator to communicate the location of the Corporate View Library is located and to provide updates regarding changes.
Defining Default Library Locations

The locations of your User View Library and Corporate View Library are defined on the Locations tab of the Options dialog box. When you create new views, sorts, and filters, and save them to locations other than a library location, you can still associate them with library groups. For detailed instructions for defining library locations see “Using the Locations Tab” on page 61.

Working with the Libraries Dialog Box

The Library dialog box displays groups, and their associated views, sorts, and filters. This dialog box includes the contents of your User View Library and the Corporate View Library.

**Warning:** You must have user rights to change views, sorts, and filters saved in the Corporate View Library. Because this library may be accessible by many staff members, changes you make to it will impact them. You can edit views, sorts, and filters in the Corporate View Library, but to later use the edited files you must save them to a different location and make them part of your User View Library.

Use the Libraries dialog box to create or remove groups, and edit or add views, sorts, and filters to a library group. You can also apply your selections to a project currently in focus, or open a new project window with a different view applied.

To open the Libraries dialog box:

☞ From the View menu, choose Library.
Library icons

Icons in the Library dialog box distinguish views, sorts, and filters in the Corporate View Library from those that are user-defined. You may see a combination of the following icons in the Libraries dialog box:

<table>
<thead>
<tr>
<th>Corporate-Defined Library Icons</th>
<th>User-Defined Library Icons</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Spreadsheet views" /></td>
<td><img src="image" alt="Spreadsheet views" /></td>
</tr>
<tr>
<td><img src="image" alt="CPM network" /></td>
<td><img src="image" alt="CPM network" /></td>
</tr>
<tr>
<td><img src="image" alt="Filters" /></td>
<td><img src="image" alt="Filters" /></td>
</tr>
<tr>
<td><img src="image" alt="Sorts" /></td>
<td><img src="image" alt="Sorts" /></td>
</tr>
</tbody>
</table>

Adding groups

Groups are categories that you populate with views, sorts, and filters that serve a specific purpose. Up to 32 Groups can display on the shortcut bar. When you open a group, all of its associated views, sorts, and filters appear.

To add a group:

1. Open the Libraries dialog box.
2. Select the Groups folder at the top of the list.
3. Click Add. A group folder appears.
4. Enter a name for the group folder.

You can now populate the group with views, sorts, and filters.

**Warning:** The shortcut bar supports a theoretically unlimited number of folders, but it is possible to define too many for your configuration of memory and disk space to support. Two symptoms are:

- You cannot scroll through the entire list of folders.
- You cannot display any folder’s contents.

To resolve the problem, you can reduce the total number of folders by combining their contents.
Populating groups with views, sorts, and filters

An individual view, sort, or filter can belong to a maximum of one group. In addition to populating groups with items you create, you can populate groups with items created by other staff members. To do this, you must have access to the location where those files are stored or the capability to make them part of your User View Library.

To add views, sorts, and filters to a group:

1. Select a group in the Libraries dialog box, and then click Add. The Open dialog box appears.

2. Locate and select a view, sort, or filter, and then click Open.

Your selection is added to the group, appears in the Libraries dialog box, and is available from the shortcut bar.

Applying views, sorts, and filters from Libraries

To apply a view, sort, or filter to a project:

1. Open the Libraries dialog box.

2. Double-click a group and select a view, sort, or filter.

3. Do one of the following:
   - Click New Window to open a new window that displays the project with the selected view.
   - Click Apply to replace the displayed view.

4. If you are applying a sort or filter, click Apply to apply your selection to the current view of the project.
Editing group names

To edit a group name:

1. Open the Libraries dialog box.
2. Click a group, and then click again on its name and enter the group name over the selected text.

Note: If you double-click a group name (as opposed to the click-pause-click described above), you open the group folder and display its contents.

Removing groups from the library

Removing a group from the library deletes only the group’s folder from the list. It does not delete associated views, sorts, and filters. Instead, these items are removed from the Libraries dialog box display.

To remove a group from the library:

1. Open the Libraries dialog box.
2. Select a group and click Remove.
3. Click Close to exit the Libraries dialog box.

Removing views, sorts, and filters from library groups

Removing views, sorts, and filters from groups does not delete them. Instead, they are removed from display in the Libraries dialog box and the shortcut bar. For instructions on reassigning items from one group to another group, see “Populating groups with views, sorts, and filters” on page 73.

To remove views, sorts, and filters from a group:

1. Open the Libraries dialog box and double-click a group.
2. Select an item on the list, and then click Remove.
3. Perform step 2 until all desired items are removed.

Deleting view, sort, and filter files

You can permanently delete view, sort, and filter files when they are saved to your computer or to a location over which you have user rights.

Warning: Depending on where files are stored and how they are accessed, deleting them may have an adverse impact on other staff members who are also using them. Also, you can not recover these files once you delete them.

To permanently delete a view, sort, or filter:

1. Use your standard Windows utility to locate the file.
2. Select and delete the file. To easily find the location of a view, sort, or filter, look in the Locations text box of the Libraries dialog box.
Working with Field Names

Field names are the building blocks of views, sorts, filters, highlights, and the Find feature. They represent either distinct data fields or calculated values used in Open Workbench. When you add field names to a view definition, you define what project data is displayed in the view and how the view is constructed.

Field names are listed by category in a list on the left side of the Layout, Sort, and Filter tabs of the View Definition dialog box, and on the left side of the Sort Definition, Filter Definition, View Highlights, and Find dialog boxes. Icons appearing on the list match rows on the grids of each dialog box. In many cases, when you open a folder you can match field names to their section on the grid.

Assigning Field Names

To assign field names to a view, sort, filter, highlight, or find statement:

1. Double-click a field name icon. The list expands to display folders that categorize and contain available field names. The following groups of field names are available:

<table>
<thead>
<tr>
<th>Section and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Project folder contains project-specific field names.</td>
</tr>
<tr>
<td>The Task Detail folder contains field names that comprise the body of the view; they displayed in the task detail pane. <strong>Note:</strong> Column headings are automatically entered when you place Task and Resource Detail field names on the grid. You can change a heading name by editing it in the column.</td>
</tr>
<tr>
<td>The Resource Detail folder contains resource-specific field names and summary information by resource that displays in the resource detail pane or the task detail pane.</td>
</tr>
<tr>
<td>The Highlight Information folder contains highlighting options that you can use to highlight field names used in a view.</td>
</tr>
</tbody>
</table>
Do one of the following:
- Select field names and drag them onto cells in the grid.
- Enter a field name in a grid cell. The field name must be preceded by “=”. 
- Place the cursor in a cell, and double-click a field name.
- Place the cursor in a cell, and then select a field name and press the Insert key.

In cases where you cannot drag a field name onto a cell, the Add Fields Feedback status bar at the bottom of the View Definition dialog box provides an explanation.

Additionally, in cases where you can drag a field name onto a cell, when a cell is selected, fields allowed in that location display in bold text.

**Viewing Field Name Definitions**

Online Help describes the purpose and use of the field names appearing in Open Workbench.

To see field name definitions:
1. Click anywhere in the grid.
2. Click Help then follow the links that lead you to the field name descriptions.
Working with Views

Open Workbench views are the means by which you display a project plan and other project data. Many views are available for you to enter data, add or delete tasks, and otherwise modify data in a project plan. Also, you can:

- Create new views and make them part of your User View Library.
- Modify and replace existing views.
- Modify existing views and save them as new views.
- Print views of a project (for more information on printing views, see “Printing Views” on page 86).

View Display Options

You display project data in views that take the form of spreadsheets, which may use Gantt charts to graphically display project status and task relationships, and CPM networks, to display task relationships and the project’s critical path.

Both types of views use field names in their definitions to determine what data they display, and both are created in the View Definition dialog box. Each type displays project information in a different format.

You select the view display format when you define a view in the View Definition dialog box. For more information on using this dialog box see “Understanding View Definitions” on page 80.

Spreadsheet views

Spreadsheet views present project data in variety of ways. They can appear as spreadsheets with editable cells, and can also display a Gantt chart that depicts the project’s schedule and the timing and relationships between tasks. Depending on the field names used to define the view, spreadsheet views may contain several panes that display different types of project information. For example, a spreadsheet view may display any combination of the following:

- a task detail pane containing editable project information
- a pane displaying a Gantt chart and a time scale
- a resource detail pane containing editable information on resources that are available for task assignments or that are assigned to tasks
Views, Filters, Sorts, and Highlights

Working with Views

- a time scale that displays days or date ranges

When a view displays a Gantt chart or time scale, you can customize both to meet your needs. You can also customize time scales for views that contain tabular fields. For instructions on customizing Gantt charts and time scales, see “Customizing the Look of Gantt Charts” on page 109, and “Setting Time Scales” on page 111.
CPM networks

CPM networks display data as a graphical model of tasks and their relationships. Each task is portrayed in a cell which may be linked to other cells in order of precedence. Unlike spreadsheet views, you cannot enter, sort, or filter data directly in CPM networks. However, you can create dependency relationships in a CPM network and you can edit task properties by opening a Task Properties dialog box from the CPM network.

There are several features available when you display a CPM network that are helpful when you are displaying a lot of data. Right-click anywhere in a CPM network to open a shortcut menu of display options that include:

<table>
<thead>
<tr>
<th>Shortcut Menu Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom In</td>
<td>Enlarges the display. This feature is helpful if you want to take a closer look at the cells in the network.</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Reduces cell display size. The Windows System Font does not scale and may be rendered unreadable by zooming out. One way to solve this is to change the Windows System Font to a scalable one, such as Arial. Another way is to Zoom back in and manipulate your window on the CPM display.</td>
</tr>
</tbody>
</table>
Views, Filters, Sorts, and Highlights

Working with Views

Understanding View Definitions

Each view has two major pieces: its underlying definition, which is comprised of field names that define the view, and the view window that displays the project data in the specified format. For information about field names, see “Working with Field Names” on page 75. You create and edit view definitions in the View Definition dialog box.

To define a view, open the View Definition dialog box. Use this dialog box to assign field names to the view, determine the its layout, and apply formatting options.

View Definition Dialog Box

To open the View Definition dialog box, do one of the following:

- From the View menu, choose Compose, and then select View.
- To edit an existing view, from the View menu, choose Edit View.
- Right-click the Field View icon in the View Shortcut bar and choose Edit from the Context menu.

**Warning:** When you open this dialog box, the Layout tab displays. Because the type of view you are creating (Spreadsheet or CPM Network) defines what tabs are displayed in this dialog box, click Description to view the Description tab and define the type of view you are creating.

If you are creating a spreadsheet view, the View Definition dialog box contains Sort and Filter tabs you can use to create sorts and filters. These Sort and Filters are part of the view definition that is automatically applied when you open the view. For more information on using sorts and filters, see “Working with Filters” on page 87 and “Working with Sorts” on page 92.

<table>
<thead>
<tr>
<th>Shortcut Menu Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Panning Overview</td>
<td>“Zeroes in” on a specific area of a CPM network. When you select this option, the Overview Window appears. To use the Overview window:</td>
</tr>
<tr>
<td></td>
<td>□ Click the window and drag it to another area of the Overview window. The CPM network moves as you drag the Overview window.</td>
</tr>
<tr>
<td></td>
<td>□ To close the window, click its Close button.</td>
</tr>
</tbody>
</table>
Using the Description Tab

Use fields on the Description tab to create or edit a description of the view.

To enter a description:

1. Choose Spreadsheet or CPM from the View Type drop-down list. For more information about these views, see “View Display Options” on page 77. When you select CPM, the Sort and Filter tabs disappear.

2. Choose a WBS level from the Level of Analysis drop-down list.

3. Select the Resource LOA check box if you want to see consolidated data on resources.

4. In the Name text box, enter a name for the view.

5. In the Author text box, enter your name or the name of the person responsible for defining the view.

6. In the View Status 1 text box, enter a message or instructions on using the view.

   If you leave this blank, the status bar displays information about the first filter or sort statement applied to the view. If you enter text here it displays in the view status area, but is replaced when a filter or sort is added or applied to the view.

7. In the View Status 2 text box, enter a message or other instructions for using the view.

   If you leave this blank, the status bar displays information about the first sort statement providing that one has been defined as part of the view. If you enter text here it displays in the view status area when a filter or sort is added or applied to the view.

8. In the Notes text box, enter any notes about the view.

   Level of Analysis controls the consolidation level of project data displayed in a view before filtering and sorting criteria are applied. It is available for all WBS levels, but provides the greatest detail when applied to tasks, and when the Resource LOA check box is selected. Level of Analysis for CPM network views is task-specific.
Views, Filters, Sorts, and Highlights

Working with Views

Using the Layout Tab

Use fields on the Layout tab to define or edit field names that comprise a view.

To determine what field names comprise the view:

⇒ Insert field names into cells on the grid, as described in “Working with Field Names” on page 75.

Formatting view cells

After you assign field names to a view, you can define how those fields will appear. Cell formatting options are enabled or disabled depending on the field you are formatting. If you select a cell that is specific to Gantt chart display, the Gantt dialog box appears instead of the Formatting Options dialog box. For instructions on using the Gantt dialog box, see “Customizing the Look of Gantt Charts” on page 109.

To open the Formatting Options dialog box:

⇒ Select a populated cell on the grid, and then click Format Cell.
To define formatting options:

1. When enabled, select from the following formatting options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>Enter a numeric value for the cell width. To change the width of a cell in the Layout tab, click a column divider and drag it to the left or right.</td>
</tr>
<tr>
<td>Protect</td>
<td>Select this check box to make the field display-only, preventing others from changing its data.</td>
</tr>
<tr>
<td>Blank if Zero</td>
<td>Select this check box if you want the field to appear empty when its value is zero.</td>
</tr>
<tr>
<td>Column Totals</td>
<td>Select this option to display column totals. This option is only available if the field name you selected displays data in a column format that uses numeric values, and it makes sense to total the value.</td>
</tr>
<tr>
<td>Tabulate</td>
<td>Select this option to arrange data in a tabular format. This option is only available if the field name you selected can be displayed in tabular format.</td>
</tr>
<tr>
<td>WBS Indent</td>
<td>Select this check box to indent tasks based on levels in the Work Breakdown Structure (WBS).</td>
</tr>
<tr>
<td>Decimals</td>
<td>Choose a number of decimal places from the drop-down list.</td>
</tr>
<tr>
<td>Alignment</td>
<td>Choose a text alignment option from the drop-down list.</td>
</tr>
<tr>
<td>Units/Format</td>
<td>Choose a unit of measurement from the drop-down list. Available units of measure include: Hours, Days, Cost, Quantity, and Percent. Available formats include: List, Count, and Flag. Availability of the Units or Formats selections depends on the field type.</td>
</tr>
<tr>
<td>Period Unit</td>
<td>Choose a period unit from the drop-down list. This selection displays units in a tabulated view. For example, hours are selected to display hours per week if the time scale is set to weeks.</td>
</tr>
</tbody>
</table>

2. Optionally, click Time Scale to open the Time Scale dialog box, then click OK when you finish formatting cells.

**Note:** This button is enabled if the field name you are formatting is a Gantt field name or you selected a field name that can be tabulated and you selected the Tabulated check box. For more information on using the Time Scale dialog box, see “Defining and editing time scales” on page 112.
Using the Filter and Sort Tabs

For instructions on creating and editing filters and sorts that are part of a view definitions, see “Working with Filters” on page 87 and “Working with Sorts” on page 92.

Editing Views

You edit views in the View Definition dialog box. This section describes several methods for opening the dialog box when you want to edit views.

To open the View Definition dialog box and edit a view:

1. Do one of the following:
   a. From the View menu, choose Edit View.
   b. From the Libraries dialog box, open a group, select a view, and click Edit.

2. Edit data appearing on tabs of the View Definition dialog box and click OK.

To save an edited view before closing a project:

⇒ From the View menu, choose Save View. The Save View Definition dialog box appears.

**Note:** If you used the Libraries dialog box to open the View Definition dialog box and edit a view, the Save View Definition dialog box appears when you exit the View Definition dialog box.

Refreshing Views

When you change data in a view, sort, or filter, all of the changes may not display immediately. Use the Refresh View feature to refresh the view window. Refresh affects only the active view.

To refresh a view:

⇒ From the View menu, choose Refresh.
Saving Views

Save new or edited views so that you can use them again. While you can save a view to any group in the Libraries dialog box, you might consider saving it to the Favorites group if you will use it often. Views are saved as .RWV files. Follow the steps below to save view definitions you create or edited by accessing the View Definition dialog box from the shortcut menu or the Libraries dialog box.

To save a new or edited view:
1. From the View menu, choose Save View. The Save View Definition dialog box appears.
2. If necessary, enter a name in the File Name text box.
3. From the Library Group pull-down, choose the group to which you are associating the view. If you created a view definition by choosing Compose View from the View menu, the steps for saving the view are different.

To save a newly-composed view:
1. From the View menu, choose Save View. The Save View Definition dialog box appears.
2. Enter a name in the File name text box.
3. From the Library Group pull-down, choose the group to associate with the view.
4. Click Save.

To save an edited view as a new view:
1. After editing the view in the View Definition dialog box, click OK.
2. From the View menu, choose Save View. The View Definition Save dialog box appears.
3. To create a new view, click Create. The Save View Definition Dialog Box appears.
4. Enter a name in the File name text box.
5. From the Library Group pull-down, choose the group to associate with the view.
6. Click Save.

Applying Views

There are different ways to apply a view to a project:

- Display a single view of the project by applying a view that replaces the current view.
- Display multiple views of a project simultaneously. When you open a new view for a project, a separate window for each view appears. This feature is helpful when you want to see different aspects of the same project and want to easily switch between views.
Displaying single views of projects

To display one view of a project:

- From the shortcut bar, open a group and click a view.

Displaying multiple views of projects

To display multiple views of the same project, do one of the following:

1. On the shortcut bar, place your mouse next to a view and right-click. Choose New Window from the shortcut menu.
2. From the Libraries dialog box, select a view from the list and click New Window.

Printing Views

When you print a view, you are actually printing the project to which a view is applied. This feature is available for spreadsheet and CPM network views. Set print margins to at least 0.75". When you print views with top and bottom print margins set very small (less than 0.75" in the Page Setup dialog box), view data may overwrite the headers and footers.

To print a view:

1. From the File menu, choose Print. The Print dialog box appears.

2. Use this dialog box to select special printer settings.

3. Click OK to print the view. For more information on printing, page setup, and printer setup options, see “Printing” on page 21.
Working with Filters

You can refine the content of a view by selecting and applying filtering criteria that defines what project, task, or resource information to display. The remaining project information is hidden so that you see only the project data you want to see. You can apply filters to any spreadsheet view, but not to a CPM view.

You can create filters that are part of a view definition or applied separately from a view. When you define a filter in the View Definition dialog box, it is considered to be part of the view’s definition and is applied to projects every time you apply the view. If you create a separate filter, you can add it to your library and apply it to any open project. Later, you can remove these filters from the view.

Creating Filters

To create a filter in a view definition:

- From the View Definition dialog box, click Filter to view the Filter tab and follow the instructions in "Defining Filter Properties".

To create a filter file that you can apply to any view:

- From the View menu, choose Compose, then click Filter and follow the instructions in "Defining Filter Properties"
Defining Filter Properties

Identical steps are used to define filters in the Filter Definition dialog box and on the Filter tab of the View Definition dialog box.

To define filter properties:

1. Open either the Filter tab of the View Definition dialog box, or the Filter Definition dialog box.

2. If you are creating a non view-specific filter, enter a name for it in the Name text box.

3. Insert field names into cells on the grid, as described in “Working with Field Names” on page 75.

4. For each field name, choose a comparison value from the Compare column pull-down.

5. In the Value column, enter a value to use in comparison with the selected field name.

6. From the And/Or column pull-down, choose one of the following arguments:
   - Choose And to include data in the view if the current and the following filter statements apply.
   - Choose Or to include data in the view if either the current filter statement or the following filter statement apply.

You can also combine the use of And and Or arguments to define filtering criteria, for example:

This example filters the information as follows:
   - Resources whose use is measured by the hour AND
   - Whose billing rate is $60.00 per hour OR
   - $70.00 per hour

The last And/Or filter statement in the dialog box is ignored, but would be applied if another line was added to the statement.

Steps for saving filters are described in “Saving Filters” on page 90.
Editing Filters

There are different ways to edit filters, including:
- Editing filters that are part of a view definition.
- Editing separate filter files

**Editing view-specific filters**

To edit a view-specific filter:

1. Follow the steps for "Understanding View Definitions" on page 80
2. Click Filter in the View Definition dialog box. The Filter tab appears.
3. Define the filter by following the steps in “Defining Filter Properties” on page 88.
4. Click OK and follow the steps in “Saving Views” on page 85.

**Editing non view-specific filters**

To edit a non view-specific filter:

1. Do one of the following:
   - From the View menu, choose Library, and then select a filter in the Libraries dialog box and click Edit.
   - On the shortcut bar, select a filter and press F3.
2. Edit the filter, and then click Save. To save the filter, follow the instructions in “Saving Filters” on page 90.

**Creating new filters from existing filter files**

If the filter you are modifying is not part of a view definition, you can save it as a new filter file.

To create a new filter file from one that exists:

1. Open and edit the filter.
2. When you have finished editing the filter, click Save. The Save Filter Definition dialog box appears. To save the filter as a new filter file, follow the instructions in “Saving Filters” on page 90.
Saving Filters

If you created a filter that is part of a view definition, it is saved along with the view. Otherwise, non view-specific filters are saved as .RWF files. The Save Filter Definition dialog box appears when you save a new or edited filter.

To save a new filter:
1. In the File name text box, enter a name for the filter.
2. From the Library Group pull-down, choose a group to associate with the filter then click Save.
3. To overwrite an existing filter, select the old filter from the list of filters in the Save Filter Definition dialog box, and then click Save.
   A confirmation dialog box appears if you are saving an edited filter.

Applying Filters

If you defined a filter within a view definition, it is automatically applied with the view. When you apply other non view-specific filters, those filtering criteria are also applied to the view.

To apply a non view-specific filter to a view:
- Do one of the following:
  • From the shortcut bar, open a group and select a filter.
  • From the Libraries dialog box, select a filter and click Apply. This applies the filter to the current view of the project.

Clearing Filters

You can easily remove non view-specific filters applied to a project. Use the Clear Filters icon in the Filters & Sorts group on the shortcut bar.

To remove filters from a project:
- On the shortcut bar, locate and click the Clear Filters view icon.
Quick Filtering on Resources

You can quickly display all information pertinent to a resource by using the Quick Filter by Resource pull-down. This feature is available when you have any resource-specific field names in a view or resource assignments in a project.

**Note:** This feature is not available in CPM views.

To use the Quick Filter by Resource pull-down:

- From the Quick Filter by Resource pull-down, choose a resource. The view displays only data specific to the resource.

To clear the resource filter:

- From the Quick Filter by Resource pull-down, choose (All Resources). The view displays all resource data. You can also filter on resources using the Resource LOA check box.
Working with Sorts

You can further refine the content of a view by selecting and applying sorting criteria. Use this feature to define how data is sorted in the view. You can apply sorts to any spreadsheet view, but not to CPM views. You can create sorts as part of a view’s definition, or as separate files. When you define a sort in the View Definition dialog box, it is part of the view’s definition and is applied whenever you apply the view. If you create a separate sort file, you can add it to your library and apply it to any open spreadsheet view.

The Sort tab of the View Definition and Sort Definition dialog boxes allows you to define field names that organize tasks and resources. If multiple tasks or resources have the same information for a field name, you can apply another field name for an additional level of sorting.

Creating Sorts

To create a sort that is included in a view definition:

1. From the View menu, choose Edit View. The View Definition dialog box appears.
2. Click Sort. The Sort tab of the View Definition dialog box appears.
3. Follow the instructions in "Defining Sort Properties".
To create a sort that you can apply to any view:

1. From the View menu, choose Compose — Sort. The Sort Definition dialog box appears.

2. To define a new sort, complete the steps in "Defining Sort Properties".
Views, Filters, Sorts, and Highlights

Working with Sorts

Defining Sort Properties

Identical steps are used for defining sorts on the Sort tab of the View Definition dialog box and in the Sort Definition dialog box.

To define sorts:

1. If you are creating a non view-specific sort, enter a name for it in the Name text box.
2. Insert field names into cells on the grid as described in “Working with Field Names” on page 75.
3. For the Start Column, enter the column number where you want to start sorting the data. For example, if you want to start sorting on the field name “Name” at the fourth character, enter 4.
4. For the Sort Length, enter the number of characters to use to sort the data.
5. Choose Ascending or Descending from the Sequence pull-down.
6. Click Save if you are using the Sort Definition dialog box.

Editing Sorts

There are different ways to edit sorts, including:
- editing sorts that are part of a view definition
- editing sort files

Editing view-specific sorts

To edit a view-specific sort:

1. Follow the steps for opening the View Definition dialog box, described in "Understanding View Definitions" on page 80.
2. Click Sort. The Sort tab appears.
3. Follow the steps described in "Defining Sort Properties" above.
4. Click OK and follow the steps in “Saving Views” on page 85.
Editing non view-specific sorts

To edit a non view-specific sort:

1. Do one of the following:
   - In the Libraries dialog box, select a group and a sort from the list, and then click Edit.
   - On the shortcut bar, select a sort and press F3.

2. Edit the sort, then click Save.

3. Follow the instructions in “Saving Sorts” on page 95.

Creating new sorts from existing sort files

You can modify an existing sort and save it as a new sort file.

To create a new sort file from one that exists:

1. Follow the instructions in “Editing non view-specific sorts” on page 95.

2. When you have finished editing the sort, click Save. The Save Sort Definition dialog box appears.

3. Follow the instructions in "Saving Sorts" and rename the sort.

Saving Sorts

If you created a sort that is part of a view definition, it is saved with the view. Otherwise, nonview-specific sorts are saved as .RWS files. The Save Sort Definition dialog box appears when you save a new or edited sort.

To save a new sort:

1. In the File name text box, enter a name for the sort.

2. From the Library Group pull-down, choose the group to associate with the sort, and then click Save.

To overwrite an existing sort:

- Select the old sort from the list of sorts in the dialog box, then click Save. A confirmation dialog box appears if you are saving an edited sort.

Applying Sorts

If you defined a sort as part of a view’s definition, it is automatically applied with the view. However, when you apply other non view-specific sorts, those sort criteria are also applied to the view.

To apply a nonview-specific sort to a view:

- Do one of the following:
  - From the shortcut bar, open a group and select a sort.
  - From the Libraries dialog box, select a sort and click Apply. This applies the sort to the view currently in focus.
Clearing Sorts

You can easily remove non view-specific sorts applied to a project by using the Clear Sorts icon in the Filters and Sorts group on the shortcut bar.

To remove a filter from a project:

♀ On the shortcut bar, click the Clear Sorts icon.
Changing View Display Colors

You can change the colors used to separate data appearing in spreadsheet views. Specifically, you can change the colors of spreadsheet view horizontal and vertical separation lines, and the background colors of rows appearing in views. This feature does not affect any highlight settings you may use to display data in views.

Changes you make to the view display colors affect all open views and are applied to all projects you open during subsequent Open Workbench sessions. A view can display horizontal and vertical lines in color, or not at all, and display rows with background colors alternating line-by-line or object-by-object. Also, when choosing view display colors, you can use a standard color palette or create a custom color palette.

You can redefine the colors used to display views any number of times. However, when you edit and apply a new view color definition, you lose the previous color definition.

Customizing Colors

When you customize view display colors, all open views use those colors. Use the Display tab of the Options dialog box to turn horizontal and vertical line display on or off, select line and background colors from the color palette, and add new colors to the palette.

To customize view display colors:

1. From the Tools menu, choose Options.
2. Click Display. The Display tab appears.
3. Choose color options from the Horizontal Lines, Vertical Lines, Background Color 1, or Background Color 2 pull-downs.
4. Click OK.
Adding colors to the color palette

Colors you add to the color palette are available for use by all groups on the Display tab of the Options dialog box.

To add colors to the color palette:

1. From the Tools menu, choose Options. Click Display. The Display tab of the Options dialog box appears.
2. Select a group and then click the down arrow next to the Color box.
3. Click Other to open the Color dialog box.
4. Perform any of the following steps:
   - Select a color from the Basic Colors palette.
   - Select a color from the Basic Colors palette, and then use the color matrix on the right side of the dialog box to edit the color.
   - Click Define Custom Color to create an entirely new color, and then use the color matrix on the right side of the dialog box to edit the color.

   **Note:** The Define Custom Color button is disabled if you are already viewing custom colors.
5. Click Add to Custom Colors to add the color to the color palette.
6. Click OK to close the Color dialog box.
7. Click OK.

Applying colors from the color palette

To apply colors from the color palette:

1. From the Tools menu, choose Options. Click Display. The Display tab of the Options dialog box appears.
2. Select a group and then click the down arrow next to the Color box.
3. Do one of the following:
   - Select a color from the palette.
   - Click None to turn off horizontal or vertical line display.
4. Click the up arrow to close the drop-down list and apply your selection.
5. Click OK.
Defining View Display Colors

To define the display of colors in views:

1. On the Display tab of the Options dialog box, do one of the following:
   - For each group, select a color from the color palette.
   - For horizontal and vertical lines, select a color from the color palette, or click None if you do not want lines to display.

2. In the Alternate Colors By group, do one of the following:
   - Select Object if you want row colors to alternate object-by-object. Depending on a view’s definition, an object may contain many rows of information. For example, a task may display its name and list all of its resource assignments.
   - Select Line if you want background colors to alternate line-by-line.

3. Use the Preview group to preview the colors before committing to them. Text display color is defined in the Highlights file. Dark background colors may render text unreadable in the view. See “Highlighting Project Information” on page 100 for instructions on changing the text color in the view.
Highlighting Project Information

Open Workbench offers a variety of fonts, colors, symbols, and patterns for highlighting project data. This feature makes views and printed reports easier to read, analyze, and understand. You can define highlights for:

- Cells in a CPM network
- Data appearing in spreadsheet views
- Gantt chart bars and symbols

There is no limit to the number of highlights and highlight conditions you can create. You can also create duplicate highlight conditions. Open Workbench applies highlights in the order listed in the Highlight Condition dialog box. When duplicate highlight conditions exist, the last condition entered is the one applied to the view.

While you can create and save many highlight files, you can apply only one (the default highlight file) to open projects. If you create multiple highlight files, you can specify which one to use by changing the default location and file name of the highlight file.

If you do not want to highlight any project data, you can clear the default highlight file location. The default highlight file and location is set on the Locations tab of the Options dialog box, as described in “Using the Locations Tab” on page 61.

To create highlights, follow these steps:

1. Select the field names that you want to highlight.
2. Define the conditions under which you want to see the highlight applied to this information.
3. Define how you want this information to look.

Defining and Editing Highlights

The highlight definition process makes use of field names to determine what project data is highlighted. To learn more about field names, see “Working with Field Names” on page 75.

To define or edit highlights, you must open the View Highlights dialog box.

To open the View Highlights dialog box:

1. From the View menu, choose Highlights.
2. Enter data as appropriate in the View Highlights dialog box:

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of Element</td>
<td>Lists the field name for the type of information to highlight. For instructions on adding field names to this column, see “Working with Field Names” on page 75.</td>
</tr>
</tbody>
</table>
Selecting field names

To highlight project data, you must first select field names to highlight.

To select field names that are part of the highlighting criteria:

Insert field names into cells in the Type of Element column.

When inserting field names in the Type of Element column, you can insert them into a cell on a row that already displays a highlight format you want applied. For instructions on assigning highlight formats to field names, see “Defining highlight formats” on page 102.

You can insert the same field name multiple times into different rows in the Type of Element column. This means that each occurrence of a field name appears differently when you display a project, depending on which highlight condition applies. For instructions on assigning highlight conditions to field names, see “Defining highlight conditions” on page 105.

---

### Sample

Displays the highlight style set for the field name as described in “Printing Highlight Settings” on page 107.

### Conditions

Describes the conditions under which the highlight is applied to the field name. See “Defining highlight conditions” on page 105.
Defining highlight formats

When you define highlight conditions, it is important to define the highlight’s appearance. Format highlights when you want information displayed using specific fonts, styles, or colors, or when you want to assign a color to cells that display project data.

For instructions on creating custom colors for fonts, Gantt symbols, and CPM highlights, see “Adding colors to the color palette” on page 98. If you use text-based field names in a highlight, you can choose how the fonts are displayed. To do this, use the Font dialog box. A Preview box displays to show you how the text will appear when the highlight applies.

To change the appearance of fonts in highlights:

1. Double-click the Sample cell adjacent to a field name that uses text. The Font dialog box appears.

2. Use settings in the Font dialog box define the appearance of fonts in the highlight.

3. From the Color palette, select a color, or click Other to open the Color dialog box where you can add a custom color to the palette.

   For information on using the Color dialog box, see “Adding colors to the color palette” on page 98.

4. Click OK to return to the View Highlights dialog box.

   If you use Gantt field names in a highlight, you can choose how the Gantt bars are displayed. To do this, use the Gantt Symbol and Color Setting dialog box. A Preview box displays to show you how the Gantt bar will appear when the highlight applies. When defining Gantt bar symbols and color settings, you can define them to match a highlight condition, and then override the settings with other symbols and color settings for the bar when a different condition is met.
To change Gantt symbol and color settings:

1. Double-click a Gantt element Sample. The Gantt Symbol and Color Settings dialog box appears.

2. From the Left Endpoint group, select the symbol, pattern, and color to use to display the left endpoint of the Gantt bar.

3. From the Center Bar group, select the symbol, pattern, and color to use to display the body of the Gantt bar. If you want the Gantt bar to have a border, select the Draw Border check box.

4. In the Right Endpoint group, select the symbol, pattern, and color to use to display the right endpoint of the Gantt bar.

5. Select the Default Color check box to apply the default color (black) to the selected end point or Gantt bar color when the highlight condition is met. For information on creating custom colors using the Color dialog box, see “Adding colors to the color palette” on page 98.

6. Select the Black Border check box to draw a black border around a Gantt bar or endpoint.

7. Select the Draw Border check box to draw a color border around the Gantt bar.

8. Click OK to save your changes.
Defining CPM highlights

If you use CPM field names in a highlight, you can choose how cells are displayed in a CPM view. Do this using the CPM Highlight Symbol dialog box.

A Preview box displays to show you how the CPM cell will appear when the highlight applies. When defining CPM cell symbols and color settings, you can define them to match a highlight condition, and then override them with other symbols and color settings when another highlight condition is met.

To change CPM cell patterns and color settings:

1. Double-click a CPM field name in the View Highlights dialog box. The CPM Highlight Symbol dialog box appears.

2. From the Pattern drop-down list, choose a pattern for the CPM cell.

3. From the Color palette, select a color, or click Other to open the Color dialog box where you can add a custom color to the palette.

   For information on using the Color dialog box, see “Adding colors to the color palette” on page 98.

4. If you are making a color selection from the Color dialog box, click OK to return to the CPM Highlight Symbol dialog box.

5. Click OK to accept changes in the CPM Highlight Symbol dialog box.
Defining highlight conditions

Use the Conditions column in the View Highlights dialog box to define the conditions under which the highlight is applied to the field name. Conditions that you define for each highlight provide an effective means of qualifying project data. By defining highlight conditions, you add another level of sophistication to your highlight criteria. For example, create highlights for different ranges of a particular field name instead of automatically highlighting all occurrences of the field name.

Warning: If you do not define a highlight condition for a field name appearing in the Type of Element column, every occurrence of that field name is highlighted.

To define a highlight condition for a field name:

1. Double-click the Conditions cell adjacent to the field name. The Highlight Condition dialog box appears.
2. In the Compare column, choose a comparison method from the drop-down list. The availability of comparison methods depends on the selected field name.
3. In the Value column, enter or select a valid value for the field name. Depending on the field name, you can either enter a value or select a value from a drop-down list if one appears.
4. In the And/Or column, choose And or Or from the column drop-down list.
   - Select And to highlight data that matches the current and following field names and highlight conditions you enter, and to link multiple highlight conditions.
   - Select Or to highlight data that matches either the current or the following highlight conditions.

You can also combine the use of And and Or arguments to refine what information you are highlighting; for example:

This example statement highlights information that matches the following criteria:

- All tasks that are detail tasks AND,
- That are critically late OR,
- That are overcommitted (the last And/Or statement in the dialog box is ignored, but would be applied if another line was added to the statement)

Customizing the color palette

Use the Color dialog box to create new colors, and make them available for use by fonts and Gantt and CPM highlight symbols.
To open the Color dialog box:

1. Do one of the following:
   - In the Font dialog box, click Other appearing in the Color group.
   - In the Gantt Symbol and Color Settings dialog box, click the down arrow next to any group that displays a color, and then click Other.
   - In the CPM Highlight Symbol dialog box, click Other.

2. Perform any of the following steps:
   - Select a color from the Basic Colors palette.
   - Select a color from the Basic Colors palette, and then use the color matrix on the right side of the dialog box to edit the color.
   - Click Define Custom Color to create an entirely new color, then use the color matrix on the right side of the dialog box to edit the color.

   **Note:** The Define Custom Color button is disabled if you are already viewing custom colors.

3. Click Add to Custom Colors to add the color to the color palette.
Printing Highlight Settings

When you print the View Highlights dialog box, you are printing a snapshot of highlight settings.

To print the View Highlights dialog box:

1. In the View Highlights dialog box, click Print. The Print dialog box appears.

2. Use this dialog box to set special printer settings. This is especially helpful if you want to print a color version of the highlight settings.

For more information on printing, page setup, and printer setup options, see “Printing” on page 21.

Note: Open Workbench does not support plot printers.
Saving and Applying Highlight Files

By default, the highlight file you specify as a default highlight file is automatically applied to every project you open in Open Workbench. Only one highlight file can be used at any given time and it is applied to all open projects. Highlight files are saved as .RWH files.

If you create multiple highlight files, you can select which one to use by defining a new default highlight file. For instructions on changing the default highlight file, see "Using the Locations Tab" on page 61.

To save the highlight file:

1. In the View Highlights dialog box, click Save. The Save As dialog box appears.

2. Choose a location for saving the highlight file from the Save in drop-down list.

3. Enter a name for the file in the File name text box, and then click Save.
Customizing the Look of Gantt Charts

The Gantt chart is a scheduling tool that shows a time scale along a horizontal axis and a project’s Work Breakdown Structure (WBS) along a vertical axis. A horizontal bar represents the duration of each task; the vertical ends of a Gantt bar correspond to each task’s start and finish date.

Some spreadsheet views use Gantt charts to provide a graphical representation of a project and the timing and relationships between its tasks. Some of the views that you create, and several of the views provided with Open Workbench, use Gantt charts to display project status across time periods. Changes you make to a view’s Gantt chart are saved with the view and applied each time you apply the view. To customize the Gantt chart display, open the Gantt dialog box.

To open the Gantt dialog box:

⇒ Double-click in the Gantt chart. The Gantt dialog box appears.

Creating and Editing Gantt Chart Layout

To create or edit a Gantt chart layout:

⇒ From the % Displayed drop-down list, choose one of the following options:

<table>
<thead>
<tr>
<th>% Displayed Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pct Expend</td>
<td>Display the percentage of work expended on the task versus the estimated amount of work.</td>
</tr>
<tr>
<td>Pct Complete</td>
<td>Display the percentage of work that has been completed to date.</td>
</tr>
<tr>
<td>Act Thru</td>
<td>Display the percentage of actuals posted against a task to date, versus the estimated actuals.</td>
</tr>
<tr>
<td>No Pct</td>
<td>Do not display any percentages.</td>
</tr>
</tbody>
</table>

Note: You can customize the Percent Expended, Percent Complete, and Actuals highlights on the Gantt chart. See “Defining and Editing Highlights” on page 100 and “Creating and Editing Gantt Chart Layout” on page 109.
Views, Filters, Sorts, and Highlights
Customizing the Look of Gantt Charts

1 Select or de-select any combination of the following check boxes:

<table>
<thead>
<tr>
<th>Check Box</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Baseline</td>
<td>Displays Gantt chart bars indicating baseline data about the project vs. actual project progress. A baseline is a snapshot of the project schedule taken earlier in the project that you can later use to measure project progress against earlier estimates of project progress.</td>
</tr>
<tr>
<td>Discontinuous</td>
<td>Displays bars indicating breaks in task-related work, such as holidays and weekends.</td>
</tr>
<tr>
<td>Float</td>
<td>Displays bars indicating the amount of float in tasks.</td>
</tr>
<tr>
<td>Stacked</td>
<td>Superimposes baseline data on the existing information. <strong>Note:</strong> Select the Baseline check box to enable the Stacked check box.</td>
</tr>
<tr>
<td>Show Dependencies</td>
<td>Displays dependencies in a Gantt chart view. When you select this option you can then create dependencies by dragging the middle of one Gantt bar to the middle of another Gantt bar. Dependencies are described further in “Creating, editing, and deleting dependencies on a Gantt chart” on page 160 and “Working with Dependencies” on page 188.</td>
</tr>
<tr>
<td>Freeze Gantt Bars</td>
<td>Disables the ability to manually shift Gantt bars on the Gantt chart. (For more information about shifting Gantt bars, see “Shifting Tasks” on page 175.)</td>
</tr>
</tbody>
</table>

2 In the Width box, enter a value that indicates the Gantt chart’s width in display pixels. All dates displayed in the Gantt chart are equally distributed along its width. Optionally, in the Display Dates group, select check boxes representing any combination of the dates you want displayed in the Gantt chart.

3 Click Time Scale to change time scale settings, or Click OK to save your changes.
Setting Time Scales

Open Workbench provides you with tools to define the type and layout of time periods displayed in spreadsheet views that contain tabulated fields and Gantt charts. Time scales can be user- or system-defined. Here is some important information to remember about using the Time Scale dialog box:

- The Scale drop-down list displays a Customized selection only if the view uses tabulated field names that are marked as such in the Formatting Options dialog box (see “Formatting view cells” on page 82).
- To enable the Period Finish Date field, you must choose Customized from the Scale drop-down list.
- The Finish Date field is only available when you choose User-Defined Date from the Period Finish Date drop-down list.
- The Start Date field is only enabled when you choose User Defined Date from the First Date Displayed drop-down list.

If your view does not use any tabulated field names, or if it contains a Gantt chart, the following selections are unavailable in the Time Scale dialog box:

- Period Finish Date
- Finish Date
- The Customized selection on the Scale drop-down list.

There are several ways to open the Time Scale dialog box so that you can define a time scale.

To open the Time Scale dialog box:

- Do one of the following:
  - In the Open Workbench window, double-click the time scale heading. In most views, this heading displays the time scale dates.
  - In the Gantt dialog box, click Time Scale.
  - In a spreadsheet view, Double-click a time scale for a tabulated field.
  - In the Formatting Options dialog box for a tabulated field, click Time Scale.
Defining and Editing a Time Scale

You can define and edit time scales in views that contain Gantt charts of field names that are tabulated. For more information on assigning the tabulated format to a field name in a view, see “Formatting view cells” on page 82.

Defining and editing time scales

To define or edit a time scale using system-defined criteria:

1. From the First Date Displayed drop-down list, choose a start date for the time scale. Available options include:
   - Project Start
   - Today’s Date
   - Project Committed Actuals Start
   - Next Pending Start
   - Project As-of Date
   - Pending Actuals Start
   - Project Fiscal Start
   - User Defined Date

   **Note:** Selecting User Defined Date enables the Start Date text box.

2. In the Start Date text box, enter the start date of the time scales.

   This text box is enabled only when you choose User Defined from the First Date Displayed drop-down list.

3. If the Period Finish Date drop-down list is enabled, choose a finish date from the time scale.

   This drop-down list is enabled only if the view is tabulated, then you choose Customized from the Scale drop-down list. Available options include:
   - Project Start
   - Project Finish
   - Project Committed Actuals Start
   - Project Committed Actuals Finish
   - Project As-of Date
   - Project Fiscal Start
   - Pending Actuals Start
   - Pending Actuals Finish
   - Next Pending Start
   - Today’s Date
   - User Defined Date

4. If the Finish Date text box is enabled, enter an end date for the time scale.

   Selecting User Defined Date enables the Finish Date text box.
5 From the Scale drop-down list, choose a time period increment that will appear in the time scale column headings. Available time scales include:

- Daily
- Weekly
- Monthly
- Quarterly
- Semi-annually
- Annually
- Customized

**Note:** The Customized selection is only available when you are editing the time scale for a view that uses one or more tabulated field names.

6 In the Number of Periods text box, enter the number of time scale periods to display.

**Show Week Check Box**

Select the Show Week check box to display the week numbers (1-52) in the Time Scale dialog box, if the time scale is set to Weekly.

Week 1 includes January 1, a standard in the U.S. and the U.K.

**Display Height Characteristics**

The timescale section of a Gantt or tabulated view will use as many as three lines to properly display the current scale. By default, an annual scale requires one line and a monthly scales requires two, but project information in the view definition may override these minimums.
5 Working with Projects

In this chapter:

- "Overview" on page 116
- "Opening Projects" on page 117
- "Creating and Editing Projects" on page 120
- "Using Calendars" on page 130
- "Sharing Project Data Using Email" on page 135
- "Finding Information in Projects" on page 136
- "Cutting, Copying, and Pasting Project Data" on page 138
Overview

A project is a related set of tasks performed to achieve a specific objective. Before planning a project, you should have a general idea of what it entails, who is responsible for managing and working on it, when it needs to be done, and how much it will cost.

Projects that you create in Open Workbench can be stored as files on your computer, a server, or a network location.

In this chapter, you will learn how to create and edit projects, and how to define and apply a calendar that your project will use for scheduling purposes.
Opening Projects

Before You Begin

If you are using a command line to open a project, you must have a mapped drive to the server where Open Workbench is installed and you should know the exact location of the project.

Opening Projects

Open Workbench projects have an .RMP file extension and may be saved to your computer or a network location.

When you open .RMP files, they display in Open Workbench as windows with named tabs or with title bars. Each .RMP file is displayed using the default view specified on the Locations tab of the Options dialog box (see “Using the Locations Tab” on page 61). If a default view is not specified, projects display minimum information.

To open an .RMP file:

1. From the File menu, choose Open. The Open dialog box appears.
2. Use the Look In drop-down list to navigate to the location of the .RMP file.
3. Choose a project from the resulting list, or enter the project name in the File Name text box.
4. Optionally, select the Open as Read-Only check box to open the project as read-only.
   
   **Note:** When you select this check box you save changes to the project.
5. Select the Create Sub-projects check box if you want include all projects as sub-projects in a master project.
6. Click Open.
Opening Projects From a Command Line

Another way to open projects is to do so using a command line. Use the command line method to open single and master projects without first starting Open Workbench. This can be performed from the:

- DOS prompt
- Windows Run dialog box
- Properties definition for a Windows icon or Start menu item

The following table provides definitions of the available command line entries:

<table>
<thead>
<tr>
<th>Entry</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>drive:</td>
<td>The letter of the drive mapped to the server containing Open Workbench.</td>
</tr>
<tr>
<td>path\npWbench.exe</td>
<td>The path to the location of the npWbench.exe program file.</td>
</tr>
<tr>
<td>/n</td>
<td>Start Open Workbench without displaying the splash screen.</td>
</tr>
<tr>
<td>/r</td>
<td>Open the project as read-only.</td>
</tr>
<tr>
<td>“drive:\path\filename.rmp”</td>
<td>The path to, and the filename of, the project file.</td>
</tr>
<tr>
<td>+</td>
<td>Add other projects to a new master project.</td>
</tr>
</tbody>
</table>
Examples

The following examples describe how you can use command line syntax.

In this example, Open Workbench opens a read-only copy of the WB_R1 project and omits the splash screen:

```
c:\Program Files\Open Workbench\bin\npWbench.exe /n /r "c:\Program Files\Open Workbench\data\WB_R1.rmp"
```

In this example, Open Workbench displays a splash screen and opens a read-only copy of the WB_R1.rmp file and a Read/Write version of the WB_R2.rmp file into a new master project:

```
c:\Program Files\Open Workbench\bin\npWbench.exe /r "c:\Program Files\Open Workbench\data\WB_R1.rmp" + "c:\Program Files\Open Workbench\data\WB_R2.rmp"
```

To open projects using a command line:

1. Do one of the following:
   - From the Start menu on your Windows desktop, choose Run. The Run dialog box appears.
   - If you are using Windows 2000, click Start on your Windows desktop, choose Programs from the shortcut menu, choose Accessories, and then select Command Prompt.
   - If you are using Windows NT, click Start on your Windows desktop, choose All Programs from the shortcut menu, and then select Command Prompt.

2. Enter the command line syntax and press the Enter key.
Creating and Editing Projects

This section explains how to create a new project, define project properties, and how to edit project and sub-project properties. You define and edit Project properties in the Project Properties dialog box.

If you are working with a master project that contains a sub-project, you can edit the sub-project’s properties only if the entire project was inserted as a sub-project and was not marked as read-only. For more information about master projects and sub-projects, see “Working with Multiple Projects” on page 179.

Once you have created a project you will want to populate it with phases, activities, and tasks, and perform other important project management tasks, such as assigning resources to tasks and creating project schedules. More information on these topics is found in other chapters throughout this user guide.

To create or edit project properties:

1. Open an existing project or, from the File menu, choose New.
2. From the File menu, choose Properties. When you create a new or open an existing project, the default view is automatically applied. If a default view is not defined, the view applied to the project displays a minimum amount of information. For instructions on defining a default view, see “Using the Locations Tab” on page 61.

To edit the properties of an entire project inserted as a sub-project:

→ Double-click the header button next to the sub-project’s title.
Using the Descriptions Tab

Enter or edit administrative details for a project are entered or edited on the Description tab. At a minimum, complete the ID text box before saving a new project.

To enter and edit information on the Description tab:

1. In the Name text box, enter the name of the project.
2. In the ID text box, enter a unique identifier for the project.
3. In the Department text box, enter the name of the department responsible for the project.
4. In the Budget text box, enter the estimated project budget.
5. In the Description text box, describe the project.
Using the Scheduling Tab

Create or edit scheduling properties for projects on the Scheduling tab.

To enter and edit information on the Scheduling tab:

1. In the Start text box, enter a start date for the project.
2. To impose a start date for the project, select the Imposed check box. This selection is necessary and helpful if you later Autoschedule your project from its start date.
3. In the End text box, enter a finish date for the project.
4. To impose a finish date for the project, select the Imposed check box. This selection is necessary and helpful if you later Autoschedule your project from its finish date.

**Note:** Autoschedule attempts to honor imposed start and finish dates; other scheduling constraints can force Autoschedule to break these constraints.

5. In the As-of text box, enter the as-of date to be used as a reference point when performing earned value calculations.

If you do not enter an As-of date, zero (0) is displayed in earned value fields such as Actual Cost of Work Performed and Budgeted Cost of Work Scheduled.
In the Priority text box, enter a priority code for the project.

Priority controls the order in which tasks are scheduled during Autoschedule, subject to dependency constraints. You can assign priority in a range from 0 to 36:

<table>
<thead>
<tr>
<th>Priority Level</th>
<th>Signifier</th>
</tr>
</thead>
<tbody>
<tr>
<td>Highest</td>
<td>Numbers 0 through 9</td>
</tr>
<tr>
<td>Default</td>
<td>10</td>
</tr>
<tr>
<td>Lowest</td>
<td>Numbers 11 through 36</td>
</tr>
</tbody>
</table>

Choose a critical path type from the Critical Path Type drop-down list. This selection impacts the CPM network calculations, which can be based on either the current project plan dates or the baseline dates.

Select the Subnets (All Projects) check box if you want CPM to schedule subnets in the project.

A subnet is a set of tasks that have dependencies among themselves.

When you select the Subnets (All Projects) check box, critical paths are calculated separately for each subnet (during Autoschedule), and for each task that does not have dependencies. Otherwise, if you de-select the check box, one critical path is calculated for the entire project with no subnets.
Using the Resources Tab

Resources are the necessary people needed to make sure the project is completed on time. This section describes how to select a team of resources from a list of global resources and make them available to a project.

You can manually enter resources in the resource detail pane of a view, define their properties, and assign them to tasks. Resources that you create are automatically available for use in your project. Resource that you create in the Resource detail pane of a view automatically appear in the Team Resources grid on the Resources tab.

Using the Key Tasks Tab

A key task is a task that, for any reason, you deem important to the project. The key task status does not impact any other Open Workbench behavior. Use this tab to view tasks marked as key tasks in a project, or to remove a key task marker from a task.

Key tasks appearing on this tab are marked as such on the General tab of the Task Properties dialog box. For more information on marking key tasks, see “Using the General Tab” on page 150.
When you remove key tasks, you do not remove the tasks from the project. Any changes appear on the General tab of the Task Properties dialog box and in any view that displays the key task field name.

To remove key tasks from the Key Tasks tab:
- Select the task and click Remove.

**Using the Advanced Tab**

Enter advanced project properties on the Advanced tab. This tab displays a Fields grid that contains two columns: the Field column that displays a list of all of the advanced properties you can specify, and the Value column where you enter or select values for the fields.

**Note:** Not all fields are available for editing.
To enter advanced properties in the Fields grid:

- Click cells in the Value column and enter values for the corresponding fields. What you enter is dependent on the corresponding field. There are four ways to enter values:
  - Select displayed check boxes.
  - Enter numeric values, currency, or dates.
  - Enter words or phrases.
  - Choose options from drop-down lists.

To see descriptions of fields on the Fields grid:

1. Click Help.
2. Use online Help to follow the links that lead you to the field descriptions.
Using the Notes Tab

Use the Notes tab to record information about a project for yourself or other staff members. When you create notes, you can also check them for spelling errors before adding them to a project, and you can view and edit them.

Creating notes

When you create a note, it appears as the last item on the History grid.

To create a note:

1. In the Notes text box, enter a note about the project.
2. In the Category text box, select an existing note category or enter a new one. **Warning:** If you are adding a new category, you must specify a Global Files location on the Locations tab of the Options dialog box. Otherwise, categories you add are not saved.
3. Click Add. The note appears as the last item in the History grid.
Reviewing and editing notes

To review a note:

1. In the History grid, select a note. The note appears in the Notes text box.
2. Repeat step 1 for notes you want to review.

To edit a note:

1. In the History grid, select a note. The note text appears in the Notes text box.
2. Edit the text of the note, and then click Modify.

Deleting notes

To delete notes:

⇒ In the History grid, select a note and click Delete.

Using the Subproject Tab

The Subproject tab is displayed only when you selected an entire project that was inserted as a sub-project.

For more information on working with sub-projects, see “Establishing Master and Sub-project Relationships” on page 181.

To open the Subproject tab:

1. Double-click the name of the sub-project. The Project Properties dialog box appears.
2. Click Subproject. The Subproject tab appears.
3 Select the Read-only check box if you want to change sub-project access to be read-only. When you select read-only, any changes you make to the sub-project are lost when you close the master project.
Using Calendars

Projects use a calendar to define work schedules and holidays. A standard calendar is available by default for you to use. An .RMP file may also have other calendars associated with it if you created new calendars while working with the file.

If a Global File location is defined, new calendars and edits to existing calendars are saved for future use when you exit Open Workbench.

Select the Calendars dialog box to choose the calendar that will be applied to every project you open during an Open Workbench session, to temporarily modify the work week schedules, and to assign common vacations, holidays, or other periods of zero availability. You can also create a new calendar or edit an existing calendar for use by all projects you open during the Open Workbench session.

In this section:
- "Working with Calendars" on page 130
- "Creating New Calendars" on page 131
- "Editing Calendars" on page 133
- "Resetting Holidays and Nonstandard Workdays" on page 133
- "Applying Calendars to Projects" on page 134
- "Deleting Calendars" on page 134
- "Printing Calendar Settings" on page 134

Working with Calendars

Here are some important things to remember about working with calendars:

- The calendar you select in the System Options group of the Calendars dialog box is applied to every project you open during an Open Workbench session.

- If you are working on different projects that use different calendars with the same name, the calendar in the first opened project is the one used by all projects, even if those projects use calendars with the same name. This situation only occurs when one or more .RMP files are opened during an Open Workbench session.

- If you create new or edit existing calendars and want to use them later, you must have a Global File location defined. For more information on defining a Global File location, see “Using the Locations Tab” on page 61.
To open the Calendars dialog box:

- From the Tools menu, choose Calendar.

Use fields in the System Options group to select the calendar to apply to all open projects, and to edit some of the calendar attributes. Use the elements in the Calendar Editing group to create a new calendar and to select which to base the new calendar on.

Scroll bars in the dialog box allow you to scroll back and forth through the calendar months.

### Creating New Calendars

When you create a new calendar, you can define a work schedule and holidays.

To create a new calendar:

1. Click New.
2. From the Based On drop-down list, choose a calendar on which to base the new calendar. All of the base calendar holidays and other settings are inherited in the new calendar.
3. In the Name combo box, enter a name for the calendar. This name will also appear on the Name and Current Calendar drop-down lists.
Defining the work schedule and holidays

A new calendar assumes the work schedule and holidays defined in its base calendar. You can change these settings to meet the unique requirements of a new calendar. When you define the work schedule and holidays for a calendar, you choose which days of the week are work days, when the work week starts, and what the work hours will be. You also choose which days are holidays, and which days (if any) are nonstandard work days.

To define the work schedule, holidays, and nonstandard work days:

1. Choose the new calendar from the Current Calendar drop-down list.
2. Make any of the following changes:
   - In the Hours per Day text box, change the hours that can be worked per day.
   - In the Hours per Week text box, change the hours that can be worked per week.
   - From the Week Start drop-down list, choose the day on which the normal work week begins.
   - Add holidays by individually selecting those dates, and then clicking Holiday.
   - Add non-standard work days by individually selecting those dates, and then clicking Workday.

For more information about saving a new calendar so you can use it during other Open Workbench sessions, see “Working with Calendars” on page 130.
Editing Calendars

You can change settings for any calendar available in the Calendars dialog box.

To edit a calendar:

1. From the Name drop-down list, choose the calendar you are editing.
2. Make any of the following changes:
   - In the Hours per Day text box, change the hours that can be worked per day.
   - In the Hours per Week text box, change the hours that can be worked per week.
   - From the Week Start drop-down list, choose the day on which the work week begins.
   - Add holidays by individually selecting those dates, then clicking Holiday.
   - Add non-standard work days by individually selecting those dates, and then clicking Workday.

Resetting Holidays and Nonstandard Workdays

Days you select as holidays or nonstandard workdays can be individually changed back to their original settings, or you can reset an entire calendar. When you reset a user-defined calendar, it reverts to the default settings of its base calendar.

To reset individual holidays or nonstandard work days:

- Click a date and click Reset.

To reset the entire calendar:

- Click Reset All.
Applying Calendars to Projects

To use a calendar during an Open Workbench session, you must specifically select it in the Calendars dialog box. Your selection is automatically applied to all currently open projects. If you do not select a calendar, Open Workbench applies a default calendar to all open projects. During the session, you can switch calendars as often as needed to create new scenarios for your projects.

To use a calendar:
1. From the Tools menu, choose Calendar. The Calendars dialog box appears.
2. Choose a calendar from the Current Calendar drop-down list.

Deleting Calendars

Calendars you create are the only calendars you can delete in Open Workbench. Also, if a calendar is displayed in the Current Calendar drop-down list, it is in use by projects you currently have open and cannot be deleted even if it is user-defined. When you delete a user-defined calendar, a default calendar is automatically applied to all open projects.

**Note:** You cannot delete the standard calendar that comes with Open Workbench and used by .RMP files.

To delete a calendar:
- Choose the calendar from the Current Calendar drop-down list, then click Delete.

Printing Calendar Settings

When you print calendar settings, you print a snapshot of the month currently displayed in the Calendars dialog box. You can print one month at a time.

To print calendar settings:
- Click Print.
Sharing Project Data Using Email

Before You Begin

- You and the recipient must have a Message Application Programming Interface (MAPI) compliant email program installed.
- Open Workbench must be installed on the recipient’s computer.

Sending Projects

You can send .RMP files to other staff member if you want to share your project plan.

To send an .RMP file:
1. From the File menu, choose Send. Your email program appears.
2. Follow your e-mail program’s instructions for addressing and sending messages.

Receiving Projects Through Email

To view a project:
1. Follow your email program’s instructions for saving attachments.
2. Open the project in Open Workbench.
Finding Information in Projects

In a very large project, finding information by scrolling through a view can be tedious. To make searching for information easier, Open Workbench provides a Find feature that you use to search for specific information in views.

Using the Find command, you construct search criteria from field names that appear in a view. Use this feature to construct search statements on the many combinations of data that comprise your project plans.

To find information in a view, open the Find dialog box and select field names as the basis for your search criteria. For specific instructions regarding field names see "Working with Field Names" on page 75.

**Note:** The Find feature works from the top down within a view. It begins searching at the cell in which your cursor is placed.

To open the Find dialog box:

1. Click in the first view cell from which you want to conduct the search.
2. From the Edit menu, choose Find. The Find dialog box appears.

Building a Search Statement

To build a search statement in the Find dialog box:

1. Insert field names into cells in the Fields column as described in “Working with Field Names” on page 75.
2. From the Compare cell drop-down list, choose a comparison value for the field name. Available comparison values are dependent on the field name you choose, and can include:
   - Equal
   - Not Equal
   - Greater
   - Less
   - Not Less
   - Not Greater
In the Value cell, do one of the following:
- Select a comparative value for the field name.
- Enter a value in the cell. The value you enter must be valid for the field name.

From the And/Or column drop-down list, choose a link type.
- Select And to find data that matches the current and following field names and comparison conditions you enter, and to link multiple find criteria.
- Select Or to find data that matches either the current or following find criteria.

You can combine And and Or arguments to refine the search; for example:

This example of a Find statement looks for information in your project that matches the following criteria:
- all tasks that have not started AND
- have a task priority of 10 OR
- are locked for scheduling

The last And/Or statement in the dialog box is ignored, but would be applied if another statement was added.

After you define search criteria, click OK to exit the Find dialog box and to go to the first occurrence of matching data.

Press the F4 key or, from the Edit menu, choose Find Next to search for other occurrences of matching data.
Cutting, Copying, and Pasting Project Data

When you cut, copy, and paste tasks and resources, you change the placement of cells in a view or add cells to a view. This enables you to paste task data from one view location to another, from one project file to another, and from Open Workbench to a Microsoft Windows application.

When you copy and cut data from a project, Open Workbench puts it on the clipboard, the Microsoft Windows utility for transporting data between applications. This information remains on the clipboard until you cut or copy other information, or until you clear the clipboard.

The Cut and Copy commands support the following data formats:

<table>
<thead>
<tr>
<th>Data Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab-separated text</td>
<td>Tab-separated text is a common format supported by many spreadsheet and word processing programs. If you cut a range of text in Open Workbench, you can paste it to any other application that supports tab-separated text.</td>
</tr>
<tr>
<td>Open Workbench proprietary format</td>
<td>Open Workbench uses its own internal data format for cutting and pasting information inside Open Workbench projects.</td>
</tr>
<tr>
<td>Objects</td>
<td>An object is a task (summary or detail) or a resource. Select an object by clicking its row header in the leftmost column of a spreadsheet view.</td>
</tr>
<tr>
<td>Gantt Chart</td>
<td>Copy and paste only. Copies both text and graphics for pasting in a Windows application. For details, see “Copying and Pasting Gantt Charts” on page 144.</td>
</tr>
</tbody>
</table>
Cutting, Copying and Pasting Cells

When you cut and copy information from views, you cut and copy the cells as text. Following are some things to keep in mind when cutting, copying and pasting cells:

- The Cut, Copy and Paste commands are available only in spreadsheet views.
- The Paste command inserts the clipboard content at the selected location in the project. The selected cell’s content is replaced with this information. Therefore, you may want to insert a blank row(s) before you paste clipboard content.
- When you cut and paste or copy and paste cell text containing a task, the task’s dependencies and resource assignments are not pasted.
- If you cut and paste or copy and paste a phase-level task that does not have a WBS level displayed, a new task is created because there was no WBS data in the cell.

To copy and paste project data:
1. Select task or resource cells in a view.
2. From the Edit menu, choose Copy.
3. If desired, insert a blank row(s) in which to paste the task or resource.
4. From the Edit menu, choose Paste.

To cut and paste project data:
1. Select task or resource cells in a view.
2. From the Edit menu, choose Cut.
3. If desired, insert a blank row(s) in which to paste the task or resource.
4. From the Edit menu, choose Paste.
   The elements of a task or resource that are copied—and can be pasted—will vary under the following conditions:
5. When more than one task or resource is copied, all relationships between them are copied as well.

Exceptions:
- If only tasks are selected, all associated resources are copied.
- All dependencies are available to be pasted. See “Paste Special” on page 141.
Open Workbench handles sub-projects and their data components differently under different conditions, and the conditions of pasting these components varies accordingly.

- **Referenced project data:** When you insert individual WBS items from another project, by using the menu command Tools / Sub-projects / Insert or Right-click / Insert Subproject, you insert only references to those items, not their actual data. So when you copy and then paste these items, you are working with references to data, and not with the data itself. To copy and then paste data, use the Copy Content command (see "Copy Content" on page 140).

- **Sub-project (mixed) data:** When you insert an entire sub-project into a project, the tasks in the project you insert are actual data, even though the line representing the project itself is a reference. So when you copy the tasks, you are working with actual data, but when you copy the project line, you copy a reference. There are more efficient ways to move data for an entire project:
  
  - Insert the project as a sub-project in Open Workbench.
  
  - Open the project by itself and copy all items in the standard way (to the clipboard), then open the target and use paste in the standard way. (Use this method for pasting into Open Workbench or a third-party application such as Microsoft Project.)
  
  - Import the project from a third-party application such as Microsoft Project.

### Copy Content

Copy Content affects only sub-project tasks when they are inserted individually. These tasks normally appear—and are copied and pasted—by reference only. But if you are pasting into a project where you want actual data then pasting references to data won’t suffice.

To copy the sub-project tasks content in the form of text, rather than a data reference, use Copy Content.

To use Copy Content:

1. Highlight a sub-project task by selecting its header button. Hold down the Shift key to select multiple tasks.

2. Choose Copy Content from the Edit or right-click menu, or use the keyboard shortcut by pressing the **Ctrl + Shift + C** keys.

   When you paste the copied information, you are pasting content, rather than references, to such information.
Paste Special

Paste Special behaves like the Paste command, but gives you more control over the results.

**Note:** Using Paste Special with interproject dependencies does not paste interproject dependencies unless the original project and target project are saved first.

To use Paste Special:

1. Copy an item to the clipboard.
2. Place the cursor where you want to paste the copied item.
3. Choose Paste Special from the Edit or right-click menu, or use the keyboard shortcut by pressing the Ctrl + Shift + V keys.
4. Select the appropriate options from the Paste Special dialog box and click OK. For option descriptions, see the table below.

### Paste Special Dialog Box

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include Resources</td>
<td>(1 object)</td>
</tr>
<tr>
<td>Always Create New Resources</td>
<td>(1 object)</td>
</tr>
<tr>
<td>Create New Resources if Not in Project (normal paste behavior)</td>
<td>(1 object)</td>
</tr>
<tr>
<td>Reuse Copied Resources to Paste Assignments</td>
<td>(1 object)</td>
</tr>
<tr>
<td>Include Assignments</td>
<td>(1 object)</td>
</tr>
<tr>
<td>Include Dependencies (PD’s)</td>
<td>(1 object)</td>
</tr>
<tr>
<td>Include Dependencies Except Between Clipboard Tasks—can create IPO</td>
<td>(1 object)</td>
</tr>
<tr>
<td>Include Constraints</td>
<td>(1 object)</td>
</tr>
<tr>
<td>Include Subtasks</td>
<td>(1 object)</td>
</tr>
<tr>
<td>Include Task and Resource Notes</td>
<td>(1 object)</td>
</tr>
</tbody>
</table>
Following is a description of each dialog box option:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include Sub-projects check box</td>
<td>Include copied sub-projects when pasting. Default: Selected. De-select to omit sub-projects from pasting.</td>
</tr>
</tbody>
</table>
| Include Tasks, n on clipboard check box   | Include copied tasks when pasting, and to enable additional controls. Default: Selected. n = number of tasks. De-select to omit tasks, and to disable additional controls. Additional Controls:  
  - Always Create Tasks option button (default selection and normal paste behavior): paste a task into the target project, even if an identical task already exists. Click OK to overwrite identical tasks.  
  - Reuse Copied Tasks to Paste Assignments option button: paste no tasks, only items related to existing tasks. |
| Include Resources, n on clipboard check box | Include copied resources when pasting, and to enable additional controls. Default: Selected. n = number of resources. De-select to omit resources, and to disable additional controls. Additional Controls  
  - Always Create New Resources option button: create a new resource in target, even if an exact match exists. Click OK to overwrite identical resources.  
  - Create New Resources If Not In Project option button (default selection and normal paste behavior): paste new resources as above, but do not overwrite existing duplicate resources.  
  - Reuse Copied Resources to Paste Assignments option button: paste no resources, only items related to existing resources.  
  - Include Resource Project Availability check box (default selection is de-selected): paste the resource’s project start and finish dates and percent availability into the target project, except when the source document includes a master project. |
| Include Assignments, n on clipboard check box | Include copied assignments when pasting. Default: Selected. n = number of assignments. De-select to omit assignments. |
### Cutting, Copying, and Pasting Project Data

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Include Interproject Dependencies, *n* on clipboard check box | Include copied Interproject Dependencies (IPDs) when pasting, and to enable additional controls. Default: Selected. *n* = number of IPDs. De-select to omit IPDs and to disable additional controls. Additional Controls:  
- Paste All IPDs option button: paste all IPDs, even if the IPD task in the source project was not copied to the clipboard.  
- Paste Selected IPDs Only option button (default selection and normal paste behavior): paste explicitly-selected IPDs into the target project. |
| Include Dependencies, *n* on clipboard check box | Include copied Dependencies when pasting, and to enable additional controls. Default: Selected. *n* = number of dependencies. De-select to omit dependencies, and to disable additional controls. Additional Controls  
- Maintain All Existing Dependencies (Can Create IPD's) option button: maintain dependency relationships between all copied objects and existing tasks not copied, even when the target is not the same project.  
- Paste Dependencies Between Clipboard Tasks option button (default selection and normal paste behavior): maintain dependencies between selected tasks.  
- Paste Dependencies Except Between Clipboard Tasks (can create IPD's) option button: abandon dependencies between selected tasks. However, paste dependencies to maintain existing relationships. |
Copying and Pasting Gantt Charts

When you copy data from a project, Open Workbench temporarily stores it on the clipboard—the Microsoft Windows utility for transporting data between applications. This information remains on the clipboard until you copy or cut other information, or until you clear the clipboard.

This enables you to copy and paste text and graphics from a project in Open Workbench—including the Gantt chart, from one view location to another, from one project file to another, and from Open Workbench to a Microsoft Windows application, such as Microsoft Word or Microsoft Excel. When you copy and paste a Gantt chart and its associated tasks, the following data is included:

- Column headings.
- The entire Gantt chart time scale as it is configured in Open Workbench, even if it extends beyond what displays on the screen.
- Gantt chart colors.
- Sub-project information and icons.
- Hidden columns, the data displayed in each column, and its column heading. Once you do a paste, this data will not display as hidden.
- Dependency lines if Show Dependencies is selected in the Gantt dialog box, and if the dependency lines begin and end within the selected area.

To copy a Gantt chart:

1. Select the entire view, or select a task or a series of tasks and the corresponding Gantt. Although you cannot select column headings, this data will still get copied.

2. Right-click and select Copy, or press the CTRL + C keys. This information is temporarily stored on the clipboard. To paste a Gantt chart:

To paste a Gantt chart:

1. Select a location in which to paste the Gantt chart in the current application, or a Windows application.

2. In Open Workbench, press the CTRL + V keys or from the Edit menu, choose Paste.

3. In a Microsoft Windows application, to paste only text, press and hold the CTRL + V keys or from the Edit menu, choose Paste. To paste text and/or graphics as the application allows, select Edit > Paste Special.
Creating and Managing Project Tasks

In this chapter:
- "Overview" on page 146
- "Adding Tasks" on page 147
- "Defining and Editing Task Properties" on page 149
- "Managing Tasks From Views" on page 169
- "Editing Multiple Task Selections" on page 171
- "Shifting Tasks" on page 175
- "Deleting Tasks" on page 177
Overview

Tasks constitute the work steps of your project. During the project planning process, you define the tasks that you need to complete in order to accomplish your project’s objectives. In this chapter, you will learn to create and define tasks, and you will learn some basic techniques for managing the tasks that comprise your projects.

Open Workbench organizes project tasks according to a Work Breakdown Structure (WBS). The default WBS for Open Workbench includes the following hierarchical levels:

- Project
- Phase
- Activity
- Task/Milestone

Labels used to identify your WBS levels may differ from the Open Workbench defaults described in this chapter.

Phases are the major steps required to achieve the project’s goal. Most well defined projects have multiple phases with specific objectives. Within each phase there are any number of activities leading to the completion of the phase’s objectives.

Each activity can be further divided into tasks, the smallest identifiable project component, and milestones, which mark significant events or dates used to measure a project’s progress. The number of tasks you can add to a project or a WBS is limited only by the memory and disk space on your computer.
Adding Tasks

This section describes the methods available for adding tasks to new and existing projects, how to move tasks around in projects, and how to delete tasks.

You can use several methods to add project phases, activities, tasks, and milestones to projects. At a minimum, you can add tasks and define some of their properties directly in a spreadsheet view, depending on the task-specific field names the view displays. Or, you can add tasks and define their properties in the Task Properties dialog box.

Adding Tasks to a New or Existing Project

This topic describes how to add tasks to a project using a spreadsheet view or the Task Properties dialog box.

To add tasks to a new or existing master project, you first insert a row above the first sub-project, and then insert the task. If you add the task anywhere in a sub-project’s WBS, the inserted task is added to the sub-project, not the master project.

Adding tasks in a spreadsheet view

By default, Open Workbench assigns a “Task” WBS level to all tasks you add to a project. Later, you can use the Task Properties dialog box to change the WBS levels of tasks you have added.

To add tasks in a spreadsheet view:

1. Select a row and, from the Edit menu, choose Insert or click an empty row in the task detail pane.

2. Enter a name for the task.

3. If the view displays task-specific columns, you can click in them and enter other task-related data.
Adding tasks using the Task Properties dialog box

You can use the Task Properties dialog box to add and edit tasks and to assign their properties.

To open the Task Properties dialog box:

- Double-click a header button next to an empty row in the task detail pane of a spreadsheet view.

The Task Properties dialog box appears. To create a task, you must at least enter a name for the task in the Name text box on the General tab.

The tabs you can use in the Task Properties dialog box depend on whether you are adding a phase or activity, a task, or a milestone. To learn more about using the Task Properties dialog box, see “Defining and Editing Task Properties” on page 149.
Maneuvering Tasks in a Spreadsheet View

After you add a task to a project, you can change its position in the spreadsheet view.

**Note:** If you move a task to an empty location that is within a sub-project or after the last line of a sub-project, the task becomes part of that sub-project.

To change the location of a task:

1. Click a task header button.
2. Click again on the selected row.
3. Hold the left mouse button and drag the task to a different location in the view.
4. Release the mouse button.

Defining and Editing Task Properties

Use the Task Properties dialog box to define and edit task properties. This dialog box contains several tabs where you can create and edit data that you may not see in a view.

In addition to managing tasks using the Task Properties dialog box, you can right-click any task in a spreadsheet view to access a shortcut menu of task-related commands. For more information on these commands, see “Managing Tasks From Views” on page 169.

You can edit task properties for sub-projects if you have Read/Write access or are saving a master project as an .RMP file. For more information about working with sub-projects, see “Working with Multiple Projects” on page 179.

You can also select multiple tasks and use one dialog box to edit the properties that they have in common or to define common properties. This is done using the Task Properties - Multiple Selections dialog box. For more information on simultaneously editing multiple task properties, see “Editing Multiple Task Selections“ on page 171.

To open the Task Properties dialog box:

- Double-click the header button to the left of the task. The Task Properties dialog box appears.

The availability and display of tabs in this dialog box depends on what you selected in the view. Specifically:

- If you select a phase or activity that is part of a master project or a sub-project, the General, Advanced, Methodology, and Notes tabs display.
- If you select a task or milestone that is part of a master project or a sub-project, all tabs except the Sub-projects tab display.
- If you select a single task that was inserted as a sub-project, all tabs, including the Sub-projects tab, display.
Using the General Tab

Use the General tab to create or edit basic information about the task.

To open the General tab:

▷ Double-click a header button in the task detail pane. The General tab of the Task Properties dialog box appears.

To add or edit information on the General tab:

1. In the Name text box, enter the name for the task.
2. In the Category text box, enter the name of a group or class to which the task belongs.
3. In the ID text box, enter a unique identification code for the task.
4. In the Type drop-down list, choose a type for the task. This drop-down list displays all of the levels in your WBS.
5. Select the Key Task check box if the task is a key task.
   A key task is a task that, for any reason, you deem important to the project. Tasks that are key tasks do not impact other Open Workbench functionality.
6. In the Duration text box, enter the duration of the task in business days. The maximum allowed duration extends from present day to June 3, 2079.
7. Select the Fixed check box if the task’s duration is fixed.
   A fixed-duration task has a duration that is not changed during autoschedule. If you do not select this check box, the task’s duration is considered to be variable and is subject to change during the Autoschedule process.
8. In the Priority text box, enter the priority of the task, then select the Inherited check box if you want the task to inherit its priority from its parent task, or the next-highest WBS level.

Priority controls the order in which tasks are scheduled during autoschedule, subject to dependency constraints. Autoschedule, therefore, schedules tasks with higher priority ahead of tasks with lower priority.

By default, tasks assume the same priority as their parent task. If there is no parent priority or priority for any higher WBS level, then Open Workbench assigns 10 as the default priority. Autoschedule schedules priorities as follows:

<table>
<thead>
<tr>
<th>Signifier</th>
<th>Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Highest</td>
<td>0 through 9</td>
</tr>
<tr>
<td>Default</td>
<td>10</td>
</tr>
<tr>
<td>Lowest</td>
<td>11 through 36</td>
</tr>
</tbody>
</table>
9 In the Schedule grid Start and Finish cells, enter the task’s start and finish dates. By default, the task start date is today’s date or the next business day after today’s date. If you do not enter a finish date, Open Workbench calculates the finish date based on the tasks duration and start date. The finish date must fall on a business day. The following schedules are displayed:

<table>
<thead>
<tr>
<th>Schedule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current</td>
<td>Uses the current values when calculating the critical path. Enter the task start and finish dates in the Start and Finish columns.</td>
</tr>
<tr>
<td>Baseline</td>
<td>Data in these read-only cells is automatically generated when you baseline a project. For more information on baselining, see “Baselines and Earned Value Computations” on page 232.</td>
</tr>
<tr>
<td>Early</td>
<td>Data in these read-only cells is automatically generated when you run Autoschedule. &quot;Early&quot; indicates the earliest a task can be completed, based on all of the task’s dependencies and constraints.</td>
</tr>
<tr>
<td>Late</td>
<td>Data in these read-only cells is automatically generated when you run Autoschedule. &quot;Late&quot; indicates the latest a task can be completed, based on all of the task’s dependencies and the constraints. For more information on Autoscheduling, see “Using Autoschedule” on page 227.</td>
</tr>
</tbody>
</table>

10 In the Status drop-down list, choose a task status.

If the task is a milestone, which has no duration, you can choose a status of Completed or Not Started from this drop-down list.

11 In the % Complete text box, enter the percent complete (from 0 to 100) for the task. Percent Complete is a value you enter and does not affect any other data.

- If you indicate that a task is 100% complete, choose Completed from the Status drop-down list.
- If you indicate the task is 0% complete, the task Status changes to Started unless you choose Not Started from the Status drop-down list.
- If a task has estimate to complete (ETC) or actuals, you must change that information before you can change the task Status to Not Started.

**Note:** You can enter a Percent Complete value even if Earned Value calculations are using Percent Expended in their formulas.
Using the Resources Tab

Resources provide the necessary people to ensure that the project is completed on time and within budget.

Use the Resources tab to assign resources to tasks and to edit some of the task-specific resource information. Another way to assign resources to tasks is to do so in a spreadsheet view if it contains a resource detail pane or resource field names. See “Assigning resources in a spreadsheet view” on page 154 for more information.

To open the Resources tab:

- Double-click a task’s header button, and then select the Resources tab in the Task Properties dialog box.

To assign and edit resources:

1. Select resources from the Project Resources grid.
   - To select a contiguous range of resources, press the Shift key and click a range of resources.
   - To select a noncontiguous range of resources, press the Ctrl key and individually click resources.

2. Click Assign, or right-click and choose Add Assignment(s) from the shortcut menu. The resources you select appear in the Assigned Resources grid.
3 Complete any combination of the following:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>This read-only cell displays the resource’s ID.</td>
</tr>
<tr>
<td>Name</td>
<td>This read-only cell displays the resource’s name.</td>
</tr>
<tr>
<td>Estimate</td>
<td>Enter a value to indicate the estimated usage required for a resource to complete a task assignment.</td>
</tr>
<tr>
<td>Actual</td>
<td>Displays the total actual usage of the resource. If you are working with .RMP files, you can enter actuals in this cell. Otherwise, you can edit this box for the purpose of creating a “what-if” scenario.</td>
</tr>
<tr>
<td>Unit</td>
<td>Choose a unit of measure from the drop-down list. The unit of measure is a resource-specific unit that defines how resource value is measured.</td>
</tr>
<tr>
<td>Loading</td>
<td>Choose a loading pattern from the drop-down list.</td>
</tr>
<tr>
<td>Baseline</td>
<td>This read-only cell receives data when you baseline a project. The information reflects the combined totals of actuals and estimate to complete (ETC).</td>
</tr>
<tr>
<td>Max %</td>
<td>Enter the percentage of a resource’s availability that can be assigned to a task.</td>
</tr>
</tbody>
</table>
When you assign resources to tasks, you also determine how the resources are loaded by assigning loading patterns.

Loading patterns determine how resource usage is distributed over the duration of a task. You can assign the following resource loading patterns:

<table>
<thead>
<tr>
<th>Loading Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back</td>
<td>Allocates usage as late as possible in the task.</td>
</tr>
<tr>
<td>Front</td>
<td>Allocates usage as early as possible in the task.</td>
</tr>
<tr>
<td>Contour</td>
<td>Allocates usage at a rate that varies with the resource’s availability left over from overlapping tasks.</td>
</tr>
<tr>
<td>Fixed</td>
<td>Allocates usage for each time interval. Using fixed loading, a resource is used to complete a task at set time intervals throughout the time it takes to complete the task.</td>
</tr>
<tr>
<td>Uniform</td>
<td>Allocates the same usage to each day in the task.</td>
</tr>
</tbody>
</table>

Maximum percentage loading (Max %) is the percentage of a resource’s total availability that can be assigned to a task. For example, a resource that is available 40 hours per week and has a maximum load of 50%, can work for no more than 20 hours per week on the task.

**Assigning resources in a spreadsheet view**

You can also easily assign resources to tasks in the Gantt Chart view or any view that includes resource and task details panes.

To assign a resource to a task directly in a spreadsheet view:

1. Highlight the resource row in the resource detail pane of the view.
2. Click anywhere in the row and hold the mouse button down while dragging the resource onto a task in the task detail pane of the view.
3. If desired, open the Task Properties dialog box for the task, and click Resources to view the Resources tab and to edit resource properties.

You can also assign resources to tasks by Cutting and Pasting resources onto tasks.

1. Highlight the resource row of the resource(s).
2. Right-click and select Cut.
3. Highlight the tasks you want to assign to the resource.
4. Right-click and select paste.
Removing assigned resources

When you remove a resource from a task, the resource is still available for assignment to other tasks in the project.

To remove a resource from a task:

- On the Assigned Resources grid of the Resources tab, select a resource and click Release, or press the Delete key.

Using the Dependencies Tab

Dependencies are important for project scheduling because they establish timing and the logical sequence of detail tasks in a project. A dependency links one task to another where the start or finish date of the second task (the successor) is constrained by the start or finish date of the first task (the predecessor).

In addition to creating dependencies between tasks in the same project, you can also create dependencies with tasks that are external to a project. This section describes the basic steps for creating dependencies. For more detailed information on working with dependencies, see "Working with Dependencies" on page 188. In addition to creating dependency relationships using the Dependencies tab, you can create them:

- in a CPM Network (see “Creating, editing, and deleting dependency relationships” on page 158).
- in a spreadsheet view that displays task details (see ”Creating, editing, and deleting dependency relationships” on page 159),
- on a Gantt chart (see “Creating, editing, and deleting dependencies on a Gantt chart” on page 160).

To open the Dependencies tab:

- Double-click a task’s header button, and then click Dependencies to view the Dependencies tab of the Task Properties dialog box.
Creating and editing dependencies using the Dependencies tab

To create and edit dependency relationships:

1. Click a task in the Project Tasks grid. A hierarchical list of tasks appears.
2. Open the WBS and select tasks from the hierarchy.
   - To select a contiguous range of tasks, press the Shift key and click a range of tasks.
   - To select a noncontiguous range of tasks, press and hold the Ctrl key and click the tasks.
3. Do one of the following to add tasks to the Dependencies grid:
   - Double-click a task.
   - Select a task and drag your selection into the Dependencies grid.
   - Select a task then click Add Predecessor(s) or Add Successor(s).
   - Right-click a task and choose Add Predecessor(s) or Add Successor(s) from the shortcut menu.

To help you quickly identify dependency relationships, the Dependencies list displays the following icons:

<table>
<thead>
<tr>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon] Indicates the task is a predecessor.</td>
</tr>
<tr>
<td>![Icon] Indicates the task is a successor.</td>
</tr>
</tbody>
</table>
As available, complete the following data in the columns of the Dependencies grid:

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Pred/Succ</td>
</tr>
<tr>
<td>Type</td>
</tr>
<tr>
<td>Lag</td>
</tr>
<tr>
<td>Lag Type</td>
</tr>
<tr>
<td>Project</td>
</tr>
</tbody>
</table>

**Dependency types**

You can create the following types of dependencies between tasks in a project:

<table>
<thead>
<tr>
<th>Dependency Types</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start-Finish</td>
<td>Successor task cannot finish until its predecessor starts.</td>
</tr>
<tr>
<td>Finish-Finish</td>
<td>Successor task cannot finish until its predecessor finishes.</td>
</tr>
<tr>
<td>Start-Start</td>
<td>Successor task cannot start until its predecessor starts.</td>
</tr>
<tr>
<td>Finish-Start</td>
<td>Successor task cannot start until its predecessor finishes.</td>
</tr>
</tbody>
</table>
Understanding lag

Open Workbench uses lag and negative lag to determine the amount of time between two tasks, or the amount of time that two tasks can be simultaneously in process. Lag and negative lag are defined in the Lag text box on the Dependencies tab of the Task Properties dialog box and can be defined as days or a percentage of time. Lag is defined as follows:

- Lag is the amount of time, or a percentage of the duration, between the two tasks. For example, if you want Task B to start 3 days after Task A is finished, make the relationship Finish-Start and enter 3.00 in the Lag text box.

- Lag can also be negative. This is defined as the amount of time or percentage of task duration in which two tasks can be simultaneously in process. For example, if you want Task B to start 2 days before Task C ends, make the relationship Finish-Start and enter -2.00 in the Lag text box.

Note: Consider a resource assigned to work four hours of ETC on two dependant tasks. With zero lag, the first task is scheduled while the next task is scheduled on the next day. If you want both tasks to be scheduled on the same day, because the resource still has availability on that day, enter -1.00 Lag to overlap the tasks.

Deleting dependencies

When you remove a dependency, you do not delete any tasks. Instead, you delete the dependency link between tasks.

To delete dependencies:

- In the Dependencies grid, select the row containing the dependency and click Delete.

Creating, editing, and deleting dependency relationships

Dependencies that you create in a CPM network use the default dependency type defined in the Options dialog box. Later, you can edit the dependency type on the Dependencies tab of the Task Properties dialog box.

You can create dependency relationships in a CPM network, but to delete dependencies, you must use the Dependencies tab of the Task Properties dialog box.

To create a dependency relationship in a CPM network:

1. Click the cell containing the task you are making a predecessor.
2. Click again on the cell and drag your mouse to the cell containing the task you are making a successor. A line appears that connects the two tasks.

To edit or delete a dependency relationship in a CPM network:

1. Double-click a cell containing a predecessor or successor dependency relationship. The Task Properties dialog box appears.
2. Click Dependencies to view the Dependencies tab.
3. Delete or edit the dependency relationship.
Creating, editing, and deleting dependency relationships

To create dependency relationships in a spreadsheet view, the view must display tasks. These dependencies use the default dependency type defined in the Options dialog box. Later, you can edit the dependency type or delete the dependency relationship on the Dependencies tab of the Task Properties dialog box.

To create a dependency relationship in a spreadsheet view:

1. Click the header button of the task for which you want to create the dependency relationship.

2. Right-click another task and choose one of the following options from the shortcut menu:
   - Select Make Successor if you want the task in step 2 to be the successor of the task in step 1.
   - Select Make Predecessor if you want the task in step 2 to be the predecessor of the task in step 1.

The task you select in step 2 becomes the successor or predecessor of the task you selected in step 1.

To edit or delete dependency relationships in a spreadsheet view:

1. Do one of the following:
   - In the task detail section of a view, double-click the header button of a predecessor or successor task.
   - Right-click a predecessor or successor task and choose Dependencies from the shortcut menu.

2. Use the Dependencies tab to edit or delete the dependency relationship.
Creating a dependency chain

As an alternative to individually creating dependency relationships, you can select multiple tasks simultaneously and create a chain of predecessor-to-successor relationships. You can do this in any spreadsheet view that contains a task detail pane where you can select multiple tasks. Each task you select becomes the successor of the previously-selected task.

The dependency type that is used is the default dependency type defined in the Options dialog box. Later, you can edit the dependency data on the Dependencies tab of the Task Properties dialog box. You must have two or more tasks in a view to create a dependency chain.

To create a dependency chain:

1. Select a predecessor task, then press the Ctrl key and click each task that you want to make a successor.
2. Right-click any of the selected tasks, then choose Make Chain from the shortcut menu. Each task you select becomes the successor of the previously-selected task.

The Make Chain command is available only when you select two or more tasks in a project and right-click one of them.

Creating, editing, and deleting dependencies on a Gantt chart

Another way to create dependencies is to do so directly on the Gantt chart area of a view. By default, dependency relationships you create on a Gantt chart are predecessor-to-successor relationships that use the default dependency type defined in the Options dialog box. Later, you can edit or delete dependencies on the Dependencies tab of the Task Properties dialog box.

Before you can use a Gantt chart to create a dependency relationship, you should first be able to see the relationship. To do this, enable the Show Dependencies feature. With this feature enabled, the Gantt chart area of a view displays connecting arrows between tasks that have dependency relationships.

To show dependency relationships on a Gantt chart:

1. Double-click anywhere on the Gantt chart. The Gantt dialog appears.
2. Select the Show Dependencies check box.

When you create a dependency relationship directly on a Gantt chart, a popup description appears, displaying the names of the predecessor and successor tasks, as well as the dependency type.

Note: If the dependency relationship cannot be created, a dialog box appears with a message and explanation.
To create dependency relationships on a Gantt chart:

1. Select a Gantt bar representing the predecessor task.
2. Click and hold the left mouse button, and drag the mouse to the Gantt bar of the successor task. A popup box appears during this process.
3. Release the mouse button when the popup box displays the name of the successor task. A connecting arrow appears between the two tasks after you release the mouse button.

To edit or delete dependency relationships from a Gantt chart:

1. Do one of the following:
   - In the task detail section of a view, double-click the header button of a predecessor or successor task.
   - Right-click a predecessor or successor task and choose Dependencies from the shortcut menu.
2. Use the Dependencies tab to edit or delete the dependency relationship.

**Using the Advanced Tab**

Use the Advanced tab to define and edit task scheduling constraints and other relevant task information.

To open the Advanced tab:

- Double-click a task’s header button, then select the Advanced tab in the Task Properties dialog box.

![Task Properties - Inter Changes dialog box](image-url)
Adding and editing scheduling constraints

Task scheduling constraints allow you to indicate to Autoschedule when a task should start or finish. When creating task scheduling constraints, a “Start” constraint indicates the task starts at the beginning of the work day, and a “Finish” constraint indicates that the task finishes at the end of the work day. Keep the following in mind when constraining tasks:

- If a task’s Status is ‘Started’, all ‘start’ constraint dates are read-only and cannot be edited.
- If a task’s status is ‘Completed’, all constraint dates are read-only and cannot be edited.
- If a task is a summary task that constrains detail tasks, the summary task constraints cannot be added.

To add or edit constraints:

- In the Date column of the Constraints grid, enter a constraining date for any of the following constraint types in the Type column:

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Must Start On</td>
</tr>
<tr>
<td>Schedule the task to start exactly on the date in the Date column. This selection overrides the Start No Earlier Than and Start No Later Than constraints.</td>
</tr>
<tr>
<td>Start No Earlier Than</td>
</tr>
<tr>
<td>Schedule the task to start no earlier than the date in the Date column.</td>
</tr>
<tr>
<td>Start No Later Than</td>
</tr>
<tr>
<td>Schedule the task to start no later than the date in the Date column.</td>
</tr>
<tr>
<td>Must Finish On</td>
</tr>
<tr>
<td>Schedule the task to finish exactly on the date in the Date column. This constraint overrides the Finish No Later Than and Finish No Earlier Than constraints.</td>
</tr>
<tr>
<td>Finish No Earlier Than</td>
</tr>
<tr>
<td>Schedule the task to finish no earlier than the date in the Date column.</td>
</tr>
<tr>
<td>Finish No Later Than</td>
</tr>
<tr>
<td>Schedule the task to finish no later than the date in the Date column.</td>
</tr>
</tbody>
</table>
Entering and editing values on the Fields grid

The Fields grid on the Advanced tab gives you access to all values associated with a task. Cells that are unavailable for data entry are disabled. A description of each item on the Fields grid is available in the online Help.

To create and edit other advanced properties in the Fields grid:

Click cells in the Value column and enter values. What you can enter in this column depends on the corresponding field. There are four ways to enter values:

- Select displayed check boxes.
- Enter numeric values, currency, or dates.
- Enter words or phrases.
- Choose options from drop-down lists.

To get online Help:

1. Click Help.
2. Use online Help to follow the links that lead you to the field descriptions.

Using the Methodology Tab

A methodology is a knowledge base containing a set of repeatable processes and instructions for systematically achieving a specific goal. Use Open Workbench to link methodology guidelines to tasks in a project. Guidelines can be produced using any program that your browser supports, and can provide in-depth descriptions for tasks and offer guidance for completing them.

You can link methodology guidelines created in Open Workbench or any other program by defining a URL (Uniform Resource Locator) or a directory and path where the guidelines are located.

If you need Open Workbench to create guidelines, guideline data and deliverables may appear automatically on this tab for the selected task. Guideline text, such as specific instructions, does not display in Open Workbench. However you can review this text outside of Open Workbench.

To read guideline text, select a task in a view and do one of the following:

- From the Help menu, choose Methodology Guidelines.
- Right-click the task and choose Guidelines from the shortcut menu.
Defining and Editing Task Properties

Linking and Editing Guideline Locations

If necessary, you can link task guidelines or edit the guideline location on the Methodology tab of the Task Properties dialog box.

To open the Methodology tab:

Do one of the following:

- Double-click a task’s header button, and then click Methodology.
- Right-click a task, choose Modify from the shortcut menu, and then click Methodology. The Methodology tab of the Task Properties dialog box appears.

In some cases, when the Methodology Author links guidelines, or guidelines to tasks, text boxes in this dialog box display guideline data, and the Deliverables grid displays task deliverables.

If phases or activities are assigned guidelines, their tasks automatically inherit the guideline URL or directory and path. If the location includes a file name and extension, it also appears on the Methodology tab.
Linking guidelines

Before linking or editing the location of methodology guidelines you must know their exact location and file name and whether or not the program used to create it is supported by your browser. Guidelines can be linked to individual tasks or at the project, phase, activity, and task levels. For example:

<table>
<thead>
<tr>
<th>Level</th>
<th>Example Guideline Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td><a href="http://www.guidelines.com">http://www.guidelines.com</a></td>
</tr>
<tr>
<td>Phase</td>
<td><a href="http://www.guidelines.com/production">http://www.guidelines.com/production</a></td>
</tr>
<tr>
<td>Activity</td>
<td><a href="http://www.guidelines.com/production/planning">http://www.guidelines.com/production/planning</a></td>
</tr>
<tr>
<td>Task</td>
<td><a href="http://www.guidelines.com/production/planning/kickoff.htm">http://www.guidelines.com/production/planning/kickoff.htm</a></td>
</tr>
</tbody>
</table>

When you work with guidelines saved to a hard drive, you must enter `file://` followed by the directory and path and, when applicable, the guideline file name and its extension. For example, enter:

`file:///c:\guidelines\plan.htm`

To link methodology guidelines, make one of the following entries in the Guidelines text box:

- If a URL is displayed in the Guidelines URL text box, enter the sublocation, file name, and file extension of the task-specific methodology. This is added to the Guidelines URL text box.

- To enter a directory, path, and file name and extension, enter `file://` followed by the directory and path and, when applicable, the guideline file name and extension. Your entry appears in the Guidelines URL text box. For example, enter:

  `file:///c:\guidelines\plan.htm`

The Deliverables grid displays the ID and description of all the deliverables associated with the task, and the Method ID text box references the task ID number in the method where it was created. You can also append the guideline location with `#` or `?` followed by the name of another location to jump to within the guidelines file.
Editing methodology links

When a guideline location is defined for a phase or activity, it is inherited by all subordinate tasks, but you can overwrite this location for individual tasks.

To overwrite a task’s default URL or directory and path:

ฤษ Click in the Guideline text box and do one of the following:

• Enter http:// followed by the URL and the guideline file name and extension.
  For example, to change a task’s URL from http://www.methods.com to http://www.guidelines.com, enter the following:
  http://www.guidelines.com

• Enter file:/// followed by a new directory and path, and the guideline file name and extension.
  For example, to change a task’s directory, path, file name, and extension from file:///c:\corporate\plan.htm to file:///d:\guidelines\plan.htm, enter the following:
  file:///d:\guidelines\plan.htm

The guideline for the task reflects the new location, while the location of guidelines for other tasks remains unchanged.

Note: You can also append the guideline location with # or ? followed by the name of another location to jump to within the guidelines file.
Using the Notes Tab

Tasks notes provide you with an easy way to communicate with staff members and your project manager. When you create notes, you can also check them for spelling errors before adding them to a task, and you can view and edit them. In addition, you can categorize notes and you can see historical notes information.

To open the Notes tab:

1. Double-click a task’s header button, and then select the Notes tab in the Task Properties dialog box.

Creating notes

To create task-specific notes:

1. In the Notes text box, enter a note for the task.
2. Optionally, click Spell Check to check for spelling errors.
3. In the Category text box, select an existing category or enter a new one.
   
   Warning: If you are adding a new notes category, you must specify a Global Files location on the Locations tab of the Options dialog box. Otherwise, the notes category is not available for future use.
4. Click Add. The note appears as the last item in the History grid.

Reviewing and editing notes

To review and edit notes:

1. In the History grid, select a note. The note appears in the Notes text box.
Creating and Managing Project Tasks  
Defining and Editing Task Properties

2 To edit the text of the note, click Modify.

Deleting notes

To delete notes:

► In the History grid, select a note, and then click Delete.

Using the Subproject Tab

The Subproject tab of the Project Properties dialog box is available only when the selected task was inserted as a sub-project. This tab gives you access to the project properties for the project from which the task originated.

To learn more about working with sub-projects, see "Establishing Master and Sub-project Relationships" on page 181.

To open the Subproject tab:

1 Double-click a task that you have inserted as a sub-project. The Task Properties dialog box appears.

2 Click Subproject.

3 Click Project if you want to view project properties for the sub-project. The Project Properties dialog box appears for the sub-project.

4 When you finish reviewing the sub-project’s project properties, click OK to return to the Subproject tab.
Managing Tasks From Views

A list of task-specific shortcut menu commands is available in most spreadsheet views when you right-click a task. Following is a list of available shortcut menu options:

<table>
<thead>
<tr>
<th>Shortcut Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Cut the selected task from the spreadsheet view and put it on the clipboard. For more information on cutting cells, see “Cutting, Copying, and Pasting Project Data” on page 138.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copy the selected task and put it on the clipboard. For more information on copying cells, see “Cutting, Copying, and Pasting Project Data” on page 138.</td>
</tr>
<tr>
<td>Paste</td>
<td>Paste a previously cut or copied task into a different project or to a different location in the same project. For more information on pasting cells, see “Cutting, Copying, and Pasting Project Data” on page 138.</td>
</tr>
<tr>
<td>Insert Task</td>
<td>Insert a blank row above the selected row.</td>
</tr>
<tr>
<td>Make Predecessor</td>
<td>Make a dependency relationship where the second selected task is the predecessor of the first selected task. This option is available when you have one task selected and you right-click another task.</td>
</tr>
<tr>
<td>Make Successor</td>
<td>Make a dependency relationship where the second selected task is the successor of the first selected task. This option is available when you have one task selected and you right-click another task.</td>
</tr>
<tr>
<td>Make Chain</td>
<td>Creates predecessor-to-successor dependency relationships between the selected tasks. This option is available when you have two or more tasks selected and you are creating a dependency relationship.</td>
</tr>
<tr>
<td>Insert Subproject</td>
<td>Displays the Open Sub-projects dialog box, where you can select a project you want to insert as a sub-project. For more information on sub-projects, see “Establishing Master and Sub-project Relationships” on page 181.</td>
</tr>
<tr>
<td>Insert External Dependency</td>
<td>Opens the External Dependencies dialog box, where you can select a task that you want to specify as an external dependency to the task you have selected in the spreadsheet. For more information on external dependencies, see “Working with Dependencies” on page 188.</td>
</tr>
<tr>
<td>Delete Task</td>
<td>Remove the selected task from the project.</td>
</tr>
<tr>
<td>Modify</td>
<td>Open the Task Properties dialog box for the selected task.</td>
</tr>
</tbody>
</table>
### Shortcut Menu Command

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dependencies</td>
<td>Display the Dependencies tab of the Task Properties dialog box for the selected task.</td>
</tr>
<tr>
<td>Assignments</td>
<td>Display the Resources tab of the Task Properties dialog box for the selected task.</td>
</tr>
<tr>
<td>Notes</td>
<td>Display the Notes tab of the Task Properties dialog box for the selected task.</td>
</tr>
<tr>
<td>Guidelines</td>
<td>View the methodology guidelines, if any exist for the task.</td>
</tr>
</tbody>
</table>
Editing Multiple Task Selections

The multiple selection feature in Open Workbench provides a quick and easy way to simultaneously assign common properties or change properties for many tasks at once, without having to open the Task Properties dialog box for each task. The Task Properties - Multiple Selections dialog box provides this feature.

The Task Properties - Multiple Selections dialog box has features similar to the Task Properties dialog, but its effect on tasks is different. This feature is only available in spreadsheet views that display a task detail section. Some rules for entering and changing data in the Task Properties - Multiple Selection dialog box include:

- You cannot change properties for multiple tasks that are sub-projects.
- Dialog box elements display data when the data is the same for all of the selected tasks.
- Blank dialog box elements indicate that the data varies for each task. If you enter data, you change the data for all selected tasks.
- Some check boxes appear disabled and selected if the tasks have different settings. In some cases you can select or de-select those check boxes and change the value for all selected tasks. Otherwise, leave the check boxes unchanged so tasks retain their original settings.
- Some groups of options may appear disabled; in cases where you can select them, you reset attributes for all selected tasks.
- In most cases, a disabled text box or drop-down list is noneditable.
- Drop-down lists display choices that are common for all tasks. If a common value does not exist, the list is disabled.

Using the Task Properties - Multiple Selections Dialog Box

Before you can open the Task Properties - Multiple Selections dialog box, you must display your project in a spreadsheet view and select multiple tasks.

If any of the tasks you select are sub-projects, you cannot change task properties in the dialog box.

- Do one of the following to select multiple tasks:
  - To select a contiguous range of tasks, press the Shift key and click a range of tasks.
  - To select a noncontiguous range of tasks, press the Ctrl key and individually click tasks.

Once you select multiple tasks, you can open the Task Properties - Multiple Selections dialog box. Tabs appearing in this dialog box are identical to those in the Task Properties dialog box described earlier in this chapter.

To open the Task Properties - Multiple Selections dialog box:

- Right-click one of the selected tasks and choose Modify from the shortcut menu. The Task Properties - Multiple Selections dialog box appears.
Creating and Managing Project Tasks

Editing Multiple Task Selections

Using the General Tab

Changes you make to this tab apply to all selected tasks. In most cases, if you do not make entries in blank dialog box elements, the properties for each task remain unchanged. However, if you do enter data in a blank dialog box element, the data changes for all of the selected tasks.

For specific information on entering data on this tab, see the steps for entering data on the General tab of the Task Properties dialog box on page 150. The following information is valid when editing data for multiple tasks:

<table>
<thead>
<tr>
<th>Specific Field</th>
<th>Information</th>
<th>Implication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ext ID text box</td>
<td>If you enter an external ID here, the first task assumes the value you enter, and subsequent tasks assume unique incremental numbers. For example, if you enter ENGR, the first task has ENGR as its external ID, and subsequent tasks might be numbered with ENGR-1, ENGR-2, and ENGR-3. Note: If you have entered a value, the text box will still appear blank since each task is given a unique ID.</td>
<td></td>
</tr>
<tr>
<td>Type drop-down list</td>
<td>This is a noneditable list.</td>
<td></td>
</tr>
<tr>
<td>Status drop-down list</td>
<td>This is a noneditable list. However, the data displayed changes depending on what you enter in the % Complete box.</td>
<td></td>
</tr>
<tr>
<td>% Complete text box</td>
<td>Changes you make here affect all selected tasks, and may change the status displayed in the Status drop-down list. This text box is disabled if any of your selections are phases or activities.</td>
<td></td>
</tr>
</tbody>
</table>

Using the Resources Tab

When you assign resources using this tab, they are assigned to all selected tasks. Likewise, any changes you make to data on this tab are also applied to each task. Resources automatically appear on the Assigned Resource grid when all of the tasks you selected are using those resources and the resources have common attributes. This tab is unavailable if any of the items you selected on the spreadsheet view were phases or activities.

To open this tab from a spreadsheet view:

1. Select a range of tasks.
2. Right-click and choose Assignments from the shortcut menu.

For specific information on entering data on this tab, see the steps for entering data on the Resources tab of the Task Properties dialog box on page 152.
Using the Dependencies Tab

In addition to editing common dependency relationships, you can also create dependency relationships that you want to make common to all selected tasks. Dependencies with attributes that are common to all of the selected tasks will also appear when you open the Dependencies tab. The following rules apply to creating dependencies for multiple selected tasks:

- This tab is unavailable if any of the items you selected on the spreadsheet view were phases or activities.
- You cannot make tasks dependent upon themselves, and therefore cannot select tasks appearing on the Project Tasks list if you selected them when opening the Task Properties - Multiple Selection dialog box.

To open this tab from a spreadsheet view:

1. Select a range of tasks.
2. Right-click and choose Dependencies from the shortcut menu. For specific information on entering data on this tab, see the steps for entering data on the Dependencies tab of the Task Properties dialog box on page 155.

Using the Advanced Tab

In addition to editing common advanced information and constraints, you can enter advanced information and constraints that you want to make common to all selected tasks. Follow are some rules for entering advanced task information:

- When all of the selected tasks have common values, those values appear in the Fields grid.
- Values you enter in blank cells on this grid become common to all of the selected tasks.
- Do not enter data in blank dialog box elements if you want the selected tasks to retain their original values.
- In some cases, cells on the Fields grid are disabled if a common value cannot be applied to all of the tasks.
- When all tasks have common constraints, those values appear on the Constraints grid. Changes you make to the columns on this grid affect all of the tasks.

To open this tab from a spreadsheet view:

1. Select a range of tasks.
2. Right-click and choose Modify from the shortcut menu, and then click Advanced to the view the Advanced tab. For specific information on entering data on this tab, see the steps for entering data on the Advanced tab of the Task Properties dialog box on page 161.
Using the Methodology Tab

In addition to editing common advanced information and constraints, you can enter advanced information and constraints that you want to make common to all selected tasks. Follow are some rules for using the Methodology tab:

- When all of the selected tasks use the same Method ID and Guidelines, the information is displayed on the Methodology tab. The exception to this is data appearing in the Guideline URL text box, which is project-specific.
- If all selected tasks share a Method ID and Guidelines file, the Deliverables grid displays deliverables common to all tasks.
- A blank Deliverables grid indicates there are no common deliverables between the tasks.
- Fields on the Methodology tab are blank when there is no commonality between the tasks, and any data you enter is applied to all selected tasks.

To open this tab from a spreadsheet view:

1. Select a range of tasks.
2. Right-click and choose Modify from the shortcut menu, and then click Methodology to view the Methodology tab. For specific information on using this tab, see the steps for entering data on the Methodology tab of the Task Properties dialog box, in “Using the Methodology Tab” on page 163.

Using the Notes Tab

Notes that are identical in category, text, author, created time, modified by, and modified time for all selected tasks appear on the History grid on this tab. The History grid is blank when there is no commonality between the task notes. Any changes you make to existing notes, or any new notes that you create, are applied to all selected tasks.

To open this tab from a spreadsheet view:

1. Select a range of tasks.
2. Right-click and choose Notes from the shortcut menu.

For specific information on using this tab, see the steps for entering data on the Notes tab of the Task Properties dialog box on page 167.
Shifting Tasks

When you display a view that contains a Gantt chart, you can manually change a task’s schedule by dragging Gantt bars to new positions. When you move Gantt bars, a pop-up window displays new dates. Use this feature to change task start dates, finish dates, or both. Changes you make to start and finish dates automatically update task start and finish dates in the Task Properties dialog box. You can also shift task start and finish dates interactively on the Gantt chart in either of the following ways:

- You can shift start or finish dates, extending the task duration relative to the surrounding time frame.
- You can shift the entire task to a new position relative to the surrounding time frame, keeping the task duration intact.

When shifting tasks, keep the following in mind:

- You cannot shift tasks if the Freeze Gantt Bars check box in the Gantt dialog box is selected.
- You can shift only one task at a time.
- You cannot move completed tasks.
- You cannot set the start dates of tasks to begin after the start date of their resource assignments. A task’s start date can only be before or on the assignment start date.
- You cannot set the finish date of tasks to end before the finish date of their resource assignments. A task’s finish date can only be on or after the last assignment date.
- You cannot change the end date of a variable-duration task to a date later than the end date of the last end date of the assignments, regardless of the loading pattern. You can, however, change the end date on fixed-duration tasks.
- Task durations cannot be longer than the recalculated duration if the variable tasks have resource assignments with ETC. However, you can drag Gantt bars to new positions on the Gantt chart, changing task start and finish dates.
- You cannot change the start and finish dates of variable-duration tasks that have resource assignments with ETC. Instead, you can move these tasks.
- You cannot change the start date of tasks that have actuals entered against them, unless the task is of a fixed duration and the start date is earlier than the earliest actuals entered.
- Dependency relationships may impact your ability to change task start and finish dates, and their duration.
**Shifting task start and finish dates**

To shift task start and finish dates and change task duration, place the mouse pointer on a bar in the Gantt chart and do one of the following:

- To change a task’s start date, drag the left side of the Gantt bar to a new position on the timescale.
- To change a task’s finish date, drag the right side of the Gantt bar to a new position on the timescale.

**Changing the time frame of tasks**

To change task position relative to the surrounding time frame without changing task duration:

- Place your mouse on the center of a bar in the Gantt chart, and drag the bar to a new position on the timescale.
Deleting Tasks

You can delete any items in the WBS hierarchy and you can delete sub-projects from a master project. The following information is important to remember when you are deleting summary and detail tasks from a project:

- Deleting a task does not automatically delete any assigned resources.
- If you delete a phase, activity, or task, the levels underneath are not removed. Instead they become part of the preceding hierarchy.
- Because deleting a task may impact other areas of Open Workbench, we recommend that you re-Autoschedule your project after deleting tasks.

To delete a task:

1. Select a task in the spreadsheet view.
2. From the Edit menu, choose Delete.
Creating and Managing Project Tasks

Deleting Tasks
7 Working with Multiple Projects

In this chapter:

- "Overview" on page 180
- "Establishing Master and Sub-project Relationships" on page 181
- "Working with Dependencies" on page 188
Overview

This chapter discusses how you can use Open Workbench to handle multiple projects for department-level management.

Project teams typically work on large and small projects simultaneously. To manage departments and organizations, you may often have to manage and control several projects at once. Many of these projects may also share the same resources.

Open Workbench has several methods for managing multiple projects, including creating master project and sub-project relationships and dependency relationships between tasks in the same and different projects.

- The master project and sub-project feature creates a link between one project (called a master project) to all or any sets of phases, activities, tasks, and milestones in another project (called a sub-project in this context). Any number of sub-projects can be combined in a master project. More on master project and sub-project relationships is discussed in "Establishing Master and Sub-project Relationships" on page 181.

- Dependency relationships are a means for managing the relative timing of tasks. This gives you a greater understanding of your project’s work flow, and helps to pinpoint weaknesses in project plans. You can create dependency relationships between tasks in the same project and those in different projects. To learn more about dependency relationships, see “Working with Dependencies” on page 188.
Establishing Master and Sub-project Relationships

The ability to establish sub-project links means you can create plans and track and analyze an individual project in detail while viewing, summarizing, and analyzing the progress of several projects at a higher level. Use this feature to perform top-down planning and to share resource availability across projects.

Remember the following when working with master projects and sub-projects:

- Each time you open a master project, all required sub-project data is accessed from the appropriate sub-project records.
- If you insert part of a sub-project as a sub-project, you cannot edit its properties.
- If the sub-project is in Read-only mode, changes made to the master project do not change the sub-project. This ensures data integrity at the detailed level.
- Changes made to sub-projects are reflected at the master project level when it is next opened unless you have both projects open simultaneously.

Master and Sub-project Autoschedule Considerations

If you Autoschedule a master project, read-only sub-project files are not changed during the Autoschedule process.

Creating Sub-project Links

In this discussion of sub-projects, the default Work Breakdown Structure (WBS) is used. If you have customized the WBS level names and the number of WBS levels, the levels may be named differently, but they will behave identically.

The master project displays sub-projects in the order in which they were selected and inserted. The following rules apply when inserting sub-projects:

- You can insert an entire project as a sub-project, or you can insert only selected phases, activities, tasks, and milestones as sub-project data.
- When you insert part of a project as a sub-project, it is automatically inserted as read-only.
- Sub-project dependencies display in the master project and are taken into consideration during the scheduling process if you have read/write access to the sub-project.
- When you insert a sub-project, it is placed immediately above the selected row. However, you can change the sub-project’s position in a view by dragging and dropping it to a new location.
Master Project and Sub-project Prerequisites

The process of creating a master project and sub-project relationship requires these three steps:

1. Make sure that the project or any of its phases, activities, tasks, or milestones already exists.
2. Create a master project by opening an existing project or creating a new project.
3. Assign another project, or parts of another project as sub-projects in the master project.

Creating Master Project and Sub-project Relationships

You create a master project and sub-project relationships using a new project or using an existing project. This section describes a variety of methods for inserting a sub-project into a master project.

When you insert part of a project as a sub-project, it is automatically inserted as read-only.

To create a new master project:

1. From the File menu, choose Open. The Open dialog box appears.
2. Locate and select the target sub-project(s).
3. Select the Create Subprojects check box.
4. Optionally, select the Open as read-only check box if you want to insert a read-only sub-project.
5. Click Open.
Inserting sub-projects from a view

When you insert part of a project as a sub-project, it is automatically inserted as read-only.

To create a master project and sub-project relationship from a view:

1. Open an existing project or, from the File menu, choose New.
2. Right-click a row in the task detail section of the view, and choose Insert Subproject from the shortcut menu. The Open Sub-projects dialog box appears.
3. Optionally, select the Open as read-only check box if you are inserting an entire project as a read-only sub-project.
4. Use the File toolbar button to locate projects.
5. Do one of the following:
   - To insert an entire project as a sub-project, double-click the project.
   - To insert specific phases, activities, tasks, or milestones that are part of a project, click the project, open and select items from the WBS in the right pane of the dialog box, then click Select.
Inserting sub-projects using the Sub-projects dialog box

When you insert part of a project as a sub-project, it is automatically inserted as read-only.

To insert sub-projects using the Sub-projects dialog box:

1. Open a new project or an existing project.
2. From the Tools menu, choose Sub-projects. The Sub-projects dialog box appears. In addition to using this dialog box to insert and delete sub-projects, you can display a list of all sub-projects that are currently part of the master project.
3. Click Insert. The Open Sub-projects dialog box appears. Use this dialog box to insert sub-projects.
4. Use the Folder toolbar button to locate projects.
5. Do one of the following:
   • To insert an entire project as a sub-project, double-click the project.
   • To insert only parts of a project, click the project, open and select items from the WBS in the right pane of the dialog box and click Select.
6. Optionally, select the Open as Read-Only check box if you are inserting an entire project as a read-only sub-project. Your selections appear in the Sub-projects dialog box and in the view. See “Using the Sub-projects Dialog Box” on page 186 for more information on using this dialog box.
Editing Sub-project Properties

When you edit properties for sub-projects, the changes also appear in the original project. Prior to editing these properties, remember that you must have read/write access to the master project and the sub-project for your changes to be saved. Edits that you make to a sub-project’s properties are made in the sub-project’s Project Properties dialog box. For instructions on using this dialog box, see “Creating and Editing Projects” on page 120.

Editing project properties for a sub-project

You can edit the project properties of a sub-project if you inserted an entire project or if you inserted a partial sub-project. The dialog box that appears depends on whether the sub-project is an entire project or only part of a project.

▪ If you select an entire project that was inserted as a sub-project, the Project Properties dialog box displays.

▪ If you select a partial sub-project, the Task Properties dialog box displays.

To edit project properties for a sub-project:

1. Select the sub-project name from the view.

2. Select the sub-project and double-click its header button.

If the Project Properties dialog box appears, use the dialog box to edit the sub-project’s properties. For instructions on editing project properties, see “Creating and Editing Projects” on page 120. If the Task Properties dialog box appears, use the Subproject tab to open the Project Properties dialog box. For instructions on using the Subproject tab, see “Using the Subproject Tab” on page 128.

Editing sub-project task properties

To edit properties for a task in a sub-project:

1. Double-click the task’s header button. The Task Properties dialog box appears.

2. Use the tabs in the Task Properties dialog box to edit the task. For further instructions, see “Defining and Editing Task Properties” on page 149.
Adding Tasks to Sub-projects

You can add tasks to a sub-project directly in the master project. If you have read/write capabilities, any tasks you add to a sub-project also appear in the original project.

To add a task to a sub-project:

1. Insert a row at a location in the sub-project, or before the first sub-project task, or after the last sub-project task.

2. Do one of the following:
   - Enter the task information directly in the spreadsheet view.
   - Open the Task Properties dialog box, and then enter task-specific information.

Rearranging and Nesting Sub-projects in a Master Project

When you create nested sub-projects, you insert sub-projects in other sub-projects in the same master project. This change is updated in each originating project.

To rearrange sub-projects, perform one of the following:

- Select a sub-project, click on the highlighted row, and drag it to a new location in the master project.
- Select, cut, and paste the sub-projects.

Using the Sub-projects Dialog Box

Use the Sub-projects dialog box to insert and delete sub-projects, and to view and print a list of all sub-projects that are part of a master project. This dialog box also provides you with information on the origin of sub-project data.

The Sub-projects dialog box appears when, from the Tools menu, you select Sub-projects.
**Sub-projects dialog box features**

This dialog box has the following features:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sub-projects list</td>
<td>Displays a list of all sub-projects associated with the master project.</td>
</tr>
<tr>
<td>Project text box</td>
<td>Displays the project name and project from which a selected sub-project originated.</td>
</tr>
<tr>
<td>Task text box</td>
<td>Displays the name of the selected sub-project. This text box remains empty if the item you select from the Sub-projects list is an entire project.</td>
</tr>
<tr>
<td>Read-only check box</td>
<td>Opens the sub-project as read-only.</td>
</tr>
<tr>
<td>Insert button</td>
<td>Displays the Open Sub-projects dialog box, from which you can select sub-projects.</td>
</tr>
<tr>
<td>Delete button</td>
<td>Removes the selected sub-project from the master project. This operation does not affect the sub-project itself, just its relation to the master project.</td>
</tr>
<tr>
<td>Print button</td>
<td>Prints the contents of the Sub-projects dialog box.</td>
</tr>
</tbody>
</table>

**Removing Sub-projects**

There are several ways to remove sub-projects, or parts of sub-projects from a master project. Some important points to remember about removing sub-projects include:

- Removing a sub-project only removes it from the master project, it does not actually delete the sub-project.
- You can only remove the entire sub-project from the master project.
- If you remove the top tier of a nested sub-project (one sub-project inserted inside another sub-project) all of the subordinate sub-projects are also removed from the master project.

To remove a sub-project:

- Do one of the following:
  - From the Edit menu, choose Delete. Right-click and choose Delete Task from the shortcut menu.
  - From the Tools menu, choose Sub-projects. In the Sub-projects dialog box, select a sub-project from the Sub-projects group in the Sub-projects dialog box and click Delete.
Working with Dependencies

Dependencies provide you with a means of ordering the relationship and timing of tasks within a project (internal dependencies), and in multiple projects (external dependencies). Dependencies define the reliance of one or more tasks on other tasks, whether the tasks reside in the same, or different projects.

This section shows how to work with dependencies, including how to define predecessor and successor relationships, and how to create, edit, and remove dependency relationships.

Dependency Relationships

You can create dependency relationships between tasks from the same or different projects. If you work with master projects and sub-projects, you can also create dependency relationships between them.

The method for creating dependencies between sub-project tasks is the same as that for creating dependencies between tasks in the same project. These relationships are reflected in the master project and the sub-project’s original project.

If you display dependency relationships in a view that uses the Predecessors, Successors, Relation, Type, Lag, and Lag Type field names in the view’s definition, to correctly display the dependency relationships you must also include the Task Name or Task ID field name in the view definition. Also, you must place the Task Name or Task ID field name in a column preceding the Type, Lag, Lag Type and Project columns.

Dependency Types

There are four types of dependencies you can create to establish the relationship between the start and finish dates of dependent tasks. These dependency types include:

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Finish-Start</td>
</tr>
<tr>
<td>The successor task cannot start until its predecessor finishes.</td>
</tr>
<tr>
<td>Finish-Finish</td>
</tr>
<tr>
<td>The successor task cannot finish until its predecessor task finishes.</td>
</tr>
<tr>
<td>Start-Start</td>
</tr>
<tr>
<td>The successor task cannot start until its predecessor starts.</td>
</tr>
<tr>
<td>Start-Finish</td>
</tr>
<tr>
<td>The successor task cannot finish until its predecessor starts.</td>
</tr>
</tbody>
</table>
Creating, Editing and Removing Internal Dependency Relationships

You can create dependency relationships between tasks in the same project on the Dependencies tab of the Task Properties dialog box, on Gantt charts, in spreadsheet views, and from a CPM network view.

This section discusses the basic steps for creating dependency relationships that use Open Workbench default settings. For instructions on changing the default settings and other dependency properties, see “Working with Dependencies” on page 188.

The Dependencies tab of the Task Properties dialog box shows the selected task’s dependency relationships and has features for adding and modifying dependency relationships. Use this tab to create, edit, and remove dependency relationships for the selected task, or for other tasks appearing in on the Dependencies tab.
To easily identify dependency relationships, the Dependencies list displays the following icons:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon 1]</td>
<td>Indicates the displayed task is a predecessor.</td>
</tr>
<tr>
<td>![Icon 2]</td>
<td>Indicates the displayed task is a successor.</td>
</tr>
</tbody>
</table>
To create dependencies in the Task Properties dialog box:

1. Right-click a task in a spreadsheet view and choose Dependencies from the shortcut menu. The Dependencies tab of the Task Properties dialog box appears.

2. From the Project Tasks list, select a task for which you want to create a successor or predecessor dependency relationship.

3. Click Add Predecessor or Add Successor.

The task you selected in step 2 becomes the successor or predecessor of the task you selected in the view and the dependency relationship appears in the Dependencies list.

After you have created the dependency relationship, you may want to change the default dependency properties or create new properties.

To edit dependency properties:

- In the Dependencies group, perform any of the following steps:
  - From the Pred/Succ drop-down list, choose the dependency relationship of a task.
  - From the Type drop-down list, choose the type of dependency. For more information about dependency types, see “Dependency Types” on page 188.
  - Click in the Lag text box and enter a number representing an amount of lag or negative lag.
  - Click in the Lag Type box and choose Daily or Percent from the drop-down list.
Creating and editing dependency relationships in a spreadsheet view

To create predecessor relationships in a spreadsheet view, the view must display tasks. These dependencies use the default dependency type defined in the Options dialog box. Later, you can edit and remove these relationships on the Dependencies tab of the Task Properties dialog box.

To create a dependency relationship in a spreadsheet view:

1. Click the header button of the task for which you want to create the dependency relationship.

2. Right-click the header button of another task and choose one of the following options from the shortcut menu:
   - Choose Make Successor if you want the task in step 2 to be the successor of the task in step 1.
   - Choose Make Predecessor if you want the task in step 2 to be the predecessor of the task in step 1.

The task you choose in Step 2 becomes the successor or predecessor of the task you selected in Step 1.

To edit or remove dependency relationships in a spreadsheet view:

1. Right-click a predecessor or successor task and choose Dependencies from the shortcut menu.

2. Use the Dependencies tab to edit or remove the dependency relationship.

In addition to individually creating dependency relationships, you can select multiple tasks simultaneously and create a chain of predecessor-to-successor relationships. To create a dependency chain, you must select multiple tasks in the view. In a dependency chain, each task you select becomes the successor of the previously-selected task.

These dependencies use the default dependency type defined in the Options dialog box. Later, you can edit and remove these relationships on the Dependencies tab of the Task Properties dialog box.

To create a dependency chain:

1. Select a predecessor task, and then press and hold the Ctrl key and click each task that you want to make a successor.

2. Right-click any of the selected tasks, then choose Make Chain from the shortcut menu. Each task you select becomes the successor of the previously-selected task.
Creating dependencies in a CPM network

Another easy way to create dependency relationships is in a CPM network. By default, these dependencies use the default dependency type defined in the Options dialog box. Later, you can edit and remove these relationships on the Dependencies tab of the Task Properties dialog box.

To create dependencies in a CPM network:

1. Select the cell containing the task that will be the predecessor task.
2. Click again on the cell and drag your mouse to the cell containing the task that will be the successor task. The two tasks are connected by a line indicating the dependency.

To edit or delete dependency relationships in a CPM network:

1. In the task detail section of a view, double-click the header button of a predecessor or successor task.
2. Use the Dependencies tab to edit or remove the dependency relationship.

Creating dependencies on a Gantt chart

Dependency relationships you create on a Gantt chart use the default dependency type defined in the Options dialog box. Later, you can change the dependency relationship and type on the Dependency tab of the Task Properties dialog box for either the predecessor or successor task.

Enable the Show Dependencies feature before creating dependencies directly in a Gantt chart. With this feature enabled, the Gantt chart displays connecting arrows depicting the dependency relationships.

To show dependency relationships on a Gantt chart:

1. Double-click anywhere in the Gantt chart. The Gantt dialog appears.
2. Select the Show Dependencies check box.
When you create a dependency relationship on a Gantt chart, a popup box appears that displays the name of the predecessor and successor tasks, as well as the dependency type.

A dialog box appears with a warning message and explanation if the dependency relationship cannot be created.

To create a dependency relationship on a Gantt chart:

1. Click on a Gantt bar representing the predecessor task.
2. Click and hold the left mouse button, and drag the mouse to the Gantt bar representing the successor task, then release the mouse button.

A connecting arrow appears between the two tasks after you release the mouse button.

Gantt dependency lines from local tasks to external dependencies or between external tasks will not display. You can use drag and drop to create dependencies from a local task to an external task, but not vice versa.

To edit or remove dependency relationships created on a Gantt chart:

1. In the task detail section of a view, double-click the header button of a predecessor or successor task.
2. Use the Dependencies tab to edit or remove the dependency relationship.

**Creating External Dependency Relationships**

You can create external dependency relationships between tasks in different projects. You can create these relationships in spreadsheet views and a CPM network using methods that differ from those used to create internal dependencies. When you create external dependency relationships, the relationships appear in both projects.

This section contains some basic steps for creating external dependency relationships using default settings. For instructions on changing the default settings, defining dependency types and lag, and editing dependency relationships, see "Editing external dependency relationships in the External Dependencies dialog box" on page 199.
Creating external dependencies in spreadsheet views

When you create an external dependency relationship, the external task is automatically made a successor task. You can later change the dependency relationship on the Dependencies tab of the Task Properties dialog box or in the External Dependencies dialog box.

To create external dependencies in a spreadsheet view:

1. Select a task that you want to make a successor or predecessor.
2. From the Tools menu, choose External Dependencies. The External Dependencies dialog box appears.

3. Click Insert. The Open External Dependencies dialog box appears.
4. Use this dialog box to locate a project, and then use the WBS on the right pane to locate and select a task.
5. Click Select. The task you selected appears in the External Dependencies dialog box. Depending on your highlights file, the external task may have a unique appearance in your view.
Creating external dependencies in CPM networks

When you create an external dependency relationship in a CPM network, the external task is automatically made a successor task. Later, you can change the dependency relationship for the task on the Dependencies tab of the Task Properties dialog box or in the External Dependencies dialog box. Dependency relationships created in a CPM network also appear in spreadsheet views and on the Dependencies tab of the Task Properties dialog boxes for all associated tasks.

To create external dependencies in CPM networks:

1. Select the cell containing the predecessor task.
2. From the Tools menu, choose External Dependencies. The External Dependencies dialog box appears.
3. Click Insert. The Open External Dependencies dialog box appears.
4. Use this dialog box to locate a project, and then use the WBS on the right pane to locate and select a task, then click Select. The task you select appears in the External Dependencies dialog box.
Editing Dependency Relationships

You can edit dependency relationships for internal and external dependencies on the Dependencies tab of the Task Properties dialog box and in the External Dependencies dialog box.

To open the Dependencies tab for tasks that have internal dependencies:

- Do one of the following:
  - In a spreadsheet view, right-click the task and choose Dependencies from the shortcut menu.
  - From a CPM network, double-click the task’s cell. When the Task Properties dialog box appears, click Dependencies.

When working with an external dependency, you can only access the Dependency tab of the Task Properties dialog box if the externally dependent task has a predecessor relationship with a task in the project. Otherwise, use the External Dependencies dialog box discussed in “Editing external dependency relationships in the External Dependencies dialog box” on page 199.
Editing dependency relationships

The Dependencies tab of the Task Properties dialog box displays dependency relationships for a selected task, including internal and external dependencies. In addition to editing dependency relationships on this tab, you can add new dependency relationships.

To edit dependency relationships:

1. From the Pred/Succ drop-down list, change the dependency relationship of a task.

2. From the Type drop-down list, choose the type of dependency. For more information about dependency types, see “Dependency Types” on page 188.

3. Click in the Lag text box and enter a number representative of an amount of lag or negative lag.

4. Choose Daily or Percent from the drop-down list.

Open Workbench uses lag and negative lag to determine the amount of time between two tasks, or the amount of time that two tasks can be simultaneously in process. You define lag and negative lag in the Lag text box on the Dependencies tab of the Task Properties dialog box.

- Lag is the amount of time, or a percentage of the duration, between the two tasks. For example, if you want Task B to start three days after Task A finishes, make the relationship Finish-Start and enter 3.00 in the Lag text box. You can also enter lag to indicate a percent.

- Lag can also be negative. This is defined as the amount of time or percentage of task duration in which two tasks can be simultaneously in process. For example, if you want Task B to start two days before Task C ends, make the relationship Finish-Start and enter -2.00 in the Lag text box. You can also enter negative lag as a percent.

Percentage of duration is usually based on the length of the predecessor task. However, if the dependency type is Finish-Finish, the percentage of duration is based on the length of the successor task.
Editing external dependency relationships in the External Dependencies dialog box

You can edit dependency relationships to external tasks in the External Dependencies dialog box. Changes you make are updated throughout the current project and the project where the external task resides.

To open the External Dependencies dialog box:

1. From the Tools menu, choose External Dependencies. The External Dependencies dialog box appears.

2. From the Pred/Succ drop-down list, change the dependency relationship of a task.

3. If desired, in the Int. Task text box change the name of the task upon which the external dependency was made. The project is updated with the new task name.

4. From the Type drop-down list, change the type of dependency. For more information about dependency types, see “Dependency Types” on page 188.

5. Click in the Lag text box and enter a number representing a lag or negative lag amount.

6. Click Lag Type and choose Daily or Percent from the drop-down list.
   The Ext. Task and Ext. Project text boxes are read-only.
Removing Dependencies

When you remove dependency relationships, you do not delete any tasks from the project. However, you may change the project’s scheduling and run Autoschedule after removing the dependency.

Here are a few things to keep in mind when removing external dependencies from a project:

- You cannot delete dependencies in a CPM network view.
- If you delete an external task from its originating project, which is an external dependency in a sub-project, the external dependency is removed from all of its related task records in all other projects.

Removing internal dependency relationships

Removing an internal dependency does not delete the predecessor or successor tasks from a project.

To remove a dependency relationship between tasks in a project:

1. Open the Dependencies tab of the Task Properties dialog box.
2. Select the dependent task from the Project Tasks list, and then click Delete.

Removing external dependency relationships

When you delete an external dependency from a project it is not deleted from its originating project.

To delete an external dependency:

1. In a spreadsheet, select the external dependency’s header button.
2. From the Edit menu, choose Delete.

Saving Projects with External Dependencies

When you save a project a copy of the external dependency data is also automatically added to the file. Remember that when you make changes to a task which impacts an external dependency, it is not updated in the project on which the task is dependent.
Printing a List of Dependencies

You can print a list of all dependencies associated with a project. The procedures for doing so are different for internal and external dependencies.

Printing from a CPM network and a spreadsheet view

To print a list of dependency relationships from a CPM network:

1. Display the project in a CPM network, in a spreadsheet view that displays a Gantt chart or in a spreadsheet view that displays dependency relationships.
2. From the File menu, choose from a combination of print preview, page setup, and printing options. For more information, see “Printing” on page 21. When printing a CPM network or spreadsheet view, you are advised to preview the print job so that you can see if you need to make adjustments to the page and printer settings.
3. When you have finished setting printing properties, from the File menu, choose Print.

Printing from the External Dependencies dialog box

Use the Print command button in the External Dependencies dialog box to print a list of external dependencies.

To print a list of external dependencies:

1. Select a task.
2. From the Tools menu, choose External Dependencies. The External Dependencies dialog box appears.
3. Click Print. The Print dialog box appears.
4. Use this dialog box to specify special printer settings.
5. Click OK to print. For more information on printing, page setup, and printer setup options, see “Printing” on page 21.
Working with Multiple Projects

Working with Dependencies
8 Resource Properties

In this chapter:
- "Overview" on page 204
- "Working with Resource Properties" on page 205
- "Multiple Selections" on page 213
- "Transferring Resource Assignments" on page 216
Overview

Resources provide the necessary people to ensure that the project is completed on time. You can assign resources to tasks in your projects and edit some of their properties. This chapter describes how to define the resources used in your project. It also discusses how to transfer assignments between resources.
Working with Resource Properties

You can set resource properties to meet the specific needs of your project. In addition to individually editing resource properties, you can select multiple resources and use one dialog box to edit the properties that they have in common.

This is done using the Resource Properties—Multiple Selections dialog box. For more information about simultaneously editing and assigning multiple resource properties, see "Multiple Selections" on page 213. Resource properties are typically defined and edited in the Resource Properties dialog box. You can open this dialog box from any view that displays resource-specific field names or displays a resource detail pane.

To open the Resource Properties dialog box:

- From the resource detail pane, double-click a resource’s header button.

In this section:

- "Using the General Tab" on page 206
- "Using the Advanced Tab" on page 208
- "Using the Calendar Tab" on page 209
- "Using the Notes Tab" on page 210
Using the General Tab

Use the General tab of the Resource Properties dialog box to create and edit general resource properties. Additionally, use this tab to define resource availability and billing information.

Entering and editing general resource properties

To enter or edit general resource information:

- Complete the following data on the General tab:
  - **Name**, enter a resource name.
  - **Category**, assign a category to the resource. Use categories to select and filter different groups and classes of resources in the view.
  - **ID**, assign a unique ID to the resource. You can enter any combination of letters and numbers.
  - **Rate**, enter the rate used per the resource’s unit of measure defined in step 5. You can define rates in terms of hours or days. Open Workbench supports a Billing Rate greater than zero.
  - **Type**, use this drop-down list to choose the type of resource. (There are four choices: Labor, Expense, Materials, and Equipment.)
  - **Availability**, enter the general resource availability. Availability can be per day, per hour, or a percentage of a full day. For more information on resource availability, see "Resource availability" below.
  - **From**, enter the first date when the resource will be available to work on tasks.
  - **To**, enter the last date when the resource will be available to work on tasks.
Resource availability

Availability is the amount of time that a resource can be allocated to a project. Open Workbench expresses resource availability as total work capacity per unit of time (for example, 8 hours per day). You can show availability for staff resources in hours per day, days per week, or a percent of a day.

When you define resource availability, it applies to all time periods except those explicitly specified to be different. If you assign usage to a resource which exceeds the resources availability for a specific time period, the resource becomes overcommitted. The following field names are specifically related to resource availability. You can use them in the definition of any spreadsheet view.

- Availability
- Unused Availability
- Each Available
- Availability Units
- Variable Availability?

When you use the Availability field name, it measures the total availability for a resource. For example, if a resource consists of 3 staff members, each available 8 hours per day, the availability for the resource is 24 hours per day. Resource availability can also vary by time period, depending on how you define the resource’s calendar. For more information on defining resource calendars, see “Using the Calendar Tab” on page 209.

The Each Available field name measures the default availability for each member of a resource team. If the resource team consists of only one staff member, then Availability and Each Available are equal, if the resource does not have variable availability. Availability Units is used to define how the resource’s usage is measured. Available units include Daily, Weekly, and Percent.

A resource’s availability can vary during a project. Any resource that has scheduled holidays (other than weekends) or vacations has variable availability. You can change the availability for a resource for any given period. For example, a resource might be available 8 hours per day for 20 days, and for the next 10 days you can change a resource’s periodic availability using the Availability field names in a view, or by scheduling holidays in the resource’s calendar.
Using the Advanced Tab

Use the Advanced tab of the Resource Properties dialog box to enter advanced resource management details. This tab displays a Fields grid with the following two columns:

- **Field**, displays a list of advanced resource properties you can specify
- **Value**, assign values to fields

![Resource Properties - Andy Julien](image)

**Note:** Depending on the resource, some values on the Advanced tab may be read-only.

To see descriptions of the fields appearing in the Field column:

1. Click Help.
2. Use online Open Workbench Help to follow the links that lead you to the field name descriptions.

**Entering and editing advanced properties**

To enter or edit advanced properties in the Field column:

- Click cells in the Value column and enter values for the corresponding fields.
  (What you can enter in this column depends on the corresponding field names.)

There are four ways to enter values for fields:

- Select displayed check boxes.
- Enter numeric values, currency, or dates.
- Enter words or phrases.
- Choose options from drop-down lists.
Using the Calendar Tab

Each resource has a unique calendar. Use the Calendar tab of the Resource Properties dialog box to modify the resource’s work week schedule, and to assign vacations, holidays, or other periods of zero availability.

![Calendar Tab Image]

Defining and editing resource calendars

To define and edit resource calendars:

2. From the Based On drop-down list, choose the calendar on which you want to base the resource’s calendar. The base calendar is a starting calendar that you can modify to meet a resource’s specific schedule.

To change the base calendar and make it resource-specific:

1. Select dates on the calendar that are workdays and click Workdays. Alternately, click a day title such as Monday, and then click Workday. All Mondays during the month are marked as workdays.
2. Select dates on the calendar that are holidays or vacation days, and click Holiday.
Resetting resource calendars

You can reset the status of individual workdays, holidays, or the entire resource calendar back to the base calendar settings.

To reset workdays and holidays to the base calendar settings:

1. Open the resource’s calendar.
2. Select the workday or holiday, and click Reset.

To change the entire resource calendar back to the base calendar settings:

⇒ Click Reset All.

Using the Notes Tab

Use the Notes tab of the Resource Properties dialog box in Open Workbench to communicate resource-specific information to other staff members, or to create notes for yourself. When you create resource-specific notes, you can also view them. Additionally, you can categorize notes and see historical information.

Creating notes

When you create a note, it appears as the last item on the History grid.

To create a resource-specific note:

1. Open the Notes tab of the Resource Properties dialog box.
2. Enter a note in the text field.
3. From the Category drop-down box, either choose an existing note category or enter a new note category name.

Warning: If you add a note category, you should also have a Global Files location specified on the Locations tab of the Options dialog box. Otherwise, categories you add will not be saved.
4 Click Add.
**Resource Properties**

*Working with Resource Properties*

### Reviewing and editing notes

To review a note:

1. Open the Notes tab of the Resource Properties dialog box.
2. In the History grid, select a note. The note appears in the text box.
3. Repeat Step 1 for every note you want to review.

To edit a note:

1. In the History grid, select a note. The note text appears in the Notes text box.
2. Edit the text of the note, and then click Modify.

### Deleting notes

To delete a note:

- Open the Notes tab of the Resource Properties dialog box.
- In the History grid, select a note. The note appears in the text box.
- Click Delete.
Multiple Selections

In this section:
- "Selecting Multiple Resources" on page 213
- "Using the General Tab" on page 214
- "Using the Advanced Tab" on page 214
- "Using the Notes Tab" on page 215

The multiple selection feature in Open Workbench provides an easy way to assign or change properties for many resources at once, without opening the Resource Properties dialog box for each resource. To edit multiple resource properties simultaneously, use the Resource Properties—Multiple Selections dialog box.

The Resource Properties—Multiple Selections dialog box has features similar to the Resource Properties dialog box, but its impact on resources is different. This dialog box is only accessible from spreadsheet views that display a resource detail section and cannot be opened from CPM network views.

Rules for entering and changing data in the Resource Properties—Multiple Selections dialog box include:
- Dialog box elements display data when the data is the same for all selected resources.
- Blank dialog box elements indicate that the data varies for each resource. In cases where you can enter data, all selected resources are updated to reflect the entry.
- Some check boxes appear disabled and selected if the resources have different settings. In some cases, you can select check boxes and change the value for all selected resources. Otherwise, ignore the check boxes so that resources retain their original settings.
- Some groups of options may appear disabled, but if you can select them you reset those attributes for all of the selected resources.
- The Calendar tab is noneditable and does not appear in the Resource Properties—Multiple Selections dialog box.
- In most cases, dialog box elements that you cannot change are disabled.
- Drop-down lists will display choices that are valid for all resources. If a valid choice does not exist, the list is disabled.

Selecting Multiple Resources

Before you can open the Resource Properties—Multiple Selections dialog box, you must open a spreadsheet view that displays resource details and select more than one resource.

To select multiple resources:

1. Select the resources you want to edit. To do this, do one of the following:
Resource Properties
Multiple Selections

- To select a contiguous range of resources, select the first resource in the range, and then press and hold the Shift key and select the last resource in the range.
- To select a noncontiguous range of resources, select one resource in the view, and then press and hold the Ctrl key and select the other resources.

2. Open the Resource Properties—Multiple Selections dialog box by right-clicking one of the selected resources and choosing Modify from the shortcut menu. The Resource Properties—Multiple Selections dialog box appears.

Using the General Tab

Changes you make on this tab, affect all selected resources. If you do not make changes or entries in blank dialog box elements, the properties for each resource remain unchanged. However if you do enter data, that property changes for all of the selected resources. For specific information on entering data on this tab, see the steps for entering data on the General tab of the Resource Properties dialog box on page 206. The following information is valid when editing data for multiple resources:

<table>
<thead>
<tr>
<th>Specific Field</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ext. ID text box</td>
<td>If you enter an external ID, the first resource assumes the value you enter, and each subsequent ID is appended with unique incremental numbering. For example, if you enter ENGR, the first resource will have ENGR as its external ID, and subsequent resource external IDs might be appended with ENGR-0, ENGR-1, ENGR-2, etc. Note: After you enter a value, this text box still appears blank, since each resource will still have a unique ID.</td>
</tr>
</tbody>
</table>

Using the Advanced Tab

In addition to editing common advanced information on this tab, you can enter advanced information that you want to make common to all of the selected resources.

When all of the selected resources have common values, those values appear in the Fields grid. Values you enter in blank cells on this grid become common to all of the selected resources. Do not enter data in blank fields if you want the resources to retain their original values. Cells on the Fields grid are disabled if you cannot enter a common value for all of the resources or if the field is noneditable.

For specific information on entering data on this tab, see the steps for entering data on the Advanced tab of the Resource Properties dialog box on page 208.
Using the Notes Tab

Notes that are identical in category, text, author, created time, modified by, and modified time for all selected resources appear on the History grid on this tab. The History grid is blank when there is no commonality between the resource notes.

Any changes you make to existing notes, or any new notes that you create, apply to all selected resources.

For specific information on using this tab, see the steps for entering data on the Notes tab of the Resource Properties dialog box on page 210.
Transferring Resource Assignments

When you have resources in your project, you can easily transfer assignments between resources. Important information to remember when transferring assignments includes:

- You cannot transfer completed assignments and they do not display during the assignment transfer process. Only current assignments are transferable.
- Existing actuals are not transferred between resources. If an assignment has recorded actuals, only the remaining portion of the assignment is transferred.
- If an assignment with actuals is transferred, the assignment start date for the “transfer to” resource is the next date after the last actual was entered. ETC is also transferred. However, the finish date for the assignment does not change.
- If tasks have duplicate names, a tooltip appears that displays task ancestry.

Transferring Assignments

To transfer assignments:

1. From the Tools menu, choose Transfer Assignments. The Transfer Assignments dialog box appears.
2. In the Transfer Assignments From This Resource list, select the resource to transfer from. The left grid displays all of the resource’s assignments.
3. From the To This Resource list, select the resource to which you are transferring assignments.
4. To maintain the current baselining, select Keep Baseline.
5. From the left grid, do one of the following:
   - Select assignments and click the right-arrow to assign them to the new resource.
   - Click All > to transfer all displayed assignments to the new resource in the right grid.

Use the left arrow and All < to transfer assignments from the right grid to the left grid. The project must have at least one assignment and two similar resources to enable the command.
9 Scheduling Projects

In this chapter:
- "Overview" on page 218
- "Developing Schedules" on page 219
- "Scheduling Process" on page 220
- "Locking Tasks in Place" on page 221
- "Setting Resource Loading Patterns" on page 222
- "Recalculating Task Duration" on page 226
- "Using Autoschedule" on page 227
- "Baselining Projects" on page 232
Overview

When you finish creating a project plan and dependency relationships, you are ready to schedule tasks and the resources that work on tasks. If your project is large, scheduling can be a complex process that balances task relationships, resource availability, and task duration.

Because scheduling is an iterative process, it usually takes several steps to balance resources working on a project. This means that you may need to make several adjustments to your project plans. Adjustments can include changing resource availability, adjusting dependency links, and adding tasks.

To ease the burden of scheduling projects, Open Workbench uses an automated scheduling process called Autoschedule. Autoschedule is discussed in more detail on page 227.
Developing Schedules

Following are some steps that you might use to develop a realistic schedule:

1. Adjust resource calendars, indicating work days and holidays for each resource. For more information, see “Using the Calendar Tab” on page 209.

2. Autoschedule the project without constraints on resource availability. Resource availability is defined by entries in the From and To text boxes on the General tab of the Resource Properties dialog box. For more information on using this dialog box, see “Using the General Tab” on page 206.

3. Autoschedule the project again with constraints on resource availability to eliminate resource overcommitment.

4. Prioritize phases, activities, and tasks.

5. Recalculate the duration of inherently overcommitted tasks, keeping in mind that you cannot recalculate the duration of tasks with fixed resource assignments. For more information, see “Recalculating Task Duration” on page 226.

6. Lock tasks that you do not want rescheduled. For more information, see “Locking Tasks in Place” on page 221.

7. Refine your use of resource loading patterns. For more information, see “Using the Resources Tab” on page 152, and “Setting Resource Loading Patterns” on page 222.

8. Adjust task priority. For information on how Autoschedule handles task priority, see “Autoschedule Priorities” on page 229.

9. Autoschedule the project again with constraints to resource availability.

10. If needed, perform one or more of the following steps, and then Autoschedule the project again:
   - Shift tasks in views using Gantt charts to manually adjust the schedule. For more information, see “Shifting Tasks” on page 175.
   - Refine dependency relationships. For more information, see “Working with Dependencies” on page 188.
Scheduling Process

There are several scheduling techniques you can use in Open Workbench. The scheduling process involves the following steps:

1. Determine one of the following:
   - the minimum length of time required to complete each task (task duration)
   - the resource usage on each task (used by Open Workbench to automatically determine durations)

2. Determine the estimate to complete (ETC) for each resource.

3. Determine each task’s resource loading pattern from one of the available loading patterns.
   
   Resource loading patterns define how resource assignments are treated by the Recalculate and Autoschedule functions.

   For more information on resource loading patterns, see “Using the Resources Tab” on page 152, and “Setting Resource Loading Patterns” on page 222.

4. From the Tools menu, choose Autoschedule then, follow the steps in “Defining Autoschedule Parameters” on page 230.
Locking Tasks in Place

You may want to lock certain tasks in place to prevent automatic scheduling functions such as Recalculate or Autoschedule from changing them. However, even if a task is locked, you can shift its start date, finish date, or both dates in views that display a Gantt chart.

Only tasks and milestones can be locked.

You can lock tasks on the Advanced tab of the Task Properties dialog box.

To lock a task:

1. Double-click the task’s header button to open the Task Properties dialog box.
2. Click Advanced. The Advanced tab appears:

![Task Properties Dialog Box]

3. Scroll down the Fields list and select the Locked for Scheduling check box.
Setting Resource Loading Patterns

You can assign resources to tasks using any of five loading patterns: Uniform, Contour, Fixed, Front, or Back. When you use these loading patterns in conjunction with Autoschedule, you can automatically produce a workable schedule that allows for real-world variations in the way work is assigned and completed.

You set loading patterns for each resource assigned to a task on the Resources tab of the Task Properties dialog box. For more information on how to use resource loading patterns, see “Using the Resources Tab” on page 152.

In this section:
- "Uniform Loading" on page 222
- "Front Loading" on page 222
- "Back Loading" on page 223
- "Fixed Loading" on page 223
- "Contour Loading" on page 224

Uniform Loading

The Uniform loading pattern assigns resource time evenly across a task only on those days when the resource is available to meet the task requirements. For example, if a resource is scheduled to work four hours per day on a task, the resource will not be scheduled to work on that task on days when it is only available to work on the task for three hours.

This pattern depends on the Max % set on the Resources tab of the Task Properties dialog box as well as on the resource’s availability. Graphically, the Uniform loading pattern can look like this:

![Uniform Loading Graph]

Front Loading

The Front loading pattern allocates resource usage as early in the task as possible. Resources are assigned to get work done as early as their availability permits.
This pattern depends on the Max % set on the Resources tab of the Task Properties dialog box as well as on the resource’s availability. Graphically, the Front loading pattern can look like this:

### Back Loading

The Back loading pattern allocates resource usage as late as possible in the task. Resources are assigned to get work done as late as their availability permits.

This pattern depends on the Max % set on the Resources tab of the Task Properties dialog box as well as on the resource’s availability. Graphically, the Back loading pattern can look like this:

### Fixed Loading

Use this pattern to allocate resource usage to meet your specifications. Resources are assigned to tasks according to your needs. Open Workbench automatically locks fixed resource assignments so that they are not changed when you use the Autoschedule and Recalculate features.
When using Fixed loading, you can create a discontinuous task, or one that starts and stops, and then starts again. You can display the pattern in views where estimate to complete is tabulated.

To view discontinuous tasks on a Gantt chart, select the Discontinuous check box in the Formatting Options dialog box. For more information, see “Creating and Editing Gantt Chart Layout” on page 109.

Graphically, the Fixed loading pattern can look like this:

![Fixed loading pattern diagram]

**Contour Loading**

This pattern fits resource loading around the resource's remaining availability, smoothing out the “peaks” and “valleys.” It is very flexible, because it can appear as the reverse or mirror image of overlapping task patterns.

If a task’s duration, start date, or finish date changes, or if you autoschedule the task, or enter new estimate to complete values, this pattern assumes the characteristics of the Uniform loading pattern.

Changes made to the duration of a task after it is scheduled cause resource assignments for each period to even out across the duration of the task.

Graphically, the Contour loading pattern can look like this:
Scheduling Projects
Setting Resource Loading Patterns

Using Open Workbench
Recalculating Task Duration

Use the Recalculate feature to compute the shortest duration possible for selected tasks. This feature recalculates duration according to resource availability and Max % load to eliminate resource overcommitment for each task. It also maximizes resource use to shorten task duration whenever possible.

Recalculate uses estimate to complete, total resource availability, and maximum percent loading to maximize resource use and avoid resource overcommitment.

If a task is inherently overcommitted, Recalculate may extend its duration to eliminate overcommitment for that period. The exception to this is when the task has fixed resource assignments.

How Recalculate Works

Recalculate uses total resource availability, Max %, and total usage to compute duration. It maximizes resource loading and minimizes the duration of tasks. It may lengthen tasks to eliminate any inherent overcommitment of resources.

Example 1: Resource availability is 8 hours per day and Max % is 50% (the resource can work on this task 4 hours per day). If usage is 12 days, Recalculate calculates the duration to be 24 business days.

Example 2: Resource availability is 4 hours per day and Max % is 50% (the resource can work on this task 2 hours per day). If usage is 12 days, Recalculate calculates the duration to be 48 days.

The mathematical calculation is as follows:

\[
\text{Duration} = \text{actuals} + \frac{\text{ETC}}{(\text{resource availability per day})} \times (\text{max % availability per day})
\]

When you assign multiple resources to a task, Recalculate computes the duration for each resource separately and selects the longest duration to determine the duration of the task.

Recalculate modifies all uncompleted tasks in the selected range, but does not adjust Fixed loading patterns. It also modifies the estimate to complete if actual usage has been recorded for a task.

Contour loading patterns are recalculated as Uniform. Recalculate also replaces patterns created by Autoschedule, and computes duration based on total availability per task.

Recalculate does not impact tasks that are locked or completed for scheduling. Instead, it modifies only the uncompleted portion of the task if the task has an estimate to complete.

To recalculate the duration of a selected task:

1. Select one or more tasks from the current view.
2. From the Tools menu, choose Recalculate.
Using Autoschedule

In this section:

- "Scheduling From a Start Date" on page 228
- "Scheduling From a Finish Date" on page 228
- "Task and Resource Constraints" on page 228
- "Autoschedule Priorities" on page 229
- "Defining Autoschedule Parameters" on page 230

Autoschedule is a powerful, automated way to create project schedules. Tasks are scheduled either sequentially as they appear in the Work Breakdown Structure (WBS), or in order of priority. Each task is scheduled to start at the earliest or latest possible time, subject to constraints. Before scheduling, Autoschedule automatically calculates the project’s critical path.

Autoschedule uses an internal set of rules to create a schedule that takes task constraints, dependencies, priority, and optionally, resource constraints into account. By default, Autoschedule operates on the entire project, but does not change tasks that meet the following conditions:

- tasks starting earlier than the date in the Ignore Before text box in the Autoschedule dialog box
- tasks starting later than the date in the Ignore After text box in the Autoschedule dialog box
- tasks marked as Locked or Completed
- tasks that have actuals, except for the time period between the last actuals thru date and the finish date

Autoschedule performs three passes of the project to create a schedule that satisfies all dependencies and does not overallocate selected resources. Each includes a forward pass and a backward pass.

To develop a schedule, the following three passes are performed whether you schedule from the project start or finish date

- During the first pass, Autoschedule creates a baseline schedule and performs a priority sort to resolve potential scheduling conflicts.
- During the second pass, the schedule is created. When Autoschedule considers resource constraints, Autoschedule first makes a pre-pass.
- During the third pass, Autoschedule recalculates the critical path based on the schedule developed in the second pass.

Note: It is possible to set dependencies, constraints, and resource availability so that it is impossible for Autoschedule to produce a schedule free of dependency violations or resource over allocations.
Scheduling From a Start Date

When you schedule a project from its start date, Autoschedule attempts to schedule all tasks in the project to start as early as possible. To do this, it:

- calculates the early start and early finish.
- moves the early start forward.
- checks for Fixed loading pattern assignments and adjusts the early start or early finish to make sure that Fixed assignments are within the date range of the project.

Scheduling From a Finish Date

When you choose to schedule your project based on its finish date, Autoschedule performs three traversals of the project, but in the second and third traversals it goes over the tasks backward first and enforces finish constraints over start constraints so that the project is scheduled to start as late as possible. When you run Autoschedule using a project’s finish date, it:

- calculates the late finish and the late start.
- moves the late finish forward.
- checks for any Fixed loading pattern assignments and adjusts the late start or late finish to make sure the Fixed assignments are within the date range of the project.

Task and Resource Constraints

The planning process requires establishing and fine-tuning task durations for all tasks in the project to obtain an acceptable total project duration. Open Workbench lets you create tasks with either fixed or variable durations, sometimes referred to as “time-constrained” and “resource-constrained” tasks, respectively.

These two types of constraints are handled differently by Autoschedule:

- If a task is time-constrained (that is, it must finish in a specific amount of time), you specify its duration and indicate that it is a fixed task on the General tab of the Task Properties dialog box.
- If a task is resource-constrained (that is, its duration depends on the availability of its resources), you specify only resource availability on the General tab of the Resource Properties dialog box and indicate that the task has variable duration on the General tab of the Task Properties dialog box. In this case, when you Autoschedule, Open Workbench adjusts the duration of the task to make best use of the available resources.

Note: Unless you need to define a specific duration for a task, set the duration to Variable. This option typically results in a tighter schedule and shorter projects.
Task scheduling constraints

You can set other task scheduling constraints that impact Autoschedule on the Advanced tab of the Task Properties dialog box. These scheduling constraints can override priority during Autoschedule but cannot override tasks that are locked for scheduling. Scheduling constraints that you can specify for tasks include:

<table>
<thead>
<tr>
<th>Constraint</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Must Start On</td>
<td>Schedule the task to start exactly on the date in the Time column. This selection overrides the Start No Earlier Than and Start No Later Than constraints.</td>
</tr>
<tr>
<td>Start No Earlier Than</td>
<td>Schedule the task to start no earlier than a specified date.</td>
</tr>
<tr>
<td>Start No Later Than</td>
<td>Schedule the task to start no later than a specified date.</td>
</tr>
<tr>
<td>Must Finish On</td>
<td>Schedule the task to finish exactly on the date in the Time column. This constraint overrides the Finish No Later Than and Finish No Earlier Than constraints.</td>
</tr>
<tr>
<td>Finish No Earlier Than</td>
<td>Schedule the task to finish no earlier than the specified date.</td>
</tr>
<tr>
<td>Finish No Later Than</td>
<td>Schedule the task to finish no later than the specified date.</td>
</tr>
</tbody>
</table>

When choosing constraints, the Start constraint indicates the task starts at the beginning of the work day, and the End constraint indicates that the task ends at the end of the work day.

For more information on constraint rules, and how to enter and edit task constraints, see “Using the Advanced Tab” on page 161.

Autoschedule Priorities

Priority controls the order in which Autoschedule schedules tasks. Tasks are scheduled first by priority, scheduling higher priority tasks before lower priority tasks (subject to dependencies and task and resource constraints).

If you don’t specify a task’s priority, Autoschedule uses the priority of its parent task. If a parent task has no priority level, Autoschedule uses the priority from the next highest WBS level. If no priority is defined, Autoschedule uses the default value, 10.

You can enter task priority or priority inheritance on the General tab of the Task Properties dialog box.
Scheduling Projects
Using Autoschedule

Autoschedule schedules task priority as follows:

<table>
<thead>
<tr>
<th>Signifier</th>
<th>Priority Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Highest</td>
<td>Numbers 0 through 9</td>
</tr>
<tr>
<td>Default</td>
<td>10</td>
</tr>
<tr>
<td>Lowest</td>
<td>Numbers 11 through 36</td>
</tr>
</tbody>
</table>

In the case of dependencies, Autoschedule assumes that a predecessor task has a priority at least equal to its successor. In some cases, dependency relationships override individual task priority during the scheduling process.

When you Autoschedule, tasks are scheduled to minimize the duration of the critical path, and to use availability as early in the project as possible.

Defining Autoschedule Parameters

To define Autoschedule parameters:

1. From the Tools menu, choose Autoschedule. The Autoschedule dialog box appears.

2. Do one of the following:
   - To schedule from a start date, enter the date in the Start Date field. The date you enter is the date on or after which you want to begin scheduling tasks. Make sure the Schedule from Finish Date field is cleared.
   - To schedule from a finish date, select the Schedule from Finish Date check box and enter the date in the Finish Date field. The date you enter is the date on or before which you want to begin scheduling tasks.

The Finish Date field is only displayed if you select the Schedule from Finish Date check box.

**Warning:** Task start dates are changed to the date you enter, except in the following cases:

- The task’s Status is ‘Started’ or ‘Completed’.
- The task has a ‘Must Start On’ constraint.
• The task is marked as Locked for Scheduling.
• The task has resource assignments with fixed loading patterns before the entered start date.

3 In the Ignore Tasks Starting Before text box, enter a date if you want Autoschedule to bypass tasks that start before the date you enter.

4 In the Ignore Tasks Starting After text box, enter a date if you want Autoschedule to bypass tasks that start after the date you enter.

5 Select the Resource Constraints check box if you want Autoschedule to take resource availability into account when scheduling the project.

   Note: If you clear the Resource Constraints check box, Autoschedule treats resources as if they had unlimited availability. Each task is scheduled against the resources total availability, not against the resources remaining availability which takes other task assignments into consideration. This results in the shortest possible schedule, but it may also cause resources to be overcommitted.

6 Click OK to schedule the project.
Baselining Projects

In this section:

- "Baselines and Earned Value Computations" on page 232
- "Defining Baseline Settings" on page 232
- "Displaying Baseline Data and Clearing Baseline Display" on page 233

Use the Baseline feature to evaluate a project and compare it to an approved plan. Baselining preserves a version of the plan that does not change as work on the project progresses, unless you baseline the project again.

You can baseline one task, a selected range of tasks, all tasks in a view, or all tasks in an entire project. When you create a baseline you preserve information such as start dates, finish dates, and durations from that moment in time. You can then compare the current plan with the baseline plan to determine if the project is proceeding as expected.

Each time you use the Baseline feature, you replace the previous baseline with information from the current plan.

The appropriate time to baseline a task or resource assignment data is after the plan for a task has been approved by management and before the task has started. If the plan goes through several review cycles, and management approves a new basis for measurement, you can baseline the task again. When this is the case, you are asked to confirm that you want to overwrite the prior version of the baseline data with the new version.

Baselines and Earned Value Computations

Baseline information is a factor in many calculations performed in Earned Value Analysis.

The Earned Value fields available in Open Workbench provide a means to track work performance to account for cost and schedule variances. For example, Open Workbench computes Budgeted Cost of Work Scheduled (BCWS) using the following formula:

\[ BCWS = \text{cumulative baseline usage from the start date through the Project as-of date} \times \text{(the resource billing rate)} \]

If there is no baseline, there can be no date or estimate at completion variances.

Defining Baseline Settings

Before baselining a project, you choose the scope of the baseline in the Baseline dialog box.

To open the Baseline dialog box:

👉 From the Tools menu, choose Baseline. The Baseline dialog box appears.
To set a baseline:

1. Click one of the following option buttons from the Scope group:

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Project</strong> Baseline all tasks in the project.</td>
</tr>
<tr>
<td><strong>View</strong> Baseline all tasks in the active view. For example, if you filter a view to display a subset of tasks, only tasks displayed in the view are baselined.</td>
</tr>
<tr>
<td><strong>Selected Task(s)</strong> Baseline only the tasks you selected from the view. <strong>Note:</strong> You must select project tasks in the view before clicking this option button.</td>
</tr>
</tbody>
</table>

2. Click one of the following option buttons from the Baseline Settings group, then click OK:
   - Click Set to set project, view, or task-specific baseline information.
   - Click Clear to clear a baseline.

### Displaying Baseline Data and Clearing Baseline Display

When you display baseline data special markers on Gantt bars indicate the baseline information, to differentiate the baseline information from the current schedule.

The lines, colors, and markers used to differentiate baseline data are formatted in the View Highlights dialog box. For instructions on using this dialog box, see “Highlighting Project Information” on page 100.

### Displaying baseline data

To display a baseline:

1. Double-click the Gantt chart. The Gantt dialog box appears.
2. In the Gantt Bars group, select the Baseline check box. When you click OK, the baseline markers appear next to the Gantt bars on the Gantt chart.
Clearing baseline display

To remove the display of baseline data:

1. Double-click the Gantt chart. The Gantt dialog box appears.

2. In the Gantt Bars group, de-select the Baseline check box.
10 Tracking and Analysis

In this chapter:
- “Overview” on page 236
- “Tracking Methods” on page 237
- “Entering and Editing Actuals” on page 239
- “Tracking Projects by Task Status” on page 242
- “Analyzing Projects” on page 244
Overview

Tracking is the process for measuring project status and comparing it to the project plan to identify variances and take corrective actions. This process is repeated over the course of a project, allowing you to control and monitor project progress and cost. You can also use tracking information to generate project status reports. Tracking consists of reviewing information on actuals, such as the actual start and finish dates, the actual duration of tasks, the actual time worked by resources, and the actual cost of the project. Tracking also provides information about tasks in progress and those that have been completed.

To ensure efficient monitoring of a project, make the lowest level of the Work Breakdown Structure (WBS) represent small amounts of work. Use milestones to indicate significant events and mark progress. To closely monitor a project, you must be able to spot problems and trends that develop during the project’s life cycle in time to do something about them. Periodic evaluations of your project data can help you pinpoint problems as they arise, letting you initiate the necessary corrective actions to bring the project back on target. In instances where the word “analysis” is used, it signifies the review, examination, investigation, and evaluation of project data to:

- identify deviations
- determine causes of deviations
- determine the importance of deviations
- decide on corrective actions

Deviations are differences between expectations and actuality, including variances traditionally used by project managers to compare planned and actual performance. Open Workbench incorporates a number of field names that can be used in views to produce the analysis project managers need to track work performance, spot trouble areas, and account for cost and schedule variances.

The list of field names in the View Definition dialog box contains many calculated variance elements and performance indices, and several field names that can be used in an analysis to signal potential trouble (for example, “Critically Late?”). These field names are used in views to directly identify tasks with deviations.
Tracking Methods

Because projects vary in size and complexity, no single tracking method is appropriate for all projects. Open Workbench uses several methods to track the progress of a project. In designing a tracking system for your project, you should determine which tracking method is best suited to your needs.

The tracking methods you use depend on the size and complexity of the project. You can apply the method you choose to individual projects and those that have master project and sub-project relationships. Following are several methods you use to track projects in Open Workbench.

In this section:
- "Total Actual Usage" on page 237
- "Periodic Actual Usage" on page 237
- "Task Status" on page 237
- "Baselining to Track Project Progress" on page 238

Total Actual Usage

Tracking total actual usage provides a way to track projects based on actuals, pending actuals, and estimate to complete (ETC) entered in Open Workbench for each resource assigned to a task.

Periodic Actual Usage

Tracking periodic actual usage allows you to periodically enter resource actuals in tabulated views as well as ETC usage for each resource assigned to a task. For more information see “Tracking Periodic Actual Usage” on page 241.

Task Status

When tracking task status you monitor the status of tasks (Started, Not Started, or Completed), change start and finish dates, and enter percent complete values. Task status is set on the General tab of the Task Properties dialog box. For more information on tracking task status, see “Tracking Projects by Task Status” on page 242.
Baselining to Track Project Progress

By baselining your project at the completion of the planning phase and also later in the project, you can compare your estimate of what would happen in the project compared to what is actually happening. When you apply a Gantt chart view with markers that display baseline data, you can compare this information and you can quickly identify and correct possible problem areas.

Tracking progress on a Gantt chart

When you baseline a task or a selected group of tasks, you preserve information on start dates, finish dates and durations. You can then display the baseline data on a Gantt chart next to the current data. This provides you with a visual representation of where your project is versus where you thought it would be. For more information on baselining, see “Baselining Projects” on page 232.

To display baseline data on a Gantt chart next to the current data:

1. Double-click the Gantt section of the view. The Gantt dialog box appears.
2. Select the Baseline check box. Symbols that depict baseline start and finish dates appear under Gantt bars to indicate actual progress.
Entering and Editing Actuals

In this section:

- "Recording Total Actual Usage" on page 239
- "Entering and Editing Estimate to Complete" on page 240
- "Converting Actuals Back to ETC" on page 240

Recording Total Actual Usage

You can record periodic actual usage on the Resources tab of the Task Properties dialog box or by editing a view that has the Actual field name.

To record total actual usage in a view:

1. Select a task and click in the cell displaying total actual usage.
2. Enter the total actual usage for each applicable cell on the timescale.

   If you previously recorded periodic actual usage for a resource, you cannot change the total actual usage directly in a view.

To record total actual usage for resources:

1. Select a task and open the Task Properties dialog box.
2. Select the Resources tab.
3. Select a resource on the Assigned Resources grid.
4. For Estimate, enter the ETC usage.
5. For Actual, enter the cumulative actual usage.
6. For Act Thru, enter the last date through which actuals have been captured on the task for the resource.
The resource detail section of the view is updated to reflect actual usage for the resources.

**Entering and Editing Estimate to Complete**

To enter or edit ETC for resources:

1. Select a task and open the Task Properties dialog box.
2. Click Resources. The Resources tab appears.
3. In the Assigned Resources grid, select a cell in the Estimates column and enter a number representing the estimate.

**Converting Actuals Back to ETC**

You can remove actuals for a specific resource assigned to a task.

To remove actuals:

1. Open a view that includes the Actuals Thru Date field in its layout; or, a task properties, resources sheet, assigned resources grid.
2. Do one of the following:
   - Clear the date to remove all actuals.
   - Change the date to an earlier date to convert any actual usage that has been recorded after the date back to ETC usage.
Tracking Periodic Actual Usage

Periodic recording of resource usage for every task to which a resource is assigned is the most comprehensive and accurate way to keep track of your project. The actual usage is the timesheet recording method where the actual time each resource spends on a task is recorded at the end of a specific time period.

You can use the Gantt Chart view in Open Workbench to track resource usage for all tasks to which a single resource is assigned. Use this view to track usage data for one resource across an entire project or group. When you use this view in conjunction with the Quick Filter by Resource feature, you can display data for one resource at a time.

Quick Filter by Resource

The Quick Filter by Resource drop-down list appears on your tool bar and lets you filter a view by resource name. This drop-down list displays all resources in the project. Selecting a resource from the list changes data displayed in the view to show data pertinent to that resource. When tracking periodic actual usage, it is helpful to select the Resource LOA option button on the Description tab of the View Definition dialog box.

The Gantt Chart view also takes advantage of tabulated data elements that give running totals in the resource detail section at the bottom of the view. When a modification is made to a view that contains a tabulated data element, the view recalculates dynamically.
Tracking Projects by Task Status

Tracking task status is the easiest way to track a project, requiring only that you establish a periodic review cycle to update your project plan.

For small to medium sized projects, it may be enough to record only task status information. When a task has started, it is recorded in the Status drop-down list in the Task Properties dialog box, or in any view which includes status data. When a task is completed, you must change its status to Completed.

Additionally, when you Autoschedule a project, tasks that are marked with a Started or Completed status are unaffected by changes you make to the start date in the Start Date text box of the Autoschedule dialog box. For more information on Autoscheduling, see “Using Autoschedule” on page 227.

Updating Status

You can update the status of tasks in the Task Properties dialog box or by editing a view with the following data elements on its layout: Status, Start, Finish, Percent Complete.

Do not confuse Percent Complete with Percent Expended. Percent Expended is a calculated field that represents the percentage of resource usage expended on a task.

Because Percent Expended is calculated and can be more precise than Percent Complete (which is user-entered and limited to 2 decimal places), Earned Value calculations such as BCWP and the others listed above may produce different results depending on which Percent Complete value you select.

Updating Status in the Task Properties dialog box

To edit task status in the Task Properties dialog box:

1 Select a task and open the Task Properties dialog box.

2 On the General tab, choose a status from the Status drop-down list. (Available status includes: Started, Not Started, and Completed.)

3 If the task is partially completed, enter a percentage of completion in the % Complete text box. You can enter all of this information on the Fields grid of the Advanced tab in the Task Properties dialog box.
Updating status in views

If you add status field names to a view’s layout you can edit status data directly in the view. Task status that you can edit includes: Status, Start, Finish, and Percent Complete. You cannot enter or edit status directly in a CPM Network.

To enter or edit task status in a view:

1. Select a task and perform one or more of the following steps depending on the view’s layout:
   - If a Status column is displayed, choose a status from the drop-down list in the cell.
   - If a Start column is displayed, enter a start date in the cell.
   - If a Finish column is displayed, enter a finish date in the cell.
   - If a % Complete column is displayed and the task is partially completed, enter a percent complete for the task.
Analyzing Projects

Open Workbench lets you examine all or any part of your project at whatever level of detail needed. Analysis you may want to perform on a periodic basis include:

- Situational analysis - getting the summary of your project.
- Problem solving - what has gone wrong with the project, and why.
- Potential problem spotting - what might happen if?

What to Analyze, and When

Project analysis minimizes or eliminates surprises by providing early warnings of trends and situations in a project. In a sense, periodic evaluations of your project serve as checks of your project’s health.

The frequency and extent of your analysis is up to you. Analyze too frequently, and you quickly find you have little time for anything else. Analyze too infrequently, and problems may not be noticed early enough to avoid an impact on the overall project success.

Analysis is essentially a means of answering a business question regarding the project. The table below lists questions that can serve as guidelines for producing useful project “health checks.”

<table>
<thead>
<tr>
<th>What to Ask</th>
<th>When to Ask</th>
<th>Standard View to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is there enough information for each task?</td>
<td>During initial planning</td>
<td>Gantt Chart</td>
</tr>
<tr>
<td>What are the key resources?</td>
<td>While scheduling (or rescheduling)</td>
<td>Resource Assignment</td>
</tr>
<tr>
<td>What tasks are these resources working on?</td>
<td>While scheduling (or rescheduling)</td>
<td>Resource Assignment</td>
</tr>
<tr>
<td>Is everything on schedule?</td>
<td>Periodically during project life cycle</td>
<td>Variance Analysis</td>
</tr>
<tr>
<td>How did actual effort compare with plan?</td>
<td>Periodically throughout the project and when the project is finished</td>
<td>Variance Analysis</td>
</tr>
</tbody>
</table>
Validating Project Data

Before attempting to analyze project data, make sure that its quality is reliable. You can solve problems with the data by entering corrections directly in views. The data is valid when you are satisfied with your answers to the following questions.

Is the plan data complete?

How you intend to use the data determines how complete the data needs to be. If you want to use the plan to track and control the project, you need more detailed data than if you are simply sketching out a high-level proposal.

For project data to be complete:

- all phases, activities, tasks, and milestones should have deliverables.
- all tasks should have assigned resources.
- all task dependencies should be defined
- all tasks should have nonzero estimates.

Is the data up-to-date?

For accurate analysis, all data undergoing analysis should be correct and complete up to the same date. This means that:

- all tasks set to start or finish before the reference date have been tracked correctly.
- actuals have been entered for all resources up to the reference date.

Is the data consistent?

To be consistent, data should not contain:

- dependency violations (dependency links improperly set)
- overcommitted resources
Using Earned Value Variances for Analysis

The deviations between planned and actual performance in a project can be described mathematically as variances. In general, there are two types of variances to watch for. These are cost variances and schedule variances; both help you discern the differences between the baseline plan estimates and the actual project performance, and are expressed as actual values.

Open Workbench uses the cost and schedule variances to calculate a number of performance and percent complete indices. These indices provide a useful indication of the extent to which a project is ahead or behind cost or schedule. It is important to review these variances and indices throughout a project’s lifetime to monitor ongoing performance and pinpoint problem areas.

Data Required for Analysis

For optimal performance of Earned Value Analysis, there must be valid data throughout the system. The pertinent options are listed in the table below.

<table>
<thead>
<tr>
<th>Option</th>
<th>Dialog Box and Tab</th>
<th>Field Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>As-of date</td>
<td>Project Properties, Scheduling tab</td>
<td>As-of</td>
</tr>
<tr>
<td>Actual</td>
<td>Task Properties, Resources tab</td>
<td>Actual</td>
</tr>
<tr>
<td>Estimate</td>
<td>Task Properties, Resources tab</td>
<td>Estimate to Complete</td>
</tr>
<tr>
<td>Billing rate</td>
<td>Resource Properties, General tab</td>
<td>Billing Rate</td>
</tr>
<tr>
<td>% Complete</td>
<td>Task Properties, General tab</td>
<td>% Complete</td>
</tr>
</tbody>
</table>

You can combine these options in a single view for easy access, and to ensure the accuracy of the data.

Certain variance formulas compare current data against baseline data. If you have not preserved a baseline of task data, Open Workbench cannot compute these variances. For information on baselining your project, see “Baselining Projects” on page 232.
**Earned Value Field Names**

Open Workbench includes a number of field names containing the fundamental calculations used for Earned Value Analysis. These field names are available as discrete items for reporting purposes. Their greatest value is in their use as variables by other calculated field names to produce the variance values. Examples of Earned Value field names include Budgeted Cost of Work Scheduled (BCWS), Actual Cost of Work Performed (ACWP), and Estimate at Completion (EAC).

**Variance Analysis**

Variance field names are used to calculate the deviations between actual and planned performance. These fields automatically compare current plan data against the baseline to quantify cost and schedule variations. The variance analysis field names available in Open Workbench are Schedule Variance (SV), Cost Variance (CV), and Variance at Completion (VAC).

**Performance Indices**

Open Workbench uses variance field names to calculate a range of indices that provide a useful guide to evaluating project and resource performance. The performance indices available in Open Workbench are Schedule Performance Index (SPI), Cost Performance Index (CPI), and Schedule Variance Index (SVI).

**Percent Complete Indices**

Open Workbench uses the fundamental earned value field names against the Budget at Completion (BAC) to calculate the percent complete indices. These indices show BCWP, BCWS, and ACWP as a percent of the baseline budget. Periodic reviews of these measures can help uncover trends over time as the project progresses.

The percent complete indices available in Open Workbench are Performance Percent Complete, Schedule Percent Complete, and Actual Percent Spent.

Because % Expended is calculated and can be more precise than % Complete (which is user-entered and limited to 2 decimal places), Earned Value calculations such as BCWP and the others listed above may produce different results depending on which Percent Complete value you select.
A Managing Projects

Overview

A project is a set of interrelated tasks undertaken to achieve a specific goal. All projects have three underlying characteristic. They:

- have a start and a finish.
- use resources: people’s time/labor.
- contain an element of risk.

The project manager plans and controls project tasks. This key person organizes tasks, assigns resources, motivates staff, reports status to management, and works to complete projects on time and within budget.

Open Workbench is an effective tool that enables project managers to deal with the real world. To make maximum use of this powerful system, you should understand the underlying project management process. This appendix provides an introduction to project planning and control and suggests how Open Workbench can be used to make it all happen.

In this section:

- “Planning Process” on page 250
- “Planning Projects” on page 251
- “Controlling Projects” on page 256
Planning Process

Start your project plan with a rough idea, but be prepared to gradually add to the plan. It is a matter of continuous refinement as you cycle through steps in the planning process more than once. Each iteration should result in a clearer, more complete plan. Use this iterative approach to produce better plans with less effort.

The planning process is highly flexible. Some steps can be performed out of sequence; some can be skipped altogether. There are few absolute rules. Below are three examples of how you can diverge from the process outlined in this appendix.

- **Example 1:** You can define dependencies before you enter resource data or vice versa.
- **Example 2:** If you are planning a large number of small, unrelated projects where the relationships between projects are based on the use of common resources and not on dependencies, you can skip dependencies entirely.
- **Example 3:** In projects using subcontractors, you can ignore resources and manage strictly by the calendar.

Open Workbench has the flexibility to handle different planning approaches. The planning process consists of the following essential steps:

1. Review your organization’s established standards and guidelines for developing and managing project plans. Your Project Officer can assist you in understanding and implementing standards and guidelines.
2. Define the overall scope and objectives of your project and identify any constraints, such as a mandated finish date. Document your problem statement. You may want to include the problem statement in some of your reports to management.
3. Review your project calendar and other project parameters.
4. Enter authorizations such as project start and finish dates. If you do not enter some of this information, Open Workbench makes reasonable assumptions which you can change later.

Always document project assumptions as you create your plan. This documentation provides a basis for decision-making as the project progresses and the initial plan requires adjustment.
Planning Projects

The following guidelines show how to plan a project.

- “Establishing a Project Structure” on page 251
- “Defining Tasks” on page 252
- “Developing a Dependency Network” on page 252
- “Establishing the Project Staff” on page 252
- “Estimating Resource Usage and Task Duration” on page 253
- “Refining the Plan” on page 253
- “Scheduling Resources” on page 254
- “Getting Approval” on page 255
- “Reviewing the Plan with Project Participants” on page 255
- “Baselining the Plan” on page 255

Establishing a Project Structure

Planning is a top-down process. First, establish the overall project structure, or how the work breaks down into different hierarchical levels. To help you with this, Open Workbench provides a default four-level project structure that includes projects, phases, activities, and tasks/milestones. You can customize the number and names of Work Breakdown Structure (WBS) levels to match your organization’s methodology.

<table>
<thead>
<tr>
<th>WBS Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Projects</td>
<td>The total set of tasks needed to achieve a specific goal.</td>
</tr>
<tr>
<td>Phases</td>
<td>The major project components.</td>
</tr>
<tr>
<td>Activities</td>
<td>The phase components.</td>
</tr>
<tr>
<td>Task/Milestones</td>
<td>The smallest identifiable amount of work leading to a deliverable (a tangible product). Milestones are specific points in time with which to measure a project’s progress. (Equivalent to tasks of zero duration.)</td>
</tr>
</tbody>
</table>

In the earliest stages of planning, define the Phase and Activity levels of your project. Order your structure as well as possible, but do not worry about creating the perfect plan. It is easy to change the project structure later.

**Note:** Find shortcuts to help reduce your planning effort. For example, project templates (previously defined projects similar to the one you are planning) can be a good starting point.
Defining Tasks

Your next step should be to enter as much data as possible into Open Workbench at the Task level. This is the level where most of the action takes place.

Open Workbench excels at managing “unmanageable” data, so do not be concerned if some of your information is incomplete or vague. You will have plenty of time later to refine your plan.

If you cannot estimate resource usage (commonly called “work effort” for staff resources) yet, omit this information for now. Open Workbench will help get your project started by applying default values to your projects, such as task duration.

Enter data directly into Open Workbench. If the project contains many similar tasks, use the copy and paste functions to replicate tasks and save keystrokes.

Try to keep your task durations manageable. For example, consider applying a general rule that no task should be shorter than five days or last longer than 10 days.

Developing a Dependency Network

Define the logical sequence of tasks by creating a dependency network, indicating which tasks must be completed before others can begin. Use this feature to create practical schedules and to gain a greater understanding of your plan. You may need to add tasks you missed earlier.

Using Open Workbench, you can create several types of dependency relationships, along with dependency links that can have gaps and overlaps.

**Note:** You can enter information directly in Open Workbench without having to draw a first-cut network on paper. Set your dependency links using the CPM Network.

Save your project. Then, carefully analyze the tasks on the critical path to see if you can shorten the critical path, perhaps by introducing some overlaps between tasks or adding resources.

Establishing the Project Staff

The project staff can consist of actual people or generic roles that can be replaced later by people. A resource must be a member of your project staff in order to be assigned to a task or milestone.

Create resources for your project, define their properties, and then assign them to tasks.
Planning Projects

Estimating Resource Usage and Task Duration

At this point, estimate resource usage and task durations more thoroughly.

In Open Workbench you can load tasks with either fixed or variable durations, referred to as time-constrained and resource-constrained tasks, respectively. If a task is time-constrained, you specify its duration and it remains fixed throughout the project. If a task is resource-constrained, you specify resource usage and availability and Open Workbench dynamically adjusts duration as usage and availability change during the project.

The greater the level of detail, the better the estimate. If you can, create a high level of detail by stating assumptions, then check them as early as possible. For example, if you do not know how many days to allow for programming blocks of code, estimate the number of blocks and the time required per block.

Project slippage is more often caused by tasks that are omitted from the plan than by tasks that are badly underestimated. Ideally, assign one resource per task. If a particular effort requires more than one resource, break down the task to its components and assign resources to each.

Enter resource usage and time estimates at the task level. Open Workbench has a powerful resource loading facility through which you can assign resources to tasks using any of these loading patterns: uniform, contour, fixed, front, or back.

Unless you specifically need to define the duration of a task, leave it flexible. Variable duration tasks typically result in a tighter schedule and shorter project. Do not worry about assigning resources to tasks on a daily basis. You can assume front loading initially, then refine your plan later. If your project is primarily dependent on available resources, use Autoschedule to get a rough idea of the total project duration. This will not be accurate because you have not yet specified dependency links. Save your rough plan and print out the Gantt chart for review. For information on printing views, see “Printing” on page 21.

Refining the Plan

Now it is time to add tasks you missed earlier and to further define tasks to meet your minimum criteria, such as limiting resource usage to less than 10 days. You can also adjust the usage or duration of tasks already entered.

Try to assign resources to all tasks. Define the availability of each resource to the project. Do this in large-scale terms; do not be concerned with daily fluctuations.

Other useful tips are:

- Use the drag function to reposition a task elsewhere in your project structure, if appropriate.
- Save your project regularly.
- Autoschedule periodically to get an idea of total project duration.
Perform the steps listed above several times until you can specify the work to be done with enough Open Workbench and precision to move on to the next steps: refining dependency relationships and developing meaningful schedules. In complex projects consisting of 300 or more tasks, perform this loop at least four times.

**Scheduling Resources**

To develop a realistic schedule, you must balance resources, remove overloads, and further refine your plan. This is another highly iterative process. As you attempt to balance resources, you may find you need to constantly go back and change resource availability, adjust dependency links, and add tasks. Some useful tips to remember when scheduling include:

- **Do not schedule on the basis of a full working day.** Allow one or two hours each day for nonproject tasks and contingencies. Contingencies can include illness, staff turnover, special assignments, and lost time.

- **Avoid scheduling one person for too many overlapping tasks.** An inexperienced individual should work on one task at a time. While experienced individuals can perform multiple tasks simultaneously, do not schedule them for more than four concurrently.

- **Ask your project office to allow for vacations, holidays, sick days, and training.** (often accidentally overlooked). Take advantage of the individual resource calendars to help avoid this oversight.

- **Allow enough time for team communication: meetings, memoranda, etc.** Whenever possible, make these specific tasks or milestones in the plan.

- **Define milestones in each phase where project information can be consolidated for use by staff members, management, and clients.** Most plans will have such natural points where a number of key tasks come together.

- **Display spreadsheet views that use a Gantt chart and a CPM network simultaneously to help you see where adjustments might be necessary.**

When refining the plan, use the Autoschedule feature extensively, saving the project before each use.

First, Autoschedule without resource constraints. This produces a schedule that is based on the dependency network. Although this might overload resources, it will result in the shortest possible project duration (the project’s finish date will be based on the Critical Path). Then, Autoschedule with resource constraints. This method shows the impact of resources on the finish date. A comparison of the two schedules may indicate where some reallocation might shorten your project.

After the initial schedule is set, consider entering priorities for one or more phases, activities, or tasks. Priorities are a way of influencing Autoschedule to choose one task over another if the two tasks are considered to be equal based on their locations in the dependency network.

Constrain tasks you do not want rescheduled; for example, the fixed arrival date of certain equipment. Refine your assignment of loading patterns (uniform, front, back, contour, or fixed). This method reflects the real world and allows for the highly efficient autoscheduling of resources.
Front loading a resource-constrained task is designed to give you the most efficient resource use. Use this option wherever possible. Be careful in your use of fixed loading. This option takes a fair amount of your time to set up, as well as system time when Autoschedule is invoked. Use it very selectively.

**Getting Approval**

Your final schedule shows:
- phases, activities, and tasks to be performed
- milestones to be achieved
- resource usage and assignments for each task
- task start and finish dates
- resource use for the project

Now that you have created a plan, you might want to create some reports for managerial approval. First, print the Gantt chart, preferably on a laser printer for presentation-quality output. Keep in mind that you can preview your print job before you print it.

Repeat the process with other Open Workbench views you want to present. For information on printing views, see “Printing” on page 21.

**Reviewing the Plan with Project Participants**

Once your plan is approved, review it with your project staff and obtain their commitment toward implementing it. It is a good idea to involve your project staff in the preparation and review of the project before seeking management approval. Use Open Workbench to produce individual work schedules describing staff member responsibilities. You will probably want to give each person a work schedule showing his or her tasks for the total project, as well as a more detailed schedule showing tasks for, perhaps, one month ahead.

**Baselining the Plan**

Once all project stakeholders approve the project plan, set the baseline for part or all of your project. Baselines preserve your original plan data, giving you a basis for comparisons later when the project is underway.
Controlling Projects

The project is now underway and as project manager you must bring it to a successful conclusion. Unfortunately, the only thing you can be sure of is that your original plan will change. This is often due to the unexpected: late arrival of equipment, illness of key personnel, or technical difficulties. However, the most common causes of project slippage are incomplete plans and overly optimistic estimates.

The purpose of project control is to generate corrective actions to keep the project on schedule even when the inevitable or unexpected occurs. This helps you to maintain realistic goals, keep your plans current, and stay on course.

Project control is a feedback loop in which you compare actual results against the plan, assess the impact of any deviations to target dates and costs, and determine corrective actions. Proper control cannot be exercised without this feedback loop.

General Design Considerations

Before we discuss how to control your project, consider some general design issues in developing a control system tailored to your specific needs. Open Workbench offers you a wide variety of options for controlling projects, so you should select the ones most suitable for your environment. As you do this, keep in mind:

- Project managers typically spend 5% of their time planning and 95% controlling.
- No one gets promoted for producing a fine plan; only for completing a successful project.

Make sure you look ahead (instead of backward) in your tracking mechanism. For effective control, look forward to the next major milestone to determine the amount of work still outstanding, rather than simply comparing actual results against the baseline. The example that follows demonstrates the problem of relying too heavily on comparisons with baseline data.

Example: A week into a project, the tasks planned for that interval have been completed on schedule. However, two additional tasks have been identified that were not in the baseline. Looking back, the project is on schedule; looking forward, it has slipped behind.
Measuring Project Success

To determine which tracking method to use, you must first determine by which criteria success will be measured. The table below lists some common success criteria.

<table>
<thead>
<tr>
<th>Success Criteria</th>
<th>What to Track</th>
</tr>
</thead>
<tbody>
<tr>
<td>Meeting the deadline</td>
<td>Calendar time for completing a task</td>
</tr>
<tr>
<td>Staying within resource budget</td>
<td>Resource usage per task</td>
</tr>
<tr>
<td>Staying within cost budget</td>
<td>Cost per task</td>
</tr>
</tbody>
</table>

*Note:* In many situations, meeting the deadline assures success even if total costs exceed estimate.

Calendar time tracking is the simplest; resource and cost tracking the most comprehensive.

Using Open Workbench, you can use any combination of the above tracking methods to varying levels.

Project Relationships

It is not unusual for a project to be closely related to other projects underway concurrently in an organization. There are two types of interproject relationships: those based on dependency links between projects and those based on the sharing of common resources.

The Open Workbench multiple project handling feature can accommodate either type of interproject relationship. Examples in the following sections demonstrate the two types of interproject relationships.

Dependency links between projects

*Example:* Project 1 contains the task “Install Equipment Onsite.” Project 2 contains the task “Begin Using Equipment.” Project 2 is therefore dependent on Project 1.

Use of common resources

*Example:* A programmer is working on three projects simultaneously. The projects are therefore related via the common resource.

Identify the commonality between resources and tasks because they represent events outside your control that can cause significant slippage in your project.
Measuring Status

As discussed earlier, project control is a feedback loop in which you compare actuals against the baseline and correct deviations. It is therefore important to consider how often to assess status. If you assess status too frequently, overhead becomes high. If you assess too infrequently, you may not be able to take corrective actions promptly enough.

Most importantly, make sure your review cycle is regular. Set aside a specific time to review status. Never say, “We do not have time for a status meeting because the project has slipped behind schedule and we have to catch up first.”

The status review process is discussed in the following sections.

Record status information

Status information is typically recorded at periodic meetings attended by all key project participants. The information normally recorded includes:

- Status of tasks (not started or completed)
- Status of important milestones
- Progress (percent complete, or preferably, estimate to complete)
- Actual start and finish dates

Document this status information and summarize action items in an Action Log or add them to the plan. After the meeting, update the plan. If your group is small, you may want to do this at the meeting.

In assessing status, be honest. It is best to know bad news early while time still exists to do something about it.

Analyze variances

After recording status information, analyze the impact of any deviations on project schedule, cost, and resources. In particular, look for:

- Slippage on the critical path or just off the critical path (those tasks with low float).
- Critically-late tasks that indicate the scheduled finish date is later than the late finish date.
- An overcommitment of resources in the remainder of the project.
- Too many tasks started but too few completed.
- Tasks with revised resource usage that exceeds the project plan indicates tasks are being underestimated.

Use views to produce additional usage and/or duration variance reports by task or resource variables to isolate and explain project risk areas. Save the views you design for this purpose and use them throughout the project.
**Revise or replan the project**

Having analyzed variances, take whatever actions are required during the remainder of the project by updating the plan. There are two very different ways of looking at the remainder of your project. This step means making relatively minor corrections to the plan but keeping the major milestone dates, resource usage, and cost within original limits. Management approval is not normally required for these changes.

- Revise the plan as appropriate to keep as close as possible to stated project objectives, schedules, and budgets by repeating the steps in the planning process described previously for the remainder of the project.

- Use the baseline feature to preserve the original dates, at least for milestones, unless you must completely replan your project due to changed objectives or a major slippage in schedule.

To replan your project, perform any or all of the following steps:

- Add new resources, extend work hours, work on weekends, etc.

- Reduce requirements. The project deliverable often starts out as encompassing all conceivable features. When slippage occurs, it may be possible to reduce on the effort and still meet most of the real needs.

- Reconfigure the plan. This could include some judicious overlapping of sequential tasks (works only on dependency-constrained projects), reestimating resource usage, reallocating resources (putting your best people on the toughest tasks) and making use of existing components. Do not simply reestimate future tasks without justification. If you have already slipped behind schedule, it is unlikely that future tasks will get done faster.

- Increase productivity. You may be able to eliminate issues that were not apparent when the project started, introduce new technology (do not forget the added risk and training required) or automate some steps.

- Extend the finish date. This is usually the last option to take because it is usually unpopular with management. But, if you must extend your finish date, do so as early as possible and make sure your new plan is truly realistic.
Communicate to management and the project staff

Use the Open Workbench Notes feature to record and communicate project, resource, or task information to staff members and management. Use views to consolidate status data into concise reports that answer the questions, “Are we ahead or behind schedule? By how much?”

Management wants clear, succinct information showing just where the project stands and what actions, if any, are required of them.

Use the Gantt chart, which is generally a clear means of communication, as the main reporting vehicle.

You may want to create views that display data at a level higher than Task level to remove details not relevant to management.

If you must bring bad news, for example, the project has slipped, do so as early as possible. Management may be able to do something about it, particularly if you have some options ready. Use Open Workbench to create such alternatives.

Keep a historical record of status. You may want to use this at the finish of the project or at major milestones to analyze where the time went or to estimate new projects.
Glossary

A

**Accounting Variance (AV)**

The difference between the **Budgeted Cost of Work Scheduled** (BCWS) and the **Actual Cost of Work Performed** (ACWP).

The formula used for calculating AV is:

\[ AV = (\text{Baseline Total Usage from the start of the task through the Project As-of Date} - \text{Cumulative actual usage from the start of the task through the Project As-of Date}) \times \text{Billing Rate} \]

For cost-based resources, the billing rate is 1, regardless of the resource’s billing rate.

**Activity**

The second level in the default Work Breakdown Structure (Project-Phase-Activity-Task) using Open Workbench. You can change level names and add levels to match your own Work Breakdown Structure (WBS) conventions.

**Actual Cost of Work Performed (ACWP)**

The cost of the completed portion of tasks, based on the actual usage.

The formula used for calculating ACWP is:

\[ \text{Cumulative actual usage from the start of the task through the Project As-of Date} \times \text{Billing Rate} \]

For cost-based resources, the billing rate is 1, regardless of the resource’s billing rate.
**Actuals**
Most often, the time a person has worked on a task or assignment, but actuals can be any measurable value, such as pounds or kilograms of some material. Use actuals to track the project’s progress and to make future scheduling more accurate.

See also:
"Assignment" on page 262

**As-of Date**
Key date for Earned Value Analysis (EVA); reference date that separates actual data from future data.

**Assignment**
When a resource is assigned to a task, the task becomes an assignment. A task may contain multiple assignments.

See also:
‘Resource’ on page 281
‘Task’ on page 285

**Autoschedule**
An Open Workbench feature that allows you to automatically schedule a project subject to dependency relationships, task priorities, and (optionally) resource availability constraints. Autoscheduling with resource constraints is similar to Resource Leveling in Microsoft Project.

**AV**
See “Accounting Variance (AV)” on 261.

**Availability**
A rate that indicates how much a resource can be used during any given time period. Most often, availability is the portion (number of hours) of a calendar’s Hours Per Day a person is able to work. You can set the default rate for this resource on a per day basis in a Resource Calendar. This type of setting will override the resource’s defined default rate.

See also:
‘Shifts’ on page 283
BAC
See “Budget at Completion (BAC)” on 264.

Back Loading Pattern
The assignment loading pattern by which a resource is scheduled as late as possible in the process of completing a task.

See also:
‘Contour Loading Pattern’ on page 265
‘Fixed Loading Pattern’ on page 271
‘Front Loading Pattern’ on page 271
‘Uniform Loading Pattern’ on page 286

Base Calendar
The calendar from which another calendar gets its default values.

See also:
‘Default Calendar Value’ on page 268
‘Override’ on page 278

Baseline
Project data preserved for later comparison with the current plan.

In top-down estimating, the baseline for a project is its current projected finish date.

In Open Workbench, you can baseline one task, a selected range of tasks, all tasks in a view, or all tasks in an entire project. When you create a baseline you preserve information such as start dates, finish dates and durations, from that moment in time. At any time after baselining a task you can compare the current plan with the baseline plan to determine if the project is proceeding as expected.

Baseline CPM Type
A Baseline CPM type uses the tasks’ start and finish dates and durations from the most recently saved baseline to determine the Critical Path.

See also:
‘Critical Path Method (CPM)’ on page 267
‘Current CPM Type’ on page 267
**Budget at Completion (BAC)**

The total baseline budget of a project.

The formula for calculating BAC is:

\[
\text{Baseline Total Usage} \times \text{Billing Rate. Baseline Total Usage is Actual + Estimate to Complete usage at baseline}
\]

For cost-based resources, the billing rate is 1, regardless of the resource’s billing rate.

**Budgeted Cost of Work Performed (BCWP)**

The cost of the completed portion of tasks, based on the baseline usage data. It is also called Earned Value.

The formula for calculating BCWP is:

\[
\text{BAC} \times \text{Percent Complete, or (Actual + Estimate to Complete usage at baseline)} \times (\text{Billing Rate}) \times (\text{Percent Complete})
\]

For cost-based resources, the billing rate is 1, regardless of the resource’s billing rate.

**Budgeted Cost of Work Scheduled (BCWS)**

The baseline cost of a defined portion of the project’s Budget at Completion (BAC). This portion is defined as a period of time from the Project Start date through the Project As-of date.

The formula for calculating BCWS is:

\[
\text{Baseline Total Usage from the start of the task through the Project As-of Date } \times \text{Billing Rate.}
\]

For cost-based resources, the billing rate is 1, regardless of the resource’s billing rate.

**Business Day**

Also called workday. The opposite of a Business Day is a Holiday.
Calendar
A set of dates defined as Business Day or Holiday.

See also:
'Availability’ on page 262
'Base Calendar’ on page 263
'Override’ on page 278

Category (notes)
When writing a note, you may need to classify the note by category. You can use categorization to help organize notes.

Category (resource, task, deliverable)
When defining data, such as a resource, a task, or a deliverable, the set to which that data belongs. For example, a programmer may be in the Software Engineers category, a computer may be in the Equipment category, and a coding task may be in the Programming category.

Column Divider
A solid vertical line that separates one column from another.

Contour Loading Pattern
The assignment loading pattern by which a resource is used to complete a task at a rate that varies with resource availability. For example, if a programmer is available three hours on Monday and four hours on Tuesday, the programmer might be assigned to the task for three hours on Monday and four hours on Tuesday through the project scheduling tool’s autoscheduling process.

See also:
'Back Loading Pattern’ on page 263
'Fixed Loading Pattern’ on page 271
'Front Loading Pattern’ on page 271
'Uniform Loading Pattern’ on page 286

Corporate View Library
A library file that serves as the default view library available to all Open Workbench users.

See also:
'Library’ on page 275
Cost Performance Index (CPI) Field

The value earned per unit of actual cost.

The formula used to calculate CPI is: \( \text{BCWP} / \text{ACWP} \).

\[
\text{CPI} = \frac{(\text{Actual} + \text{Estimate to Complete usage at baseline}) \times (\text{Percent Complete})}{(\text{Cumulative actual usage from the start of the task through the Project As-of Date})}
\]

Cost Variance (CV)

The difference between Budgeted Cost of Work Performed (BCWP) and Actual Cost of Work Performed (ACWP). A negative value indicates costs exceeding the baseline plan; a positive value indicates a cost savings.

The formula for calculating CV is:

\[
((\text{Actual} + \text{Estimate to Complete usage at baseline}) \times (\text{Percent Complete})) - (\text{Cumulative actual usage from the start of the task through the Project As-of Date})) \times (\text{Billing Rate})
\]

For cost-based resources, the billing rate is 1, regardless of the resource’s billing rate.

Cost Variance Index (CVI) Field

An index of the difference between the Budgeted Cost of Work Performed (BCWP) and the Actual Cost of Work Performed (ACWP).

The formula used to calculate CVI is:

\[
\frac{(\text{BCWP} - \text{ACWP})}{\text{BCWP}}
\]

\[
\text{CVI} = \frac{((\text{Actual} + \text{Estimate to Complete usage at baseline}) \times (\text{Percent Complete})) - (\text{Cumulative actual usage from the start of the task through the Project As-of Date}))}{((\text{Actual} + \text{Estimate to Complete usage at baseline}) \times (\text{Percent Complete}))}
\]

CPM

See “Critical Path Method (CPM)” on 267.

CPM Network

A network diagram that shows tasks and their dependency links. It is also called a Precedence Diagram.
**Critical Path**

The set of tasks in a project for which any delay or expansion lengthens the project or causes any project deadlines to slip. The critical path determines the earliest **Finish Date** of the project and does not take resource constraints into account.

See also:

- ‘CPM Network’ on page 266
- ‘Critical Path Method (CPM)’ on page 267
- ‘Critically Late’ on page 267

**Critical Path Method (CPM)**

The CPM is the manner in which the project scheduling tool calculates the project’s duration. A project’s **Critical Path** is a set of tasks representing the longest path through the project (in terms of duration). The project scheduling tool uses the critical path value to determine the tasks that drive the project deadlines and constraints.

Resource constraints do not enter into the critical path calculation. Open Workbench uses task duration and dependency relationships to determine the critical path. Open Workbench and certain other project scheduling and management tools also determine the float for each task in a project. Float is the number of days that a task can lengthen without adversely affecting the project finish date. Critical tasks have a float of zero or less; therefore, when a critical task is delayed, the project finish date or other deadlines are affected.

See also:

- ‘Baseline CPM Type’ on page 263
- ‘CPM Network’ on page 266
- ‘Critically Late’ on page 267
- ‘Current CPM Type’ on page 267

**Critically Late**

A condition that exists when a task has a scheduled finish later than the **Late Finish Date**. A Task that is critically late delays the **Project Finish Date**.

See also:

- ‘Critical Path Method (CPM)’ on page 267
- ‘CPM Network’ on page 266

**Current CPM Type**

A Current CPM type uses the current information for task start and finish dates and durations to determine the **Critical Path**.

See also:

- ‘Baseline CPM Type’ on page 263

**CPI**

See “Cost Performance Index (CPI) Field” on 266.
Date Range
A span of time between start and finish dates.

Default
A value entered in a field by the system when you create a new record. Usually, you can change the value. In some cases, you may have the option to reset fields to their default values.

See also:
‘Override’ on page 278

Default Calendar Value
A default calendar has Monday to Friday marked as workdays and Saturday and Sunday marked as holidays. The default shift for a workday is 8 A.M. to 12 P.M. and 1 P.M. to 5 P.M. You set these values in calendars.

See also:
‘Override’ on page 278

Deliverable
A measurable result or product of a task, such as a report or prototype.

Dependency Type
The type of constraint placed on the Start or Finish date of the detail task or milestone.

- Finish-Start: Successor task cannot finish until its Predecessor has started.
- Finish-Finish: Successor task cannot finish until its Predecessor is finished.
- Start-Start: Successor task cannot start until its Predecessor has started.
- Start-Finish: Successor task cannot start until its Predecessor is finished.

See also:
‘Lag’ on page 275
‘Predecessor’ on page 279
‘Successor’ on page 284

Duration
The length of time, in business days, a task requires from conception to completion, including the start and finish dates.

See also:
‘Estimate at Completion (EAC)’ on page 269
‘Finish Date’ on page 270
‘Start Date’ on page 284
**EAC**
See “Estimate at Completion (EAC)” on 269.

**Early Finish Date**
The earliest time a task can be completed.
See also:

‘Estimate at Completion (EAC)’ on page 269
‘Late Finish Date’ on page 275

**Earned Value Analysis (EVA)**
This statistical operation compares the actuals of the present project against what was planned. For example, it may compare the length of time a task would take, according to a baseline budget plan, to the actual length of time it took. EVA is also called Performance Measurement.

**Edit Mode**
A state in which keystrokes, such as entering or deleting text, affect the contents of cells. This is different from Navigation Mode.

**Estimate at Completion (EAC)**
The sum of actual cost to date and estimated remaining costs.
The formula for calculating EAC is:

\[ (\text{Actual} + \text{Estimate to Complete}) \times \text{Billing Rate}. \]

For cost-based resources, the billing rate is 1, regardless of the resource’s billing rate.

**Estimate to Complete (ETC)**
The estimated time for a resource to complete an Assignment.
**Finish Date**
The current planned date on which a task or project will be completed.
See also:
‘Start Date’ on page 284

**Finish-Finish**
A Dependency Type in which the Successor task cannot finish until its Predecessor is finished.
See also:
‘Finish-Start’ on page 270
‘Lag’ on page 275
‘Start-Finish’ on page 284
‘Start-Start’ on page 284

**Finish-Start**
A Dependency Type in which the Successor task cannot finish until its Predecessor has started.
See also:
‘Finish-Finish’ on page 270
‘Lag’ on page 275
‘Start-Finish’ on page 284
‘Start-Start’ on page 284

**Fixed Cost**
A Resource whose unit of measure is cost.

**Fixed Duration**
A task in which the duration is constant and not driven by resource assignments. A fixed-duration task is also called a Time-Constrained Task.
See also:
‘Variable Duration’ on page 287
**Fixed Loading Pattern**

The rate at which a resource is used to complete a task. Once set, the rate cannot be changed by the project scheduling tool. You set the time when you assign the resource to the task.

See also:
- ‘Back Loading Pattern’ on page 263
- ‘Contour Loading Pattern’ on page 265
- ‘Front Loading Pattern’ on page 271
- ‘Uniform Loading Pattern’ on page 286

**Float**

The number of days that the initiation or completion of a task may be delayed without adversely affecting the **Project Finish Date**.

The formula for calculating Float is:

\[
\text{Late Start} - \text{Early Start}
\]

**Front Loading Pattern**

The rate at which a resource is used to complete a task. In this case, the resource is scheduled to work on the task as soon as possible.

See also:
- ‘Back Loading Pattern’ on page 263
- ‘Contour Loading Pattern’ on page 265
- ‘Fixed Loading Pattern’ on page 271
- ‘Uniform Loading Pattern’ on page 286
G

**Gantt Chart**
A chart with time along the horizontal axis, used to display the status of multiple tasks. In a scheduling tool’s Gantt chart, each task’s duration displays as a horizontal bar. The ends of the bar correspond to the task’s start and finish dates.

See also:

‘CPM Network’ on page 266

**Guidelines**
Instructions on how to complete a task. Guidelines can be instructions for performing a task, general statements of policy, or any other information that helps resources perform their work. You can create guidelines in any format that your browser can display.
**Holiday**

A holiday is any day that is not a *Business Day*, in which a resource is not available. You set days as business days or holidays in the calendar.

See also:

- 'Default Calendar Value’ on page 268
- 'Override’ on page 278
Key Task

Indicates whether you consider this WBS object to be of key importance. Key tasks are listed in the project property sheet to summarize the project.
**Lag**
The amount of time between two dependent tasks. For example, if you want TaskB to start three days after TaskA is finished, make the relationship Finish-Start and enter 3 in this field. Alternatively, you can enter a negative number here to indicate negative lag. For example, if you want TaskB to start two days before TaskA ends, enter –2 in the Lag field. You can also specify lag or negative lag as a percentage of the task duration.

**Late Finish Date**
The latest date on which a task can be completed without adversely affecting the Critical Path of a project.

See also:
‘Early Finish Date’ on page 269

**Level of Analysis**
Controls the level of consolidation of project data displayed in a view before filtering and sorting criteria are applied.

**Library**
An Open Workbench file that stores view shortcut bar data, including the names of groups that categorize views, sorts, and filters. A library also stores the paths to and names of the views, sorts, and filters that appear in each group.

**Loading**
The rate of resource Usage on a task per unit of time. The rate can be uniform or it can vary over time. Loading applies to a single task; Availability applies to the whole project.

See also:
‘Loading Pattern’ on page 275

**Loading Pattern**
The pattern with which resources are used to complete a task.

See Also:
‘Back Loading Pattern’ on page 263
‘Contour Loading Pattern’ on page 265
‘Fixed Loading Pattern’ on page 271
‘Front Loading Pattern’ on page 271
‘Uniform Loading Pattern’ on page 286
Message Area
A bar displayed at the bottom of the program window that shows messages describing selected objects or commands and available keys to help you use the program.

Milestone
A reference point for measuring a project’s progress. A milestone is a task that has no duration; its Start Date and Finish Date are the same.

See also:
‘Task’ on page 285
‘Work Breakdown Structure (WBS)’ on page 288
Navigation Mode

A state in which keystrokes affect table cells, columns, and rows rather than their contents, such as moving the cursor from one cell to another or from one record to another. This is different from the Edit Mode.
Overallocation
Assigning more project hours to a resource than are available for that resource. In Open Workbench Director, use the Overallocated Resources page to see overallocated resources.

Override
In the definition of calendar data, any time you make a change to a specific date’s default or base setting. For example, if the base calendar has November 22 as an 8-hour workday with shifts from 8 A.M. to 12 P.M. and 1 P.M. to 5 P.M. and you change any of these factors (for example, workday to holiday, or 8 hours to 6 hours) for a new calendar, then you override the Base Calendar setting.

See also:
‘Default Calendar Value’ on page 268
Perform % Complete Field
Percent of work performed on a task to date against the total budget.

The formula for calculating Perform % Complete is:

\[
\text{Perform % Complete} = \frac{100 \times (\text{Actual} + \text{Estimate to Complete usage at baseline}) \times (\text{Percent Complete})}{\text{Actual} + \text{Estimate to Complete usage at baseline}}
\]

Performance Measurement
See “Earned Value Analysis (EVA)” on 269.

Phase
The top level in Open Workbench products’ default Work Breakdown Structure (WBS) of Project-Phase-Activity-Task. You can change level names and add levels to match your own WBS conventions.

Predecessor
A task that precedes another (Successor) task, and is related to it by a Dependency Type link.

See also:
‘Milestone’ on page 276

Program
A program is the collection of projects that combine to meet an overall goal. In such a case, it does not refer to a computer software application.

Project
Generically, a related set of tasks performed to achieve a specific objective.

In Open Workbench products, a Work Breakdown Structure (WBS) for a Project contains Phase, Activity, and Task levels.

Project Finish Date
The date you set for a project to finish, or the finish date for the last task in the project.

Project Management
A body of knowledge dealing with the planning and control of projects. A set of principles, techniques, and tools used to manage projects.
**Project Plan**

Basic and default data about a project, including start and finish dates, and resources. Using a project scheduling tool, you can use the project plan to create a project’s tasks and assignments.

**Project Scheduling Tool**

Software applications, such as Open Workbench or Microsoft Project, with which project managers create and track project files. This type of application is also called *project management software*. 
Resource
Any staff, equipment, cost, or material necessary to perform a task.

Resource Availability
The amount of time a resource is present and able to be used on projects.
See also:
‘Availability’ on page 262

Resource Calendar
A calendar of Business Day and Holiday applicable to a particular resource. A resource may have holidays and working days different from those specified on the Base Calendar.

Resource Leveling
The process of scheduling tasks so that Resource Usage is made as close as possible to Availability throughout the duration of the project. Open Workbench can perform resource leveling when you Autoschedule a project.

Resource Usage
The amount that you’ve used a resource; for example, hours that an employee has worked, that a group of employees has worked, that a fleet of cars has been driven, or how much funding from a pool has been used. People are always resources, but resources are not always people.
See also:
‘Actuals’ on page 262
‘Usage’ on page 286

Roles
Generic resources that represent the job responsibilities of the resources assigned to a project. A role defines the work function while a resource identifies the individual who performs that role. Examples of roles include project manager, programmer, and business analyst.
**Schedule**
A timetable for performing tasks, utilizing resources, or allocating facilities.

**Schedule % Complete Field**
Percent of the Budget at Completion represented by the Budgeted Cost of Work Scheduled. In other words, the percent of the budget yet to be used.

The formula for calculating Schedule % Complete is:

\[ \text{Schedule % Complete} = \frac{100 \times \text{Baseline Total Usage from the start of the task through the Project As-of Date}}{\text{Actual + Estimate to Complete usage at baseline}} \]

**Schedule Options**
Default record entries for the day of the week your workweeks start, the time of day your workdays start and finish, and the number of hours in your workdays and workweeks. When you export a project to a project scheduling tool format that requires these record entries, Open Workbench includes the schedule options in the appropriate fields. Open Workbench also adds schedule options to projects from project scheduling tools that do not include them.

**Schedule Performance Index (SPI)**
An index of the Budgeted Cost of Work Performed (BCWP) and the Budgeted Cost of Work Scheduled (BCWS). Indicates the percent of work performed out of the total work scheduled and tells you how much more work is scheduled or expected.

The formula for calculating SPI is:

\[ \text{SPI} = \frac{\text{Baseline Total Usage from the start of the task through the Project As-of Date}}{\text{Actual + Estimate to Complete usage at baseline}} \times \left( \frac{\text{Percent Complete}}{\text{BCWS}} \right) \]
**Schedule Variance (SV)**

The difference between Budgeted Cost of Work Performed (BCWP) and Budgeted Cost of Work Scheduled (BCWS). A negative value indicates that less work was accomplished than was scheduled; a positive value indicates that a task or group of tasks are ahead of schedule. The Schedule Variance is calculated in the project scheduling tool.

The formula for calculating SV is:

\[
(Billing \ Rate) \times ((Actual + Estimate \ to \ Complete \ usage \ at \ baseline) \times \ (Percent \ Complete)) - (Baseline \ Total \ Usage \ from \ the \ start \ of \ the \ task \ through \ the \ Project \ As-of \ Date)
\]

For cost-based resources, the billing rate is 1, regardless of the resource’s billing rate.

**Schedule Variance Index (SVI)**

An index of the variance between the Budgeted Cost of Work Performed (BCWP) and the Budgeted Cost of Work Scheduled (BCWS).

The formula for calculating SVI is:

\[
SVI = \frac{(BCWP - BCWS)}{BCWS}
\]

**Shifts**

In a calendar, the times within a workday a resource is scheduled to work. A change in shift affects availability. However, a change in availability does not affect shifts.

Shift information is exported to Microsoft Project, while Open Workbench uses availability to make the project schedule. Therefore, it is important to change both shift and availability information concurrently.

**SPI**

See “Schedule Performance Index (SPI)” on 282.

**Spreadsheet View**

A type of View that arranges data in a matrix of rows and columns.

**Staff**

The association of one or more resources with a project.
**Start Date**
The current planned date on which a Task, Project, Request, As-of Date, or Assignment is scheduled to begin.

See also:
'Finish Date’ on page 270

**Start-Finish**
A Dependency Type in which the Successor task cannot start until its Predecessor is finished.

See also:
'Finish-Finish’ on page 270
'Finish-Start’ on page 270
'Lag’ on page 275
'Start-Finish’ on page 284

**Start-Start**
A Dependency Type in which the Successor task cannot start until its Predecessor has started.

See also:
'Finish-Finish’ on page 270
'Finish-Start’ on page 270
'Lag’ on page 275
'Start-Finish’ on page 284

**Status**
Project results compared to project plan. Status is determined in terms of costs, resources, deliverables, and whether the project is started, not started, or complete. In Open Workbench, a Status Indicator reflects the status of a project, or for a Program, the status of its component projects.

**Subnet**
A subnet is a group of tasks in a project that have dependencies among themselves. During Autoschedule, a separate critical path can be calculated for each subnet.

**Successor**
A task that follows another task (the Predecessor) and is related to it by a Dependency Type link.

**SV**
See “Schedule Variance (SV)” on 283

**SVI**
See “Schedule Variance Index (SVI)” on 283
**Task**
A discrete unit of work that occurs over time. In general terms, a task is the lowest level of a project’s *Work Breakdown Structure (WBS)*.

See also:
- ‘Duration’ on page 268
- ‘Milestone’ on page 276

**Time-Constrained Task**
A task whose duration is fixed.

**Tracking**
The process of measuring the *Status* of a project and comparing it to the plan to identify variances and take corrective actions.
Uniform Loading Pattern

The assignment loading pattern by which resource time is scheduled evenly across a task, but only on those days when the resource is available to meet the task requirements.

See also:

'Back Loading Pattern’ on page 263
'Contour Loading Pattern’ on page 265
'Fixed Loading Pattern’ on page 271
'Front Loading Pattern’ on page 271

Usage

The current planned estimate of Resource Usage on a task. The amount of time, quantity, or cost assigned to a Resource on a task.

Usage can refer to actual, baseline, or estimate. It is measured in days, hours, cost, quantity, or percent of availability.

See also:

'Availability’ on page 262

Utilization

The total usage per time period for a resource resulting from the summation of all tasks in the project.
Variable Availability
Resource availability that varies during a project.
See also:
‘Loading Pattern’ on page 275

Variable Duration
Task duration that can change when you Autoschedule a project. A Task with variable duration is also called a resource-constrained task.

Variance at Completion (VAC)
The difference between the latest Estimate at Completion (EAC) and the Baseline. A positive value indicates the cost is less than planned; a negative value indicates a cost overrun; a value of zero indicates the cost is on budget.

The formula for calculating VAC is:

\[ \text{BAC} - \text{EAC}, \text{ or } \text{VAC} = \text{Billing Rate} \times ((\text{Actual} + \text{Estimate to Complete usage at baseline}) - (\text{Actual} + \text{Estimate to Complete})) \]

For cost-based resources, the billing rate is 1, regardless of the resource’s billing rate.

View
In Open Workbench, a set of related fields on screen.
See also:
‘Spreadsheet View’ on page 283
W

**WBS Object**
A step in the Work Breakdown Structure used as a building block. Your organization may refer to these WBS objects with different terminology; for example, you may call these summary tasks or parent tasks, child tasks or detail tasks. Each WBS object contains information on its dependencies, role assignments, initial estimates, and deliverables.

**Work Breakdown Structure (WBS)**
The organization of projects into phases, activities, tasks, and milestones.

**Workspace**
The area of the application window used for displaying views.
Symbols

.RMP files
   creating 120
   editing 120
   opening 117
   sending by email 135

.RWF files
   applying 90
   creating 87, 89
   deleting 74
   editing 89
   saving 90

.RWH files
   applying 108
   creating 100
   defining 100
   editing 100
   printing 107
   saving 108

.RWS files
   applying 95
   creating 92, 95
   deleting 74
   editing 95
   saving 95

.RWV files
   applying 85
   deleting 74
   editing 84
   saving 85

A

Activity
   WBS level 251

Actuals
   removing 240
   tracking 237

Adding
   colors to the color palette 98
   library groups 72
   resources to projects 124, 204
   tasks 147
   tasks to master projects 147
   tasks to subprojects 186
   toolbar buttons 15

Advanced
   project properties 125
   properties for multiple resources 214
   resource properties 208
   task properties 163

Alternating
   colors in views 99

Analysis
   about 236
   data requirements 246
   earned value variances 246

Analyzing projects 244
Applying
  .RWF files 90
  .RWH files 108
  .RWS files 95
  .RWV files 85
calendars to projects 134
colors from the color palette 98
filters 73, 90
highlights 108
sorts 73, 95
views 85
Assigning
  resources
to projects 124
to tasks 152, 154
Autoschedule
about 227
  conditions 227
effect on loading patterns 59
  from a finish date 228
  from a start date 228
  master projects and subprojects 181
parameters 230
priorities 229
resource constraints 231
  schedule development 227
  start date 230
Autoschedule dialog box 230

B
Back loading pattern 223
Base calendar 131
Baseline dialog box 232
Baselines
  about 232
displaying 233
  earned value computation 232
  for tracking 238
  setting 232

C
Calendars
  and .RMP files 130
  applying to projects 134
  creating
    for projects 131
  resource 209
defining
  project holidays 132
  project work schedules 132
  resource holidays 209
  resource workdays 209
deleting user-defined 134
editing
  for projects 133
  resource 209
  naming 131
  printing 134
resetting
  for projects 133
  resource 210
  resource 209
  saving for projects 130
Calendars dialog box 131
Categorizing
  resources 206
tasks 150
Clearing
  baseline display 234
  filters 90
  resource filters 91
  sorts 96
Color dialog box 98, 105
Color palette
  applying colors 98
Colors
  adding to the color palette 98
  alternating in views 99
Column width 19
Columns
  deleting 19
  inserting 19
  resizing 19
Command line 118
  opening projects 119
syntax
    definitions 118
    examples 119
Constraints
  editing for multiple tasks 173
Contour loading pattern 224
Copying and pasting
  project data 139
  resources 139
  rules 139
tasks 139
Corporate View Library 69
   access 70
   administration 70
   creating 69
CPM
   cell colors and symbols 104
CPM Highlight Symbol dialog box 104
CPM network
   displaying 79
   menu options 79
   printing 201
CPM networks
   editing dependencies 193
Creating
   .RMP files 120
   .RWF files 87, 89
   .RWH files 100
   .RWS files 92, 95
   a Corporate View Library 69
   calendars for projects 131
   dependencies
      in spreadsheet views 192
      on Gantt charts 160, 193
dependency
   chains 160
   relationships 156
   external dependencies 194, 196
      in spreadsheet views 195
   external IDs for multiple selections 214
   filters 87, 89
   highlights 100
   library groups 72
   new projects 120
   project
      notes 127
   resource
      notes 210
   search statements 136
   sorts 92, 95
   subprojects 182
   task notes 167
   toolbars 14
   views 80
Critical path type selection 123
Custom colors
   defining 98
Custom dictionary location 62
Customize dialog box 13
   Commands page 14
   Toolbars page 14
Customizing view colors 97
Customizing WBS level names 63

D
Data requirements for analysis 246
Dates
   displaying in time scales 112
   shifting in Gantt charts 175
Default
   currency 58
   custom dictionary 62
   file locations 62
   global files 62
   guidelines location 58
   highlights file 62
   lag 60
   library location 71
   project file location 62
   view
      applying 120
      location 62
Defining
   CPM color settings and cell patterns 104
   custom colors 98
default
   currency 58
   custom dictionary 62
   dependency links 60
   global files location 62
   guidelines location 58
   lag 60
   lag type 60
   project file location 62
   resource loading patterns 59
   WBS levels 63
   dependency relationships 157
   filter properties 88
   Gantt chart layout 109
   highlight colors 106
   highlight formats 102
   highlights 100
   highlights file location 62
   key tasks 150
   notes categories 58
   project
      priority 123
      properties 121
   resource
      calendars 209
Displaying
- baselines 233
- dates in Gantt charts 110
- lines in views 99
- multiple views of one project 86
- recently opened files 58
- shortcut bar 58
- status bar 58
- subprojects 184
- task properties 148
- time period increments in Gantt charts 113
- time scales in Gantt charts 113
- toolbars 11
- tooltips 15

Earned value
- computation 232
- field names 247
- variances
  - for analysis 246

Editing
- .RMP files 120
- .RWF files 89
- .RWH files 100
- .RWS files 95
- .RWV files 84
- advanced properties
  - for multiple resources 214
  - for multiple tasks 173
- calendars 133
- constraints for multiple tasks 173
- dependencies
  - for multiple tasks 173
  - from CPM networks 193
  - on Gantt charts 161
  - on Spreadsheets 159, 192, 194
- Dependency relationships 191, 192
- dependency relationships 156, 197
- estimate to complete 240
- external IDs for multiple resources 214
- filters 89
- Gantt chart layout 109
- general data for multiple resources 214
- guidelines data for multiple tasks 174
- highlights 100
- library group names 74
- multiple resource selections 213
- nonview-specific

filters 89
- sorts 95
- notes
  - for multiple resources 215
  - for multiple tasks 174
- project
  - notes 128
  - properties 120
- resource
  - calendars 209
  - data for multiple tasks 172
  - notes 212
  - properties 206
- rules for multiple tasks 171
- sorts 94
- subproject
  - project properties 120
  - properties 120, 185
  - task properties 168, 185
- task
  - duration 32
  - notes 167
  - time scales 112
  - views 80, 84
  - view-specific filters 89
  - sorts 94
  - WBS summary levels 63

Email
- MAPI compliance 135
- receiving files 135
- sending files 135
- viewing project files 135

Enlarging toolbar buttons 15

Entering
- estimate to complete 240
- project budgets 121
- resource properties 206

Estimate to Complete 153
- editing 240
- entering 240

Exiting Open Workbench 5

External dependencies 194, 195
- creating in CPM networks 196
- printing 201

External IDs
- editing for multiple tasks 172
  - entering
    - for multiple selected resources 214
for multiple tasks 172
  project 121
  task 150

F

Field name
  comparison values in filters 88
  icons 75
Field names
  in filters 88
  in highlights 101
  in search statements 136
  in sorts 94
  in views 82
  inserting 76
  viewing definitions 76
File locations
  setting defaults 62
Filter Definition dialog box 87
Filtering resources 241
Filters
  adding
    field names 136
    to the library 73
  applying 73, 90
  clearing 90
  creating 87, 89
  defining properties 88
  deleting 74
  editing 89
  naming 88
  overwriting 90
  removing from the library 74
  saving 90
Find dialog box 136
Finding
  data in views 136
  Filter file locations 74
  sort file locations 74
  view file locations 74
Finish dates
  changing in tasks 176
  project 122
  shifting in tasks 176
Fixed loading pattern 223
Fixed task duration 60
  specifying 150

Formatting
  options 83
  view cells 82
Formatting Options dialog box 83
Forwards Autoschedule 228
Front loading pattern 222

G

Gantt bar
  display 110
Gantt chart
  color settings 103
  editing dependencies 161
  symbols 103
Gantt charts 7
  creating dependencies 160, 193
  displaying
    dates 110
    dependency relationships 160, 193
    time period increments 113
    time scales 113
  layout 109
  percentage display options 109
  shifting dates in 175
  width 110
Gantt dialog box 109
Global files location 62
Grids
  deleting rows 19
Guidelines
  defining default location 58
  editing for multiple tasks 174
  linking 163, 165
    to projects 251
    to tasks 164
  specifying for multiple tasks 174

H

Header buttons 7
Highlight colors
  defining 106
Highlight Condition dialog box 105
Highlight formats
  defining 102
Highlights
applying 108
conditions 100
creating 100
defining 100
highlight conditions 105
inguting 100
file location 62
printing 107
removing 100
samples 100
saving 108
selecting field names 101

I
Indices
percent complete 247
performance 247
Inserting
columns 19
field names 76
rows 19
subprojects 181, 187
into views 183
tasks in subprojects 186
WBS levels 64
Installing Open Workbench 3

K
Key tasks 124
defining 150

L
Lag 60, 158
defining default 60
specifying 157
type 157
Libraries dialog box 71

Library
adding groups 72
applying views, sorts, and filters 73
creating groups 72
default location 71
ingiting group names 74
icons 72
populating 73
removing groups 74
Lines
displaying in views 99
Linking guidelines 163, 165
Loading patterns 153, 154
Back loading 223
Contour loading 224
described 59
Fixed loading 223
Front loading 222
Uniform loading 222
Locating
view, sort, and filter locations 74
Locking tasks 221

M
Managing multiple projects 180
Master projects 181
adding tasks 147
Autoscheduling 181
prerequisites 182
Measuring resource value 59
Methodology guidelines
ingiting links 166
Milestone
WBS level 251
Multiple projects
managing 180
Multiple resources
ingiting
advanced data 214
general data 214
notes 215
rules 213
Multiple Selections dialog box
subproject information 171
Multiple tasks
Advanced page rules 173
Dependency page rules 173
ingiting
advanced data 173
constraints 173
dependencies 173
guidelines data 174
notes 174
resource information 172
Methodology page
rules 174
rules for editing 171
Multiple views
displaying 86

N
Naming 94
.RWF files 88
.RWS files 94
.RWV files 81
calendars for projects 131
filters 88
projects 121
resources 206
sorts 94
tasks 150
views 81
Negative lag 158
Nested subprojects 186, 187
New projects
creating 120
Notes
creating for multiple tasks 174
defining
categories 58
for multiple resources 215
editing
for multiple resources 215
for multiple tasks 174
project 127
resource 210
task 167

O
Online Help
using 25
Open Workbench
exiting 5
installing 3
starting 4
window elements 6

Opening
Calendars dialog box 131
new project windows 73
projects 117
projects from a command line 118, 119
Resource Properties-Multiple Selections
dialog box 214
Task Properties dialog box 148, 149
Options dialog box 57
Defaults page 59
Locations page 61
WBS page 63
Overwriting
filters 90
sorts 95

P
Panes 7
Paste Special 141
Percent complete indices 247
Performance indices 247
Periodic actual usage
tracking 237, 241
Phase
WBS level 251
Placing toolbars 12
plot printers and Open Workbench 24
Populating the View library 73
Print dialog box 24, 107
Print Preview window 22
Print Setup dialog box 24
Printing
.RWH files 107
calendar settings 134
CPM Network 201
dependencies 201
external dependencies 201
highlights 107
print margins 23, 86
subprojects list 187
views 24, 86
Prioritizing tasks 150
Priority scheduling 123, 229
Project analysis 244
data validation 245
file location 62
finish dates 122
planning guidelines 251
priority 123
property definition 121
revising plans 259
start dates 122
team communication 260
WBS level 251
Project data
copying and pasting 139
Project notes
creating 127
deleting 128
editing 128
Project Properties dialog box 120
Advanced page 125
Descriptions page 121
Key Tasks page 124
Notes page 127
Resources page 124
Scheduling page 122
Subproject page 128
Projects
about 116
adding tasks 147
applying views 86
creating 120
critical path type selection 123
describing 121
editing properties 120
entering budgets 121
external IDs 121
naming 121
opening
from a command line 118, 119

Q
Quick Filtering on Resources 91, 241

R
Rearranging
subprojects 186
tasks 149

Recalculate 226
examples 226
Recalculating task duration 226
Receiving emailed files 135
Recent project files list 58
Refreshing views 84
Removing
actuals 240
dependencies 158
external dependency relationships 200
filters 90
highlights 100
internal dependency relationships 200
resource assignments 155
shortcut bar display 58
sorts 96
toolbars 16
Renaming toolbars 15
Resetting
calendars for projects 133
resource calendars 210
toolbars 15
Resizing columns 19
Resource
actual usage 153
availability 206, 207
calendars 209, 210
defining defaults 59
estimate to complete 153
external IDs 206
filtering 91
Level of Analysis 81
loading patterns 59, 153, 154
max % load 153
rates 206
scheduling constraints 228, 231
task assignments 154
value 59
Resource detail pane 7
Resource filter
clearing 91
Resource loading patterns 222
Resource notes 210
creating 210
deleting 212
editing 212
Resource properties
editing 206
entering 206

Using Open Workbench 297
S - S

Resource Properties dialog box 205, 206
  Advanced page 208
  Calendar page 209
  General page 206
  Notes page 210
Resource Properties-Multiple Selections dialog box
  opening 214
Resources
  assigning
to tasks 152
to tasks in spreadsheet views 154
categorizing 206
copying and pasting 139
  editing
  advanced data for multiple resources 214
  external IDs 214
  for multiple tasks 172
  general data for multiple resources 214
  multiple selections 213
  notes for multiple resources 215
  entering
  for multiple tasks 172
  filtering 241
  naming 206
  removing from tasks 155
  tab 124
  unit of measure 153
Reverse Autoschedule 228
Reviewing
  project notes 128
  resource notes 212
  task notes 167
Revising project plans 259
Rows
  deleting in views 20
  inserting 19, 20
  removing from grids 19

S
Save Filter Definition dialog box 90
Save View Definition dialog box 84

Saving
  .RWF files 90
  .RWH files 108
  .RWS files 95
  .RWV files 85
calendar for projects 130
  filters 90
  highlights 108
  projects with external dependencies 200
  sorts 95
  views 85
Schedule
  development 219
  display 151
Scheduling 219
  constraints 162, 228, 231
  priority 123
  subnets 123
  task constraints 229
  techniques 220
Search statements
  creating 136
Selecting
  critical path type 123
  dependency types 157
  view display colors 99
Shortcut bar 7
  display 9
  hiding 9
  moving 9
  restoring 9
  right-click menu options 10
  viewing 58
Show Tips at Startup check box 58
Sort Definition dialog box 93
Sorts
  adding 73, 94
  applying 73, 95
  clearing 96
  column length 94
  creating 92, 95
  defining properties 94
deleting 74
  editing 94
  naming 94
  overwriting 95
  removing from the library 74
  saving 95
  sequence 94
Split bar 7
Spreadsheet views 77
  assigning resources to tasks 154
Spreadsheets
  editing dependencies 159, 192, 194
Standard views
  Clear Filters 53
  Clear Sorts 53
  CPM Network 42
  Dependency Definition 45
  Dependency Status 48
  Gantt Chart 41
  Key Tasks 53
  Phase Level Gantt 43
  Resource Assignment Gantt 43
  Revise Schedule 52
  Schedule 47
  Sort By Resource 53
  Status Update 49
  Unused Availability 50
  Variance Analysis 51
  WBS Definition 44
Start dates
  changing in tasks 176
  for Autoschedule 230
  for projects 122
  setting for tasks 151
  shifting in tasks 176
Starting Open Workbench 4
Status
  defining for multiple selected tasks 172
  display 58
  information 258
  measuring 258
  tracking 242
  updating 242
Subnets 123
Subproject
  display 184
  prerequisites 182
  task properties 185
Subproject properties
  editing 120, 185
Subprojects 181
  creating 182
  deleting 187
  displaying
    lists 184, 187
    tasks 187
  editing
    project properties 120
    task properties 168
  inserting 183, 187
  tasks 186
  linking 181, 182
  nested 186, 187
  printing lists 187
  read-only 187
  rearranging 186
    in master projects 186
    viewing source projects 187
Subprojects dialog box 184, 186
  System-defined time scales 112
duration 32
eexternal IDs for multiple tasks 172
external IDs 150
fixed duration 60, 150
inserting in subprojects 186
locking 221
naming 150
percent complete 151
prioritizing 150
rearranging 149
recalculating durations 226
removing resource assignments 155
rules
for deleting 177
for shifting start and end dates 175
schedule display 151
shifting in Gantt charts 175
status 151
Time Scale dialog box 111
Time scales
defining 112
displaying
dates 112
time period increments 113
time periods 113
editing 112
system-defined 112
tip of the day 4, 29
Tip of the Day dialog box 58
Toolbar
display options 15
Toolbar buttons 7
adding 15
described 12
enlarging 15
Toolbars
creating 14
deleting 16
displaying 11
placing 12
removing 16
resetting 15
Tooltips display 15
Total actual usage 237

Tracking 236
actu als 237
by Status 242
methods 237
periodic actual usage 237, 241
task status 237
total actual usage 237
using
a Gantt chart 238
baselines 238

U
Uniform loading pattern 222
Unit of measure 153
Updating
status 242
Using online Help 25

V
Validating project data 245
Variance analysis 247, 258
View
cell formatting 82
display 7
type 81
View colors
customizing 97
View Definition dialog box
Description page 81
Filter page 84
Layout page 82
Sort page 84
View display colors
defining 65, 97
selecting 99
View Highlights dialog box 100
Viewing
emailed projects 135
field name definitions 76
shortcut bar 58
Views 77
adding
field names 82
to the library 73
applying 73, 85
default 62, 120
many 86
Using Open Workbench

multiple views 86
one 86
cell formatting 82
CPM networks 79
creating 80
defining status 81
deleting 74
rows 20
displaying lines 99
displaying view windows 7
editing 80, 84
formatting options 83
inserting rows 20
naming 81
printing 24, 86
refreshing 84
removing from the library 74
saving 85
spreadsheet 77
View-specific
filters 89
sorts 94

W

WBS
editing summary levels 63
icons 64
WBS levels 146, 251
Activities 251
customizing 63
defining 63
deleting 64
inserting 64
Phases 251
Projects 251
Tasks/Milestones 251
Window
docking options 8
elements 6